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P R E F A C E  

Contents and Conventions 

P.1 Overview 
In this chapter we describe the scope of the manual, the conventions used and most importantly 
the safety guidelines. The MPMS 3 uses cryogens and high power components, we strongly 
recommend being aware of all hazards in order to prevent injuries and system damage. 

 

This preface contains the following information: 

• Section P.2 discusses the overall scope 
of the manual. 

• Section P.3 illustrates and describes 
conventions that appear in the manual. 

• Section P.4 describes the safety 
guidelines and regulatory information in 
the manual. 

• Section P.5 gives disposal information 
and RoHS and WEEE compliance.

P.2 Scope of the Manual 
This manual discusses the MPMS 3. It contains information about the basic functionality, 
describes the hardware that is unique to the system, and explains how to use the system and the 
MPMS 3 MultiVu software. 

P.3 Conventions in the Manual 
File menu Bold text identifies the names of menus, dialogs, options, buttons, and panels 

used in the MPMS 3 MultiVu software. 

File > Open The > symbol indicates that you select multiple, nested software options. 

.dat The Courier font indicates file and directory names and computer code. 

Important Text is set off in this manner to signal essential information that is directly 
related to the completion of a task. 

Note Text is set off in this manner to signal supplementary information about the 
current task; the information may primarily apply in special circumstances. 
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W A R N I N G !  
This symbol signals specific caution or conditions that could 
result in system damage, bodily harm, or loss of life. 

  

 

W A R N I N G !  
This symbols signals electrical hazards that could result in 
bodily harm, or loss of life. Used at all accessible 200-230 V 
power outlets. 

  

 

W A R N I N G !  
This symbol signals cryogenic hazards that could result in 
bodily harm and loss of life. Used wherever accessible parts 
could reach temperatures below 0°C (32°F). 

  

 

W A R N I N G !  
This symbol signals hot surface hazards that could result in 
bodily harm and loss of life. Used wherever accessible parts 
could reach temperatures above 60°C (140°F). 

  

 

W A R N I N G !  
This symbol signals strong magnetic fields.  Used to indicate 
potential danger from a charged magnet. 

  

 

This symbol signals information on fusing. 

  
 

 

P R O T E C T I V E  C O N D U C T O R  
T E R M I N A L  

The protective conductor terminal symbol in the left figure 
identifies the location of the bonding terminal, which is bonded to 
conductive accessible parts of the enclosure for safety purposes. 
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E U R O P E A N  U N I O N  C E  M A R K  
The presence of the CE Mark on the equipment signifies that it has been 
designed, tested and certified as complying with all applicable European 
Union (CE) regulations and recommendations. 

 

 

  A L T E R N A T I N G  V O L T A G E  S Y M B O L  
This international symbol indicates an alternating voltage or current. 

 

 

S T A N D B Y  S Y M B O L  
The power standby symbol indicates a sleep mode or low power state. The 
switch does not fully disconnect the device from its power supply, depressing 
the button switches between on and standby. 

 

 

W A S T E  E L E C T R I C A L  A N D  E L E C T R O N I C  
E Q U I P M E N T  ( W E E E ) !  

This symbol on the product or on its packaging indicates that this product 
must not be disposed of with regular waste. Instead, it is the user’s 
responsibility to dispose of waste equipment according to local laws. The 
separate collection and recycling of the waste equipment at the time of 
disposal will help to conserve natural resources and ensure that it is recycled 
in a manner that protects human health and the environment. For information 
about where the user can drop off the waste equipment for recycling, please 
contact your local representative. Contact Quantum Design for instructions 
on how to disassemble the equipment for recycling purposes. 
 

P.4 Safety Guidelines and Regulatory Information 
Before using this product, please read the entire content of this User’s Manual and observe all 
instructions, warnings and cautions. These are provided to help you understand how to safely and 
properly use the MPMS 3 and reach its best performances. 

Quantum Design Inc. disclaims any liability for damage to the system or injury resulting from 
misuse or improper operation of the system. Please contact your Quantum Design representative 
for any service issues. 

This product is NOT operator-serviceable except for simple operations described in Appendix A.
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W A R N I N G !  
If the equipment is used in a manner not specified by the 
manufacturer, the protection provided by the equipment may be 
impaired.  Do not position the equipment so that it is difficult to 
operate the disconnecting device. 

 
Observe the following safety guidelines when you use your system: 

P.4.1 Inspection for Damage 
The MPMS 3 is carefully packaged at the factory to minimize the possibility of damage during 
shipping. Inspect the box for external signs of damage or mishandling.  Inspect the contents for 
damage.  If there is visible damage to the instrument upon receipt, inform the shipping company 
and Quantum Design immediately. 
 

 

W A R N I N G !  
Do not attempt to operate this equipment if there is evidence of 
shipping damage or you suspect the unit is damaged.  Damaged 
equipment may present additional hazards.  Contact Quantum 
Design technical support for advice before attempting to power on 
and operate damaged equipment. 

P.4.2 Electricity 
o In case of emergency, switch the power off at the rear of the cabinet or unplug the main 

power cord from the laboratory power outlet. 

o To prevent electrical shock, unplug the system before you install it, adjust it, or service it.  
Permit only qualified electricians or Quantum Design personnel to open electrical 
enclosures and perform electrical servicing and checks. 

o The instrument must be plugged into a 200-230VAC 50/60HZ single phase appliance 
outlet fused to 16A (Outlet type IEC 60309, 200-250V, 16A, 2P+E, 6H, blue). See 
Appendix C.2. 

o To prevent damage, always power down module bay tower when removing/installing 
modules. 

o Keep electrical cords in good working condition, and replace frayed and damaged cords. 

o Do not replace detachable MAINS electrical supply cords with inadequately RATED 
electrical cords. 

o For continued protection against fire hazard, electric shock and irreversible system 
damage, replace fuses only with same type and rating of fuses for selected line voltage. 
Information about user-accessible fuses and their replacement is summarized in Appendix 
A.3.9. 
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P.4.3 Cryogens 
o Direct contact with cryogenic liquids, materials recently removed from cryogenic liquids, 

or exposure to the boil-off gas can freeze skin or eyes almost instantly, causing serious 
injuries similar to frostbite or burns.  Wear protective gear, including clothing, insulated 
gloves, and eye protection, when you handle cryogenic liquids. 

o Transfer cryogenic liquids only in areas that have adequate ventilation and a supply of 
fresh air. Nitrogen and Helium gas can displace the oxygen in a confined space or room, 
resulting in asphyxiation, dizziness, unconsciousness, or death.  Quantum Design 
recommends installing oxygen sensors where the MPMS 3 is located and with all other 
cryogenic systems. 

o Do not obstruct the cryogen exhaust lines. The exhaust should be visible to the user when 
operating the system. 

o Keep this system away from radiators and heat sources. Provide adequate ventilation to 
allow for cooling around the cabinet and pump console. The distance between the system 
and wall should be at least 30 cm. (12 inches) in each direction. Do not obstruct the 
ventilation openings on the top of the cabinet. 

o Do not obstruct the ventilation outlet located on the left side of the pump console and air 
intake at the rear. The clearance around the pump console should be at least 20 cm (8 
inches) in each direction. 

o Do not obstruct or pinch the pump exhaust line located at the rear of the pump console. 

o Refer to the manuals for the pump and monitor for additional safety warnings and notices. 

P.4.4 Moving the MPMS 3 
The MPMS 3 has four integrated caster wheels that allow the system to be easily rolled from one 
location to another.  However, several steps must be taken in order to prepare the system for safe 
relocation.  These detailed instructions can be found in Appendix A.3.6.  

P.5 Disposal Information 
The MPMS 3 is exempt with the requirements of: 

• DIRECTIVE 2011/65/EU OF THE EUROPEAN PARLIAMENT AND OF THE 
COUNCIL of 8 June 2011 on the restriction of the use of certain hazardous substances 
in electrical and electronic equipment (RoHS 2) 

The MPMS 3 complies with the requirements of: 

• DIRECTIVE 2012/19/EU OF THE EUROPEAN PARLIAMENT AND OF THE 
COUNCIL of 4 July 2012 on waste electrical and electronic equipment (WEEE)  
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P.5.1 RoHs Statement  
RoHS Statement:  The MPMS 3 is a Research and Development instrument that falls into 
Category 9 RoHs exemption. 

P.5.2 WEEE Statement 
WEEE Statement:  The MPMS 3 is WEEE compliant as Quantum Design uses recyclable 
materials in the fabrication of the equipment.  Several components require special handling and 
processing and these components must be removed at time of decommissioning for proper 
handling before recycling/disposal.  Contact Quantum Design for updated 
procedure/recommendations before disposal.  A list of components to be removed before 
recycling or disposal is provided in Table P-1 below. 

Table P-1. List of Components to be removed before Recycling or Disposal. 
 

Component Description / 
Location Identifying Photograph/Diagram 

MPMS3 7T Probe Assembly 
(QD P/N: 4502-100) 

 
Power Drawer Assembly 
 (QD P/N.: 4506-050) 
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MPMS3 backplane 
 (QD P/N.: 3572-002) 

 
Gas Handling Module 
(QD P/N: 4501-040) 

  
Pirani Sensor and PCA 
Assembly (QD P/N.: 4501-071) 

 
Hybrid Magnet Controller 
Assembly (QD P/N.: 4503-010-
01)  

 
Temperature Control Module 
Assembly (QD P/N: 4101-260) 
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SQUID Control Module 
Assembly (QD P/N: 4101-500) 

 
Motor Module Assembly  
 (QD P/N: 4101-100) 
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C H A P T E R  1  

Getting Started 

1.1 Overview 
In this chapter we give a brief system introduction and describe how to get started and to perform 
the most common tasks with your MPMS 3. The instructions are meant to be brief in order to get 
a quick overview of the routine operations and to get familiarized with the system. More details 
are provided in the rest of the manual. 

1.2 Introduction 
The Quantum Design Magnetic Property Measurement System (MPMS) is a family of analytical 
instruments configured to study the magnetic properties of small experimental samples over a 
broad range of temperatures and magnetic fields. Automated control and data collection are 
provided by a computer and various electronic controllers. Extremely sensitive magnetic 
measurements are performed with superconducting pickup coils and a Superconducting Quantum 
Interference Device (SQUID). For this reason, the MPMS family of instruments are called 
SQUID magnetometers. 

To optimize speed and sensitivity, the MPMS 3 utilizes some analytic techniques employed by 
DC measurement scans. During the DC measurement the sample is moved slowly through the 
pick-up coils detecting the magnetic moment based on the scan time and amplitude of the 
measurement. 

The MPMS 3 utilizes a superconducting magnet (a solenoid of superconducting wire) to subject 
samples to magnetic fields up to 7 Tesla (70 kOe). The SQUID detector and magnet must both be 
cooled with liquid helium. Liquid helium is also used to cool the sample chamber, providing 
temperature control of samples from 400 K down to 1.8 K. To help conserve liquid helium, the 
system is designed to use less costly liquid nitrogen to intercept heat bound for the helium tank. 
The MPMS 3 will only operate properly with both cryogens in use:  liquid helium and liquid 
nitrogen. 

For details on hardware and measurement methods refer to Chapters 3 and 4, respectively
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1.3 Common Tasks 
Before attempting a measurement make sure the system is filled with the necessary cryogens: 

 

 

 

 

The most common tasks necessary to perform a measurement are summarized in the following 
flowchart: 

    

 

    

1.3.1 Mounting Samples 
In general, a few precautions should be taken when mounting a sample onto the sample 
holder to be measured on the MPMS 3: 

• Make sure the sample will fit into the chamber. The inside diameter of the 
sample chamber is 9 mm.  The sample dimensions should be well below this 
dimension to avoid rubbing of the sample through the sample chamber. 

• For the most accurate magnetic moment measurements, measure the magnetic 
signature of the sample holder before mounting the sample.  Once the sample is 
measured the background signal of the sample holder will need to be manually 
subtracted, point-by-point, from the sample measurement. 

• Quartz and brass sample holders are supplied. In general, quartz sample holders 
should be used for measurement of small magnetic moments.  The quartz holders 
are brittle and fragile, but have the smaller magnetic signature. For samples 
having a large moment, the brass sample holders are preferred and will have 
negligible magnetic background and may be easier to handle. 

• Mount samples very securely to a sample holder to achieve accurate magnetic 
moment readings. (GE) 7031 varnish, or a glue that will withstand the 
temperature extremes and sample holder thermal contraction during the 
experiment is recommended for bonding the sample to the sample holder. In 
general, 7031 varnish can be dissolved with alcohol or toluene to remove 
samples and re-use sample holders. Do not soak the entire sample holder in 
solvents like acetone —they will damage the adapter that mates the sample 
holder to the sample rod. 

• Mount samples on-axis with the sample rod to minimize dependence of the 
magnetic moment readings on the angular orientation (about a vertical axis) of 
the sample rod. 

 

Mounting 
Sample 

Loading 
Sample 

Centering 
Sample 

Measure 
Sample 

Fill liquid 
He 

Fill liquid 
N2 + 
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• Use the supplied sample mounting station to place the sample at the proper location 
(66±3mm) on the sample holder as shown in Figure 1-1.  The sample holder should be placed 
on the mounting station such that its base is aligned flush with the zero-point indicator. 

Figure 1-1. Sample mounting station. 

Note While custom sample holders may also be used, it should be noted that the accuracy and 
reproducibility of magnetic moment readings may be compromised. The supplied brass and 
quartz holders are manufactured to ensure optimal geometry, and the MPMS 3 software can 
accurately predict their thermal contraction in order to keep samples properly centered in the 
detection coils. User-designed sample holders may not meet these aims. 
 

1.3.1.1 OPTIONAL SAMPLE HOLDERS 

Specialty sample holders may also be purchased from Quantum Design.  Available 
options include straw and liquid sample holders.  Guidelines for use of these specialty 
holders are outlined below. 

 

STRAW SAMPLE HOLDER: 

The hardware needed for using a straw sample holder include:  

• Straw adaptor (QD Part # 4500-614) 
• Straws   (QD Part # 8000-001) 

NOTE The straw sample holders are only intended for use with DC Scan mode.  They 
should not be used with the VSM option. 

 

W A R N I N G !  

Do not use straws at temperatures greater than 350 K. Straws will 
melt. 

  

Like the quartz and brass sample holders, predetermined parameters of the straw holder- 
sample rod assembly allow use of the Auto-Tracking feature (see Section 1.4.3) during 
measurement.  If the user chooses to use straws from other sources, it is possible that 
sample position may behave differently upon cooling and warming.   

Mount Samples 
Here 
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As shown in Figure 1-2, the straw fits snuggly onto the adaptor, and a sample is mounted 
securely in the straw.  The sample mounting station should be used to position the 
sample in the straw at 66±3 mm. 

 

 
Figure 1-2. MPMS 3 sample rod, straw adaptor (yellow), and straw holder with sample. 

Note The straw length should be modified so that it is roughly the same as the quartz or brass 
sample holders (5.82 ± 0.01 in). 

 
A basic procedure for using straw sample holders is provided below.  Additional 
guidelines for mounting thin film, gelatin powder capsule, and single crystal 
samples in straw holders are given in Application Note 1500-018: Using Straw 
Sample Holders with DC Scan Mode in MPMS 3. 

 
1. Weigh and measure the sample.  After you insert the sample into the sample 

chamber, you can select Sample > Properties… from the menu bar to define 
the sample’s mass, in milligrams, and its diameter and length, in millimeters.  
Here you can also specify the type of sample holder used. 

2. Use two short sections of straw with thru cuts, and slide them into the outer 
straw to sandwich the sample in the middle.  The straw segments should be 
near identical in shape and length to ensure the background is uniform, and 
thus contributes little to the overall signal.  Use the sample mounting station to 
make sure that the sample is positioned at 66 ± 3mm . 

 
 

 
Figure 1-3. Correctly positioned sample in straw holder. 

 
3. Alternatively, the sample can be placed inside of a small straw segment as 

shown below. 
a. To mount your sample in this manner, use phenolic tweezers to place 

the sample inside the small straw segment. 
b. Hold the straw segment so that its two open ends are vertical. 
c. Place the straw segment inside the drinking straw, and move the 

segment until it is 66±3 mm from the end of the straw.  Verify that the 
walls of the straw obstruct the open ends of the segment. 
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Figure 1-4. Using a small straw segment to position a sample in the straw holder. 

4. To attach the straw to the sample rod adaptor, wrap a sufficient amount of Kapton 
tape around the adaptor so that the drinking straw will fit snugly over it. 

5. Place the end of the drinking straw over the tape on the adaptor. 
6. Place a small piece of tape over the exposed end of the drinking straw. This extra 

piece of tape prevents a loose sample from falling into the sample chamber. 
 

SEALED SAMPLE HOLDER: 

Sealed Teflon sample holders are also available from Quantum Design.  The sealed 
sample holders can be used to measure solid and powder samples.  Liquid samples may 
also be measured if grease or Teflon tape is applied to the fine threads of the Teflon 
sample bucket.  However, it is recommended to test the seal in another vacuum space 
prior to measuring in the MPMS 3.  Due to its high background signal the sealed sample 
holder should not be used to measure weakly magnetic samples.    
 
Necessary hardware: 

• Sealed Sample Rod Assembly  (QD part # 4084-266) 
 Adaptor    (QD part # 4500-654) 

 

 
Figure 1-5. MPMS 3 sample rod, adaptor, and sealed sample holder. 

The body of the sealed sample holder is a carbon fiber rod.  The Teflon sample bucket 
threads onto the sample holder rod.  The adaptor is mated with the Teflon female joint at 
the top of the sample holder.  The background signal of the sample holder should be 
measured prior to measurement of the sample.   
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Figure 1-6. Sealed sample holder and sample bucket shown in detail. 

1.3.2 Loading and Unloading Samples 
1. Attach a sample holder with mounted sample to a sample rod. Make sure that the mating 

surfaces of the adapters are clean and that they are screwed all the way in. When screwing 
your sample holder to the sample rod, hold the rod at the blue bearing. 

 

                                                Figure 1-7. Sample holder mounting. 

2. Select the software menu item “Sample > Install/Remove…”, select the “Change Sample” 
button from the toolbar or the change button in the sequence control window. 

          

               
Figure 1-8. Sample installation menu, toolbar button, and sequence control pane.  

The Install/Remove Sample Wizard begins. It guides you through the rest of the sample 
loading process, including warming the chamber to room temperature and venting the 
chamber, specifying a data file for saving measurement data, entering sample and sample 
holder information, and centering the sample. If you only wish to unload a sample, the wizard 
instructs you how to do this. 
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Figure 1-9. Sample installation wizard. 

3. Follow the instructions in the wizard. 

4. After specifying a data file for saving measurement information, the “Sample Properties” 
window will appear and you will be prompted to enter optional information about the sample 
and sample holder. 

 

Figure 1-10. Sample Properties Window 

Selecting one of the Quantum Design sample holders (brass, quartz, straw) for your 
measurement will enable the advanced feature called  Autotracking.  In this advanced feature 
the system automatically tracks the center of the sample during cooling and warming, based 
on the predetermined thermal expansion properties of the QD sample rod-sample holder 
assembly. 
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NOTE Sample properties entered are used for informational purposes only.  Magnetic moment 
is always measured in either emu or A·m2.  Refer to Section 2.2.1 for information on 
changing the measurement units. 

Alternatively, you may unload samples with the procedure below, or load samples without 
specifying data file, sample, or sample holder information. This procedure will not help you 
center your sample either. 

 
1. Stop any measurement in progress. Make sure the chamber temperature is above 295 K 

and below 315 K. Set temperature and wait if necessary, to prevent condensing or 
freezing air and moisture in the chamber. 

2. Press the “Eject” button,        , on the front instrument bezel.  The chamber vents 
continuously with helium and the sample transport moves to the top position. 

3. Remove the cap from the sample transport. 

 
Figure 1-11. Sample rod installation. 

5. Remove the installed sample rod. Insert a new sample rod into the chamber if desired. 

6. Replace the cap and press the “load”             button on the instrument bezel. 

The chamber is purged with helium. You will need to specify a data file and center your new 
sample in order to perform measurements.

 

W A R N I N G !  

Never press the “load” button without having replaced the cap. 
Air will be sucked into the system and cause ice accumulation 
in the sample space. 
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W A R N I N G !  
Before installing the sample transport, check that the O-ring on the 
sample space manifold is in place (Figure 1-11) and is free of 
debris.  

 

                         Figure 1-12. Sample space manifold O-ring. 

 

W A R N I N G !  
Never insert the sample rod into the sample chamber if the O-ring 
on the top of the sample transport is missing (see Figure 1-13).  
The O-ring prevents air from pumping into the chamber.  Air 
pumped into the chamber can damage the vacuum pump and 
freeze the sample. 

  
 

Figure 1-13. Sample transport O-ring.
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1.4 Centering Samples 
Before initializing a single measurement or a sequence, the sample must be centered within the 
detector coils.  During a centering scan, the MPMS 3 scans the entire length of the sample 
transport’s vertical travel path.  The sample must be centered within the detection coils for 
accurate magnetic measurements. This can only be done if the sample is mounted near the correct 
location on the sample holder, as shown above in Section 1.3.1 “Mounting Samples”. 
 
There are two different ways to enter the sample offset: Scan for Sample Offset and Enter 
Offset Manually.  The Install/Remove Sample Wizard will scan for sample offset or let you 
specify the offset value.   If you are not using the Install/Remove wizard, select Sample > Locate 
or select the “Locate” button from the toolbar. 
 

                    
Figure 1-14. Locate menu and toolbar button. 

 
Figure 1-15. Sample centering scan. 

The sample offset is defined as the distance from the bottom end of the sample holder to the 
sample location and is usually about 66 mm. After a successful centering scan or manual entry of 
the sample offset, the motor armature position should be roughly centered in the window of the 
sample transport. 
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1. The most accurate technique is to Scan for Sample Offset. The software moves the 
sample through the detection coils and analyzes the coil response to locate the sample. 
The MPMS 3 initializes the sample transport by first performing a “touchdown” to the 
lower-travel-limit.  The initialization position places the sample far enough below the 
pickup coils that the SQUID does not detect the sample moment.  Centering scan 
parameters are factory defined, with the exception of Scan time, which can be set from 1-
15 seconds. The default centering scan time is 4 seconds.  However, for larger moment 
samples, slower scans should be used to avoid software errors in reconstruction of DC 
waveforms. Alternatively, to perform a good centering scan on samples with small 
moments, you may need to induce a magnetic moment > 1x10-7 emu in your sample by 
applying a magnetic field, or by changing the temperature. 
 
Figure 1-15(a) illustrates the sample moving upward through the detection coils.  Figure 
1-15(b) illustrates MPMS 3 MultiVu measuring the SQUID response while the sample 
moves through the coils.  Figure 1-15(c) plots the SQUID response against the scan 
length; the output in Figure 1-15(c) indicates that the sample is mounted too high and 
must be lowered.  In Figure 1-15(d), the scan begins one-half scan length below the 
center coils. 

 
 

 
Figure 1-16 DC centering scan and measured SQUID voltage response. 
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2. If your sample has a very weak magnetic response and inducing a magnetic moment 
is undesirable or impossible, scanning the sample may not work. Additionally, if 
your sample does not have a dipole-like response, scanning the sample may not 
work. In these cases you can measure the sample offset using the sample mounting 
station before loading the sample and select Enter Offset Manually.  This is a 
necessary step to ensure that samples are properly centered during measurements. 

 
Sample offset is the distance measured from the bottom end of the sample holder to 
the (magnetic) center of the sample.  When mounting your sample, use the sample 
mounting station to ensure that the magnetic center of your sample falls within the 
center of the gradiometer coils, at 66 ± 3 mm. 

1.4.1 Scan the Sample 
By scanning the sample before measurements, the user can find the center of the sample in 
between the pick-up coils.   

1. Click “Scan for Sample Offset.”  The instrument smoothly moves the sample through the 
detection coils. It may scan the sample several times to achieve optimum signal.  The user 
may adjust the scan time that it takes the system to center a sample. 

2. The signal is plotted in red as a function of position, along with a dipole response fit in green. 
A good scan has one central peak with symmetric peaks on either side. The center peak is 
approximately 170% the magnitude of the outer peaks, and opposite in polarity. This is due 
to the geometry of the 
detection coils. 

3. The instrument calculates the 
sample offset based on the fit 
to the data and asks you for 
confirmation to use the 
calculated value. Click “OK” 
only if the fit and calculated 
sample offset look correct.  

 

Figure 1-17. Sample offset confirmation. 

1.4.2 Enter Sample Offset Manually 
Samples with weak magnetic response might need to be centered manually.  To do so: 

1. Set the temperature to 305 K and wait for the chamber to reach 305 K. The sample offset you 
measure at room temperature is not valid at other temperatures, due to thermal contraction of 
the sample rod. If you are using the Install/Remove Sample Wizard, it will set the 
temperature for you. 

2. Click “Enter Offset Manually.” 

3. Enter the sample offset you measured. This should be 66±3mm. For accurate measurements, 
it is important to enter the offset as close as possible to the true value.  If your sample offset 
differs from this range, the sample should be repositioned on the sample holder.   
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Figure 1-18. Manual Sample Offset 

4. Click “OK.” 

1.4.3 Automatic Centering 
As the temperature of the sample changes, the dimensions of the sample rod and sample holder 
will also change, moving the sample away from the center of the detection coils. To compensate 
for this, use automatic centering to keep your sample centered during experiments (see Figure 1-
20). 
• There are two automatic centering modes: 

○ Auto-Tracking adjusts the sample location automatically to compensate for the 
thermal contraction of the sample rod and sample holder. The brass or quartz sample 
holder must first be specified in the “Sample Properties” dialog.  Auto-Tracking will 
generally give the best results and is the preferred setting in the MPMS 3. 

○ You may also disable automatic centering with No Automatic Centering. This will 
reduce the moment accuracy and result in slight measurement errors if the chamber 
temperature changes. 

 
• Specify the automatic centering mode each time you start a measurement or each time you 

place a measurement command or a center sample command into a sequence. The automatic 
centering setting is found on the “Setup” tab in the MPMS 3 Measurement window. 

1.4.4 Measuring Samples 
With DC measurements the sample is scanned up and down at constant speed and the SQUID 
signal is obtained as a function of position and time.  The up and down scans are subtracted in 
position space, giving an approximation of the system drift over the time of the measurement.  
Linear drift is then subtracted from the SQUID signal as a function of time, and the raw data is 
fitted to the dipole response function in position-space.  The fitting algorithm assumes that the 
sample magnetic moment approximates a dipole magnetic moment, with sign and value remaining 
constant during measurement.  DC Fixed Center and DC Free Center moments are calculated for 
each point, based on the dipole response function.  As the names suggest, for Fixed Center the 
center position has been fixed for the fitting routine, and with Free Center, the center position is a 
free parameter.  The auto-tracking feature mentioned above is particularly useful for the DC 
Moment Fixed Center.  The auto-tracking center acts as the seed center position for the DC scan.  
For more on DC measurement theory, refer to Chapter 4. 
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1.4.4.1 IMMEDIATE MEASUREMENTS 

Immediate measurements refer to the magnetic moment of a sample at a specific 
temperature or magnetic field. 

 
• Initiate sample measurement with the menu item Measure > Measure… or by 

clicking the “Measure” toolbar button.  Either method will open the 
Measurement window (Figure 1-20). 

 

     
Figure 1-19. Selecting "Measure" from either the pull-down menu or the toolbar button 

 
Base system tabs include Setup, DC, and Graph.  Additional tabs may be present for 
installed options such as VSM or AC.  Descriptions of the measurement tabs and 
parameters are given below. 
 

 
Figure 1-20. MPMS 3 Measurement window. 
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• Setup Tab      
o Specify “Continuous Measuring” for a continuous stream of data, or “Single 

Measurement” to collect a single data point. 
o Specify the SQUID “Ranging” as Sticky Autorange (default), Always Autorange, 

or Fixed Range.  Sticky Autorange selects the best range for each point while 
minimizing re-ranging between individual data points.  Always Autorange acquires 
each data point with the best possible resolution even if the measurement will take 
longer due to the increased range changing operations.  Fixed Range uses the 
SQUID range specified by the user. 
For additional details regarding SQUID ranging, refer to Appendix B: Advanced 
Software Options. 

 
Figure 1-21. Selecting a fixed SQUID range. 

o Specify which automatic centering method is used to keep the sample centered 
during measurement: 

 Auto Tracking – Automatically tracks the sample during cooling and 
warming based on known parameters of the sample rod-sample holder 
assembly.  In order to select this option, a Quantum Design supported 
sample holder must first be selected under Sample Properties.  Auto 
Tracking is disabled when using custom sample holders. 

 No Automatic Centering – Disables automatic centering  
 

o “Data Logging” (Figure 1-23) allows you to select a *.qmap file to log additional 
diagnostic information such as gas handling, temperature control, and magnet 
control data.  The data will be stored in the measurement data file.  An example of 
diagnostic data logging is shown in Figure 1-24.  This differs from the MutliVu log 
which can be run in the background in addition to your measurement data log.  For 
more information about running a diagnostic log in the background, refer to 
Appendix B.3. 
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Figure 1-22. Data logging option. 

 

Figure 1-23. Example of data selections to be logged. 

 DC Tab 
o Scan Length – Specify the total scan length (in mm). The value entered is the total 

length of the scan, which will be centered about the expected center position of the 
sample.  Scan lengths can be set between 10 mm and 60 mm (default: 30 mm). 

o Scans per Meas. – The total number of scans (up + down) to be acquired before the 
data is analyzed to calculate the sample moment.   

o Scan Time – Time (in seconds) for each individual (up or down) scan.  In addition 
to the values available from the drop down menu, non-integer values may be entered 
as well (optimal scan times depend on environmental conditions).  The default scan 
time is 4 seconds.  However, scan times may need to be adjusted based on the 
magnitude of your sample moment.  For samples with large moments, or time 
dependent magnetization, faster scans may be required.  
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NOTE Additional measurement considerations for the above DC parameters may be 
found in the following Application Notes: 

 1500-229, DC Scan and High Moment Samples 
 1500-018, Using Straw Sample Holder with DC Scan Mode. 

 
o Save Raw Data – Save raw scan data for each data point (into a separate *.raw 

file) for later analysis or post processing. The raw data file will be saved in the same 
folder as the measurement data file, under the same name as the data file, but with 
the *.raw file extension. 

 
Figure 1-24. DC measurement parameters. 

• Graph Tab – Shows the up and down scans (black) of the last DC measurement and the 
mathematical fit to the raw data (green). 

 
Figure 1-25. Calculated moment of the up and down scans (black) for the last DC measurement, 

along with the mathematical fit to the data (green). 
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Before clicking “Start” to begin the immediate measurement, temperature and magnetic field can 
be set by selecting Instrument > Temperature…  (or Instrument > Field…), or by clicking on 
either the temperature or field status bars (see Figure 1-27).  Both the system temperature and 
field control windows (Figure 1-26) allow the user to choose a set point and rate, as well as mode 
of approach.  Additional details regarding the status bar may be found in Section 2.2.5.  Approach 
modes are discussed in Section 2.3.5.2. 

  
Figure 1-26. System temperature and magnetic field control windows. 

 
Figure 1-27. MPMS 3 MultiVu status bar. 

For temperature, the stability criteria are: ±0.5K for T > 100 K, and ±0.5% for T < 100K.  Field 
stability is declared after the QuickSwitch heater has been turned off and the QuickSwitch 
becomes superconducting. 

1.4.4.2 SEQUENCE (AUTOMATED) MEASUREMENTS 

Automated measurements are controlled through sequence files, where operation 
commands are input by the user in a desired order.  In addition to measurement 
commands, several other operations are also available through sequence measurements, 
all of which are summarized in Chapter 2. 
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1.4.4.3 SUMMARY OF DC SCAN PARAMETERS 

Tables 1-1 and 1-2 below summarize the accepted DC and SQUID scan parameters for 
both DC centering and DC measurement scans.  Default values are indicated when 
applicable. 

 

Table 1-1. DC Scan Parameters 

PARAMETER 

ACCEPTED VALUES 

DEFINITION 
CENTERING 

SCAN 
MEASUREMENT 

SCAN 

Scan Length 60 mm 
10-60 mm (1- 6 cm) 

Default: 30 mm 

Length of sample transport’s 
vertical travel path that is 
scanned.  Sample is centered 
when it is in the middle of the 
scan length. 

Scans Per Meas. 1 1-100 

Number of scans (up + down) to 
be completed before data is 
analyzed and sample moment is 
calculated.  This value does not 
account for transport motion as a 
result of SQUID ranging. 

Data Points ~200 ~200 
Individual voltage readings 
plotting response curve in data 
file. 

Scan time 
1-15 s 

Default: 4 s 

1-15 s 

Default: 4 s 

Time in second for each 
individual up or down scan.  
Non-integer values within the 1-
15 second range may also be 
entered. 

Centering N/A 

Autotracking 

 

 

 

No Autocentering 

Sample location is adjusted 
automatically based upon the 
known thermal response of the 
QD sample holders and sample 
rod. 

 

Disables automatic centering. 
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Table 1-2. SQUID Parameters 

PARAMETER 

ACCEPTED VALUES 

DEFINITION 
CENTERING 

SCAN 
MEASUREMENT 

SCAN 

Ranging 

Default: Sticky 
Autorange 

(Not settable by 
user.) 

 

 

 

Sticky Autorange 

 

 

Always Autorange 

 

 

Fixed Range (1000, 
100, 10, or 1) 

SQUID range is a value of 
sensitivity (see Appendix B), 
with 1 being the most sensitive.   

Sticky Autorange (default) 
changes range only if the signal 
falls outside of a specified 
percentage of the full range.   

Always Autorange dynamically 
adjusts the range for maximum 
signal, for every single 
measurement. 

Fixed Autorange will keep the 
SQUID at the selected range; 
however, if the signal exceeds the 
maximum of the selected range, 
no data points will be collected. 

 

For additional information regarding DC measurement theory and applications, including sample 
and measurement considerations, refer to Chapter 4 of this user’s manual.  

1.5 Filling the Helium and Nitrogen Tanks 
 

 

 

W A R N I N G !  
Cryogens such as liquid helium and liquid nitrogen pose the 
following dangers:  (1) They can cause serious burns due to 
extreme cold. (2)  They may expand explosively in closed 
containers if warmed above their boiling point. (3) Their vapors 
may displace the breathable air in a closed room.  
(4) Liquid or vapors may back stream out of fill ports when 
removing caps/plugs/transfer lines. 
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W A R N I N G !  
To guard against these dangers, wear eye protection and 
protective clothing such as gloves and covered shoes when 
working with these cryogens. Also ensure that the room has good 
ventilation. Never disable relief valves, burst disks, or other safety 
devices on cryogen vessels and transfer equipment. 

Experienced personnel should perform or supervise these 
activities. 

 

 

W A R N I N G !  
When transferring helium, the probe top plate is heated to 
avoid moisture and ice collection close to electronic 
equipment. 

Beware: surfaces of the top plate might reach high temperatures. 

 

The MPMS 3 usually requires nitrogen about as often as it requires helium. It is recommended to 
fill the nitrogen and helium tanks at the same time.   Monitor the nitrogen level meter, as the 
presence of nitrogen is critical for low temperature operation and minimizing consumption of 
helium.  As older MPMS 3 systems do not have an integrated nitrogen level meter, it is very 
important to maintain a regular LN2 filling schedule.  Generally liquid nitrogen should be added 
once a week.  Do not use a high pressure (~200 psi, ~14 bar) liquid nitrogen storage dewar, but 
instead stay with the lower pressure (22 psi, 1.5 bar) rated nitrogen containers. The helium should 
be added as needed. 

If you fill the tanks while the instrument is measuring, measurement accuracy and precision may 
be compromised. 

 Several indicators help you to track your helium level: 

a. Status bar: The MultiVu status bar shows the remaining helium volume in liters (see 
section 2.2.5). 

b. Color bar: The color bar in the status bar indicates the urgency for helium refill. 

 Green: Helium level sufficient for proper operation. 

 Yellow:  System is still operational but helium should be filled soon. 

 Red: Helium needs to be filled immediately. The system will shut down and 
return to operational only once helium is filled up. 

c. Status light: The lower status light on the probe follows the same scheme as the color 
bar in the status bar (see section 1.6). 

1.5.1 Fill the Liquid Nitrogen Tank 
Open the fill port on the top of the nitrogen tank to determine if there is liquid 
nitrogen in the tank. If there is liquid nitrogen in the tank there will be a slight 
overpressure and gas will be forced out when you open it. If the tank has no liquid 
nitrogen there will be no overpressure or there will be a vacuum created by the 
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liquid helium evaporation which chills the nitrogen tank below the nitrogen boiling 
point—air will be sucked in when you open the tank. This vacuum effect can also be 
generated immediately after transferring liquid helium into the helium tank because 
the high flow of cold helium gas during the transfer may also cool the nitrogen tank 
below the nitrogen boiling point. 

 

 

W A R N I N G !  

Therefore, this check is only reliable two hours or more after 
transferring liquid helium into the instrument. (It is best to perform 
this check before starting to fill the helium tank.) 

 
 

1. Connect the hose to the nitrogen storage dewar. 

 

 
Figure 1-28. Liquid nitrogen transfer tank (only use low pressure containers p<22psi, 1.5 bar). 

2. Open one nitrogen fill port and insert the hose. 
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    Figure 1-29. Filling liquid nitrogen. 

3. Open the valve on the nitrogen storage dewar to start the transfer. 

 

 

W A R N I N G !  

CAUTION: If during the start of the transfer the rear exhaust does 
not open within the first 30 seconds, then stop transferring and 
refer to Appendix A.3.10. 

  

4. Transfer until the tank is full. Liquid nitrogen droplets will be expelled from the exhaust hose 
connected to the back of the MPMS 3 when the tank is full. The rubber hose exhaust should 
be visible to the operator when operating the system, in particular during transfers. 

5. Close the valve on the nitrogen storage dewar. The nitrogen fill port and adapter will be 
frozen. Wait a few minutes until the hose and fill port warm up. Remove the hose and replace 
the plug in the nitrogen fill port. 

 

W A R N I N G !  

CAUTION:  Cold nitrogen gas/liquid might backstream out of 
the open port. 

  

 

W A R N I N G !  

SERVICE NOTE: Inspect O-rings in the nitrogen inlet fittings once 
a month. Spare O-rings can be found in your utility kit in case they 
are damaged. Apply vacuum grease to keep them lubricated. 
Maintaining the nitrogen ports is important because it will prevent 
from ice plugging which can cause irreversible damage to the 
system. 
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1.5.2 Fill the Liquid Helium Tank 
 

 

W A R N I N G !  
Ramp the field to zero before starting transferring helium. 
Introducing warm gas into the dewar will cause the gas-cooled 
magnet to quench. 

 

 

W A R N I N G !  
Wear protective safety gear, such as gloves and goggles. 

Start the helium fill utility: 
 
Select the software menu item “Utilities > Helium Fill…”  

OR Press the “fill” button 

 
o The helium fill status and graph will be 

displayed.  If this is an initial cool down (or 
if the system has run dry) the software will 
ask whether this is an initial cool down or 
not. Selecting “Yes” will start the cool down 
wizard instead of the normal Helium fill (see 
Appendix A.4). 

   
Figure 1-30. Utilities menu. 

 
 

 
Figure 1-31. Helium fill utility. 
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o  Install the Helium transfer line extension and insert the Helium transfer line into 
the storage dewar: 

 
a. Make sure the appropriate extension for your storage dewar is on the long 

end of the helium transfer line—it should just reach the bottom of the 
storage dewar. Make sure the tube fitting is also on the long end of the 
transfer line. 

b. Vent excess pressure from the helium storage dewar. Then open the main 
valve on the helium storage dewar and insert the long end of the helium 
transfer line.                          

c. Tighten the fitting onto the tube adapter. Then slowly lower the Helium 
transfer line into the liquid helium until pressure builds up and gas begins 
flowing from the other end of the transfer line. 

d. Close the storage dewar safety relief valve so you may pressurize the 
storage dewar. 

 
Figure 1-32. Liquid helium storage dewar, and helium transfer line insertion into fill port. 

 

o Open the helium fill port on the MPMS 3 and rapidly insert the transfer line 
(Figure 1-32), then screw the fitting tight. 

 

 

W A R N I N G !  

CAUTION:  Cold helium might back stream out of the open fill 
port. 

 

o Monitor the transfer as follows: 
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a. Lower the Helium transfer line all the way to the bottom of the storage dewar 
then raise it up about 2 cm (1 in.) to prevent transfer of particulate 
contamination that has settled on the bottom. 

b. Pressurize the storage dewar with helium gas and maintain a gas flow into the 
dewar of about 3 liters per minute. The fill rate should not exceed 2%/minute. 

c. Monitor the helium level in the software, and adjust the gas flow to the storage 
dewar if the transfer rate slows. 

o When the meter reads full (100% ~70 liters), stop pressurizing the storage dewar, 
open the safety relief valve on the storage dewar, and remove the transfer line 
from the MPMS 3 and quickly replace the cap on the fill port. Make sure cap is 
screwed on tight to avoid ice collecting and plugging of the transfer insert on the 
probe. Then remove the Helium transfer line from the storage dewar and close the 
storage dewar main valve. Open the storage dewar pressure safety relief valve to 
ensure that no overpressure is building up inside the storage dewar. 

o In order to determine the level of helium remaining in your storage dewar, use the 
Taconis tube (i.e., “thumper” or “dip-stick”) that was provided with your 
MPMS3.   Instructions for using the Taconis tube may be found on the Quantum 
Design website in Application Note 1014-404: Using the Taconis Tube

 

1.6 Quick Reference:  Buttons and Status Lights 
The tables below describe the function and behavior of the three buttons and three status lights on 
the front of the SQUID VSM. The status lights are embedded within the buttons, but they function 
independently of the buttons. 
 

Table 1-3. Button Functions 

Button Name Used to… Function when Pressed 
 

Eject eject samples and 
open chamber 

Vents sample chamber continuously with helium and 
moves sample transport to top of travel. Disabled 
when chamber is not at room temperature and when 
measurement is in process. 

 

Load close chamber Purges sample chamber with helium, leaves 
chamber evacuated 

 

Fill start helium level 
monitor 

Turns on helium level meter and starts the helium fill 
utility software. Same as selecting “Utilities > Helium 
Fill…” 
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Table 1-4. Status Light States 

Light State Color Means 

 

on (solid) green Ready:  chamber has been purged, no sequence is running 

 

blinking 
slowly 

 

green Busy:  running sequence 

yellow Busy:  purging chamber 

 

blinking 
rapidly 

yellow Venting:  you should replace the cap and press the load button 
to purge the chamber as soon as possible 

red Error:  see the MultiVu event log (“Utilities > Show Event Log…”) 

 

on (solid) 
green Status:  last Helium level reading OK 

yellow Status:  last Helium level reading < 25% (~18 liters). OK to use 
system, but fill soon. 

 

blinking 
rapidly red 

Warning:  last Helium level reading extremely low (< 10% ~7 
liters). Fill the system as soon as possible. SQUID is not 

immersed in liquid helium (yields noisy measurements), inlet of 
flow controller is not immersed in liquid helium (yields loss of 

temperature control), magnet at risk (quench). System will shut 
down and recover once helium has been filled. Always fill both 

helium and nitrogen tanks 
 

 

blinking 
slowly yellow Busy:  reading helium level meter 
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C H A P T E R  2  

Software 

2.1 Overview 
In this chapter we describe MultiVu, the Windows™ software that coordinates the operation of 
the MPMS 3 hardware. MultiVu combines in a single user interface the basic instrument control, 
status reporting (section 2.2.5), data collection, graphing (section 2.4), sequence editing and 
sequence execution (section 2.3). In addition to these features, MultiVu also contains instrument 
utilities, diagnostics, and error reporting. 

 

MultiVu may be freely installed on additional computers. To install MultiVu, simply run the 
“MPMS 3 Setup.exe” program and follow the instructions provided within the setup program. 
To install MultiVu on a computer that is not connected to your MPMS 3 system, you would select 
“Simulation Mode” from the popup list in the “Select Components” step – depending on the 
options that are present in your system, you might want to enable some of the option installers as 
well (see Figure 2-1). 

 
Figure 2-1. Components selection dialog in the MPMS 3 setup. 
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Once installed, use the desktop icon for running MultiVu in simulation mode, which works 
without MPMS 3 hardware attached. In simulation mode, MultiVu will not control the instrument, 
report the instrument status, collect data, or execute sequences. Simulation mode allows you to 
use the sequence editing and data graphing features of the software from different computers, and 
is not intended for use on the MPMS 3 computer. 

To start the MPMS 3 MultiVu do one of the following: (a)  select and double click the desktop 
icon or (b) open the Windows Start menu and then locate and select the MPMS 3 MultiVu 
option.  The MPMS 3 MultiVu option may be located in the Programs > Quantum 
Design folder. 

 
Figure 2-2. MPMS 3 MultiVu icon. 

Wait for the MPMS 3 MultiVu to start up.  The MPMS 3 MultiVu interface opens, and in the 
center of the interface, the startup progress dialog box appears.  This dialog box identifies each 
task the system performs as part of the start-up.  The dialog box disappears as soon as start-up is 
complete. 

 

 
Figure 2-3. System startup progress dialog. 

When the MultiVu software is not running, the MPMS 3 goes into a hibernation state to prevent 
equipment damage. Most users will leave MultiVu running on the MPMS 3 computer at all times. 
MultiVu has a control to place the MPMS 3 in standby mode to conserve resources and still 
monitor the equipment status when it is not in use. Generally, it is not necessary to quit the 
MultiVu software.  Table 2-1 lists the directories and descriptions of files associated with the 
MPMS 3 MultiVu Software. 
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Table 2-1. MPMS 3 MultiVu Directories and Files 

DIRECTORY FILES DESCRIPTION MANUAL 
REFERENCE 

C:\QdSquidVsm\  Root directory 
containing all 
files related to 
MPMS 3 
MultiVu 

 

C:\QdSquidVsm\Data  Default directory 
to store all 
measurement 
data 

 

C:\QdSquidVsm\Macros  Directory for 
basic scripts 

2.3.2 

C:\QdSquidVsm\MultiVu SquidVsm.exe MPMS 3 
MultiVu 
program file 

 

C:\QdSquidVsm\MultiVu *.dll Libraries 
required for 
MPMS 3 
MultiVu (list of 
files depends on 
installed options) 

 

C:\QdSquidVsm\MultiVu *.chm On-line manuals  

C:\QdSquidVsm\MultiVu Event.log Log file 
containing 
diagnostic 
information for 
trouble shooting 

 

C:\QdSquidVsm\Qmaps *.qmap Definition files 
for additional 
data logging 

Appendix B 

C:\QdSquidVsm\Sequence  Default directory 
to store 
sequences 

2.1.2 

C:\QdSquidVsm\SVsm\Calibration Coil-….cfg System-specific 
calibrations 

 

C:\QdSquidVsm\SVsm\LogFiles ScanData.dat Result of last 
location scan 

 

C:\QdSquidVsm\SVsm\LogFiles VsmLog.txt Log file 
containing 
diagnostic 
information for 
debugging 
related to the 
measurement 
DLL 
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DIRECTORY FILES DESCRIPTION MANUAL 
REFERENCE 

C:\QdSquidVsm\SVsm\System SVsmMultiVu.dll Library used by 
MultiVu 
containing code 
for the moment 
measurement 

 

C:\QdSquidVsm\SVsm\System DCScanProcess.dll Library for 
performing data 
analysis (fitting) 
of DC scan data 

 

C:\QdSquidVsm\SVsm\System seqtrans_vsm_....dll Library for 
automatic 
updating of 
sequences 
written in older 
versions of 
MultiVu 

 

C:\QdSquidVsm\SVsm\System Vsm.ini INI file for 
customization of 
the measurement 
library 

 

C:\QdSquidVsm\System *Service.exe Windows 
Services that 
provide system 
control (e.g., 
temperature) 
even when 
MultiVu is not 
running 

 

C:\QdSquidVsm\System *StateMachine.dll Libraries used by 
the above 
services 

 

C:\QdSquidVsm\System QdWapiLog.txt 

QdWapiLog_Bak.txt 

Log files 
containing 
diagnostic 
information for 
the services/state 
machines 

 

C:\QdSquidVsm\Tools  Various utilities 
for system 
diagnostics 
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2.1.1 Graphical User Interface 
The main MultiVu window displays essential status information about the instrument and allows 
controlling the instrument with simple mouse-click commands. The interface allows immediate 
control of the MPMS 3 for performing a wide variety of standard tasks, such as changing the 
temperature or magnetic field, running measurements, or logging system data.  The interface also 
allows most functions of the MPMS 3 and its measurement options to be automated by using a 
series of simple commands, called a sequence.  Section 2.1.2 below describes how these 
commands are created and executed using a sequence editor.  

The software also allows you to view two different types of files:  sequence files (.seq) and data 
files (.dat). Sequence files are used to automate the instrument operation. Data files are 
collections of time-stamped data recorded by the instrument. The commands available in the user 
interface change based on the type of file in the active window within MultiVu. Shortcuts to 
common commands are found in context-sensitive menus you access by right-clicking on a data 
file (graph) window or on a sequence file window. 

2.1.2 Automation with Sequences 
Instrument operation is automated with files called sequences. Sequences are similar to simple 
computer programs or scripts that execute linearly. Program branching and logic are not part of 
the MPMS 3 sequence language, but some looping operations are provided. 

MultiVu contains an easy sequence editor where you double-click the command you want to 
insert into a sequence file, then fill in command parameters in a pop-up window. The editor 
allows typical Windows cut, copy, paste, and delete functions. The predefined sequence 
commands allow tremendous flexibility when automating the MPMS 3 operation. 

For advanced users, the editor also allows access to the underlying script that is executed when a 
sequence is run, so that advanced programming techniques can be applied. Such advanced 
techniques are not necessary for most users.  

MultiVu is also used to run, pause, lock, and abort sequences on the MPMS 3 and to view the 
status of sequences as they run. 

2.1.3 Data Files and Graphing 
Automation and the rapid data collection capabilities of the MPMS 3 allow large amounts of data 
to be saved to data files on the computer hard drive. Data files may be viewed in different 
formats, including graphs, tables, data records, and even raw text. The graph views may be 
extensively manipulated to help analyze data. Graph views may also be saved as templates for 
viewing other data so that common graph settings, such as data item selection, axis scaling, 
display range, and grid display may be applied in aggregate to any data file. The cells in table 
views may be copied and pasted into spreadsheets and graphing programs. However, the data file 
itself may not be altered or edited in MultiVu, except by adding data records and comments.
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2.2 Graphical User Interface 
The MPMS 3 MultiVu menu options and toolbar buttons provide for multiple ways of performing 
many basic tasks, such as opening files and running sequences. The menu options and toolbar 
buttons that are available depend on the active file and the task being performed and also on the 
installed hardware options. 

 
Figure 2-4. User interface overview. 

The main MultiVu window is shown above. The tool bar, control center, sequence command bar, 
and status bar may each be docked and un-docked or set to auto-hide by right-clicking any non-
control region or by dragging them around the main window. They may also each be hidden using 
the “View” menu. 
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2.2.1 Menu Bar 
The Menu Bar contains menus for accessing all fundamental software features. The available 
menus and menu options vary, based on the current task, active file, and installed MPMS 3 
options.  Some options add additional items to the menus. 

 

 
Figure 2-5. Main menu bar. 

 FILE - File menu contains commands for opening, closing, and printing sequence files 
and data files; for saving sequence files, graph files and graph template files; for 
generating new sequence files; and for exporting data files to alternate formats. 

 EDIT - Edit menu contains commands to edit sequence files. It is not shown unless a 
sequence window is selected. 

 VIEW - View menu allows you to show and hide the various components of the 
MultiVu graphical user interface, and to open different types of data file windows (graph 
view, table view, record view, raw data view.) 

 SAMPLE - Sample menu helps you install, remove, and locate samples and enter 
sample properties that are recorded in the data file. 

 SEQUENCE - Sequence menu contains commands to control the execution of 
sequences and to access the underlying script for advanced sequence editing. 

 MEASURE - Measure menu contains commands to control magnetic moment 
measurement, to change the data file where measurement data is recorded, to add 
comments to the data file, and to change the unit system used to record magnetic 
measurements. 

 GRAPH - Graph menu helps you manipulate the appearance of data file graph windows. 

 INSTRUMENT - Instrument menu contains commands to control the temperature, 
magnetic field, and vacuum state of the sample chamber, and to put the instrument into 
shutdown mode when unused. For more information about the modes of instrument 
operation, see Chapter 3:  Hardware. 

 UTILITIES - Utilities menu contains commands to activate and configure instrument 
options, and to help maintain and troubleshoot the instrument, including filling the 
helium tank, tuning the SQUID, logging diagnostic data, and viewing error messages. 
(See Appendix B for more information.) 

 WINDOW - Window menu helps arrange the open windows in MultiVu. 

 HELP - Help menu contains version and serial number information about the MPMS 3, 
and access to the user documentation. 
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2.2.2 Tool Bar 
The Tool Bar contains shortcuts that let the user initiate many of the more frequently performed 
MPMS 3 MultiVu functions without having to select multiple, nested menu options.  The buttons 
are grouped according to function.  The active file and the current state of the sequence operation 
determine which buttons are enabled. 

The user may move, dock, hide, or display the tool bar.  The “View > Tool Bar” toggle 
option hides or displays the tool bar. 

If the mouse pointer pauses over a tool bar button, a ToolTip pops up display the name of the 
button. 

 
Figure 2-6. Tool bar. 
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2.2.3 Control Center  
The Control Center (Fig. 2-7) 
provides an overview of the 
currently installed sample name, 
selected data file name, selected 
sequence file name, measurement 
status, and sequence execution 
status. In addition, there are 
buttons to provide quick access to 
change the sample; change the data 
file; change the selected sequence; 
edit, run, pause, abort, or lock the 
selected sequence; and view a 
graph of the current data file. 

2.2.4 Sequence Command 
Bar 
The Sequence Command Bar (Fig. 
2-8) is shown when you edit 
sequences. You can toggle its 
display by selecting the “View > 
Sequence Command Bar” entry 
while editing a sequence. It 
contains commands you may insert 
into the sequence. Commands are 
organized in a tree structure. Click 
“+” and “-” to expand or collapse 
tree branches. Double click 
commands to insert them into the 
sequence. More on sequences is 
found in section 2.3. 

 
Figure 2-7. Control 

center. 

 

 
Figure 2-8. Sequence command 

bar. 

2.2.5 Status Bar 
The Status Bar displays the sequence status and the status of the magnetic field, system 
temperature, and the MPMS 3 sample chamber.  The color of the helium tank level-reading 
changes to yellow, then red when the helium level drops too low. The length of the colored bar 
indicates the fill level. Click on the panels in the status bar as shortcuts to basic instrument control 
(such as temperature, magnetic field, and chamber vacuum state) and SQUID diagnostics. 
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You might minimize, maximize, hide, display or move the status bar.  By default, the status bar is 
maximized to show the maximum amount of status information.  The “View > Status 
Bar > None” menu entry hides the status bar. “View > Status Bar > Maximum” 
displays the entire status bar. 

 

 
Sequence: 

-status 
-file name 
-execution line 

Temperature: 
-present state 
-setpoint 
-rate and mode 

Magnetic Field: 
-present state 
-setpoint 
-rate and mode 

Sample Chamber: 
-pressure 
-state 

Helium Tank: 
-approximate volume 
remaining 

SQUID: 
-reading 
-range 

Figure 2-9. Status bar. 

The sequence status panels indicate whether a sequence is running.  The top or first panel always 
indicates the sequence status: Idle, Running (green background), or Paused (yellow background).  
During the run, the sequence status panels display the current sequence step, the name of the 
running sequence, and the base name of the active data file.  If another sequence is selected for 
editing while a sequence is running, the sequence status panels continue to show the name of the 
running sequence and the base name of the data files storing the measurement data from the 
current sequence run.  Clicking on any sequence status panel displays the control center. 

The temperature status panels display the current system temperature and indicate the state of the 
temperature control.  Clicking on any temperature status panel opens the Temperature Parameters 
dialog box.  The field status panels display the current magnetic field and indicate the state of the 
field control.  Clicking on any field status panel opens the Magnetic Field dialog box. 

The chamber status panels display the state of the sample chamber status and indicate the level of 
helium in the dewar.  Clicking on any chamber status panel opens the Chamber dialog box. 

The SQUID status panels show the current SQUID voltage and range (1, 10, 100, or 1000) – 
during a SQUID reset or while tuning the SQUID the bottom panel will show SQUID status 
information. Clicking on any SQUID status panel opens the SQUID diagnostics window. 

2.2.6 Sequence Window 
The Sequence Window is used for editing sequences. More than one sequence window may be 
open at a time. The selected sequence is always the sequence in the last sequence window that 
was active (clicked). The control center reports the selected sequence file name. The selected 
sequence is the sequence into which commands will be inserted when selected with the sequence 
command bar. The selected sequence is also the sequence that executes when “Run Sequence” 
( ) is selected, when the control center “Run” button is selected, or when the menu command 
“Sequence > Run” is selected.
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2.2.7 Data Window (Table View) 
The Data Window (Table View) shows a data file in table format. Each row in the table represents 
a single data record. A data record consists of several data items collected simultaneously, such as 
sample temperature, magnetic field, and magnetic moment. You may view a single data record in 
its own window by double-clicking any record in the table view. 

Cells and groups of cells in the table view can be selected, copied, and pasted into other 
spreadsheets and graphing programs for additional analysis using the standard Microsoft 
WindowsTM copy and paste features. 

2.2.8 Data Window (Graph View) 
The Data Window (Graph View) shows a data file in graph format. Each point on the graph 
represents a single data record. A data record consists of several data items collected 
simultaneously, such as sample temperature, magnetic field, and magnetic moment. Hovering the 
mouse over any data point will display a tool tip with the values for that point. You may view a 
single data record in its own window by double-clicking any record in the graph view. The record 
view and graph view are linked, so that the highlighted point on the graph view corresponds to the 
record shown in the record view. 

The appearance of the graph view may be manipulated extensively and templates may be applied 
to the graph view so that you do not need to set each graph characteristic individually. To learn 
more about manipulating the graph view, read section 2.4 “Graphing Data Files.” 

 

 

2.3 Sequences 
 

Operation of the MPMS 3 can be automated using sequence files. Sequence files are like simple 
computer programs instructing the instrument to carry out a number of operations in a 
predetermined order. Operations typically found in a sequence file include changing the sample’s 
temperature, changing the magnetic field, and measuring the sample’s magnetic moment. 
Additionally, commands may be placed in sequences to log diagnostic data, center the sample, 
record a comment in the data file, begin recording data to a new data file, generate a message on 
the computer screen, and even run another sequence. 

2.3.1 Editing Sequences 
• Create a new sequence file by clicking “New Sequence”  or selecting the menu item 

“File > New Sequence.” 

• Open an existing sequence file for editing by clicking “Open Sequence”  or selecting 
the menu item “File > Open… > Sequence.”  You will be prompted to locate the 
file you want to open. 
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• The top of the sequence window shows the sequence file name. An asterisk symbol (*) 
after the file name means the sequence has changed since last time the file was saved. 
Sequences must be saved before you run them. 

• Save a sequence file by clicking “Save Sequence”  or selecting the menu item “File 
> Save.”  If not already assigned, you will be prompted for a location and file name.  

• Add a command to the selected sequence by double-clicking the command in the 
sequence command bar. The new command is inserted above the highlighted command 
in the selected sequence window. You will first be presented with a pop-up window to 
fill in command-specific information. Then a summary of the command will appear in 
the sequence window. More detail about each available sequence command is found at 
the end of this section. 

• Remove and reorganize sequence commands by 
highlighting them in the sequence window and using 
the “Cut,” “Copy,” “Paste,” “Delete,” and 
“Undo” commands in the “Edit” menu. 

• Disable commands in a sequence file without 
deleting them using “Edit > Disable” (Fig. 2-
10). Enable a disabled command with “Edit > 
Enable.” A disabled command will be skipped 
during sequence execution. Disabled commands are 
preceded by an exclamation mark symbol (“!”) in 
the sequence window and are changed from black 
text to gray text. With this feature you may decide to 
execute or not execute some commands just prior to 
run time based on the immediate circumstances. For 
example, you may wish to disable a series of 
commands that fall outside the meaningful 
measurement range for certain samples. 

 

• All of the commands found in the “Edit” menu are duplicated in a pop-up menu when 
you right-click any sequence window. 

2.3.2 Advanced Script Editing (Macros) 
Before running sequences, MultiVu automatically compiles sequence files into a Visual Basic for 
Applications type of script. Users with programming experience may compile this script without 
running the sequence, and may then edit the script directly and run the edited script (macro). 
However, Quantum Design cannot certify the instrument behavior when it is automated with user-
designed scripts. Many checks and safeguards are bypassed when running a sequence script 
directly. Novice users should not use this feature. Advanced users with programming experience 
should use this feature with caution. 

 
• Compile and edit the sequence script using the menu commands “Sequence > 

Advanced > Compile Macro” and “Sequence > Advanced > Edit 
Macro.”  A Sax Basic editor window will appear. 

• Run the script with the menu command “Sequence > Advanced > Run Macro.”  
You will be prompted to locate the script file to run. Or you may run the script by 
clicking the “Start/Resume” button ( ) in the Sax Basic editor window. 

Figure 2-10. Disabling 
sequence commands. 
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• Find more information about the Sax Basic editor and scripting language by right-
clicking in the Sax Basic editor window and selecting “Help > Editor Help” and 
“Help > Language Help.” 

2.3.3 Running Sequences 
 

• If the sequence file you want to run is not open, you need to open it. Open an existing 
sequence file by clicking “Open Sequence” ( ) or selecting the menu item “File > 
Open… > Sequence.”  You will be prompted to locate the file you want to open. 

• To execute a sequence, it must be the selected sequence. If more than one sequence 
window is open, make sure the selected sequence is the sequence you want to execute. 

• Execute the selected sequence by: 

○ Selecting “Run Sequence” ( )  

OR 

○ Selecting the menu command “Sequence > Run.” 

OR 

○ Selecting the “Run” button on the control center. 
• The status bar and the control center both display the status of the sequence execution. 

The sequence window also highlights the line currently being executed in green. 
• The toolbar, “Sequence” menu, and command center all provide the ability to pause 

( ) and abort ( ) sequence execution also. When paused, the sequence window 
highlights the active line of the sequence in yellow.  If a sequence is aborted, it will 
finish its current measurement motion before executing the abort sequecence command. 

2.3.4 Locking Sequence Execution 
• When the sequence execution is locked, a sequence cannot be run, paused, or aborted 

without first unlocking sequence execution. You cannot exit MultiVu when sequence 
execution is locked either. 

• No key or password is required to lock or unlock sequence execution. The feature is 
intended only to prevent careless and accidental interference with instrument operation. 
It is not a security device against malicious behavior. 

• The instrument does not need to be running a sequence to lock sequence execution. 
• Lock sequence execution by clicking “Lock Sequence” ( ). Or select the menu item 

“Sequence > Lock,” or click the “Lock” button on the control center. Type in your 
name and additional information so other users know why the sequence is locked, then 
click the “Lock” button. All run, pause, and abort controls in the graphical user interface 
are disabled. 
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Figure 2-11. Locking/unlocking sequences. 

• Unlock the sequence by clicking “Lock Sequence” ( ) again. Or select the menu item 
“Sequence > Unlock,” or the “Unlock” button on the control center. Then click the 
“Unlock” button on the popup dialog, which displays the name and message of the 
person who locked sequence execution. 

2.3.5 Sequence Commands 
The following sequence commands can be used in sequences. Option software purchased with the 
MPMS 3 may provide additional sequence commands not listed here. 

2.3.5.1 MEASUREMENT COMMANDS 

○ Measure – Creates a sequence step specifying all necessary parameters (see tabs in 
Figure 2-12 below) to run or stop a measurement. 
 
Note that there might be additional tabs available between the “DC” and “Advanced” 
tabs that are not shown in the screen shots –tabs are added dynamically when 
additional measurement options (such as VSM or AC) are present. Please refer to the 
respective option manuals for details on the parameters available. 
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                       Figure 2-12. MPMS 3 Sequence Measure - measurement parameters interface. 
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 Setup Tab 
o Action – Select “Start/Reconfigure” to start measuring with the parameters 

specified on the other tab(s). Select “Stop” to stop any measurement that is 
currently running 
Note: when “Stop” is selected as the action, none of the other settings in this 
or any other tab matter 

o Measure Type – Specify “Continuous Measuring” for a continuous stream of 
data, or “Single Measurement” to collect a single data point 
Note: when “Continuous Measuring” is selected, the sequence will 
immediately advance to the next step and the system will keep measuring until 
it encounters the next “Stop Measure” command. When “Single 
Measurement” is selected, the sequence will continue to its next command 
only after the data point has been acquired 

o Logging Interval – Specify the logging interval (for continuous measurement 
stream) – specifying any number smaller than the measuring time for the 
selected measurement will result in every data point acquired to be logged to 
the data file as fast as possible. 
 

 DC Tab 
o Measure DC Moment – Checkbox to en-/disable DC scan data acquisition. 

The status of this checkbox is also displayed in the title “DC” tab 
o DC scan parameters common to both Immediate and Automatic measurements 

(Scan Length, Scans per Measurement, Scan Time, and Ranging) are 
described in Section 1.4.4 Measuring Samples. 
 

 Advanced Tab 
o Centering - Specify which automatic centering method is used to keep the 

sample centered (“Auto Tracking” typically gives the best results and is the 
preferred selection) 
 

 Data Logging – Specify additional data that will be logged with each data point in 
the measurement data file 
 

 Default – Reset all parameters to their system defaults 
 

○ New Datafile – Changes the data file being used to record data (Fig. 2-13). You must 
specify a path and file name for the new data file. In addition, specify whether data 
should be written to a new version of the data file or appended to the end of the existing 
file if the specified file already exists. If you select “Create New File/Version” and a file 
with the specified path and file name already exists, the data will be written to a new file 
with the specified file name plus a five digit number appended to the end of the file name 
as a unique identifier, such as “MyDataFile_00001.dat,” “MyDataFile_00002.dat,” etc. 
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Figure 2-13. Creating a new datafile. 

○ Datafile Comment – Puts a comment in the present data file, along with a time stamp. 
The comment and time stamp constitute a single data record in the data file. 
This can be useful to tag data in order to facilitate post processing 

○ Center Sample – Allows you to reposition the sample for accurate measurements, and to 
change the automatic centering setting. (Also allows advanced operations:  moving the 
sample to any specified location, motor touchdown and motor home.)  If your sample 
begins the sequence well-centered and automatic centering is enabled, this command 
may not be necessary. 

○ Moment vs. Field – Performs a series of magnetic moment measurements at specified 
magnetic fields (see also chapter 1.)  You specify the maximum and minimum fields and 
one intermediate field (typically zero field) and the shape of the field ramps to perform, 
for example, four-quadrant or five-quadrant hysteresis loops. The series may begin and 
end on either the maximum, minimum, or intermediate field. You also control the rate of 
field change in between fields and whether the field stabilizes for each measurement or 
continues changing (sweeps) while the measurement is performed. 
Note that measuring while sweeping the field will result in decreased sensitivity and less 
accurate data and is only suggested for qualitative analysis. Moreover, due to coupling 
from the magnet to the superconducting gradiometer, the field sweep rate cannot be set 
too high or no data can be acquired as the SQUID will be over-ranging too often. 
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        Figure 2-14. MPMS 3 Moment vs. Field sequence command - setup interface. 

You specify the data spacing in field (H) (uniform in H, H2, H1/2, 1/H, or log(H)) and the 
number of data points per two-quadrant ramp. Alternatively, you may also specify 
“continuous measuring,” in which case the instrument will record data as quickly as 
possible, with your averaging time, while the field sweeps are performed. You may also 
repeat multiple measurements at each magnetic field. The software displays the 
approximate magnetic fields where measurements will be performed with your settings, 
and the estimated total time to perform the measurement series. 
Measurement parameters and selection of measurements to be performed can be 
specified in the individual measurement tabs in the same manner as for the “Measure” 
command above. 
Note that the “Moment vs. Field” command requires that the temperature is stable at 
each field before collecting any data. 
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○ Moment vs. Temp. – Performs a series of magnetic moment measurements at specified 
temperatures (see also chapter 1.)  You specify the start and end temperature, and the 
rate of temperature change. You also control whether the temperature stabilizes for each 
measurement or continues changing (sweeps) while the measurement is performed. You 
specify the data spacing in temperature (T) (uniform in T, T2, T1/2, 1/T, log(T)) and the 
total number of data points. Alternatively, you may also specify “continuous measuring,” 
in which case the instrument will record data as quickly as possible, with your averaging 
time, while the temperature sweep is performed. You may also repeat multiple 
measurements at each temperature. The software displays the approximate temperatures 
where measurements will be performed with your settings, and the estimated total time to 
perform the measurement series.  Measurement parameters (e.g., scan length, scan time) 
can be specified in the individual measurement tabs in the same manner as for the 
“Measure” command above (see chapter 4 for application considerations). In addition to 
Auto-Tracking settings, the “Advanced” tab also allows you to specify a wait time at 
each temperature prior to commencing measurement and the temperature approach mode 
(fast settle, no overshoot—see set temperature command above) for each temperature. 

○ Auto-Tracking – Allows you to turn Auto-Tracking on or off. Note that Auto-Tracking 
should typically be enabled as it will provide the most accurate data by keeping the 
sample automatically centered while changing temperatures – Auto-Tracking might be 
disabled when using custom sample holders where no Auto-Tracking parameters are 
available. 

2.3.5.2 SYSTEM COMMANDS: 

• Call Sequence or Script – Suspends 
execution of selected parent sequence file 
and begins execution of specified child 
sequence file or script file. When execution 
of specified child sequence file or script is 
complete, execution of selected parent 
sequence will continue with the next line. 

• Chamber Operations – Changes state of 
the sample chamber atmosphere. (Fig. 2-15) 

• Remark – Serves as a message, comment, 
or visual break for the user only. Does 
nothing when executed in a sequence file. 

• Scan Field – Creates a program loop for 
executing repeated commands at user-
defined magnetic field increments. All 
commands between the “Scan Field…” line 
in the sequence and the “End Scan” line in 
the sequence will be repeated at each 

 

Figure 2-15. Chamber operations menu. 

magnetic field specified by the scan field command. Set the initial and final fields and 
the scale on which the field increments should appear uniform (linear, H2, H1/2, 1/H, 
log(H).)  Also set the total number of field steps. (For uniform linear spacing, you may 
alternatively set the field increment.)  Finally, specify the rate and approach mode used 
by the magnet controller to achieve each set point: 
○ Linear:  Controller will drive directly to each field and attempt to maintain the 

specified charging rate as closely as possible until each set point is reached. At each 
set point the field will stabilize, and remain stable, until the commands within the 
loop are completed. A small amount of field overshoot can occur in this mode. 
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○ No Overshoot:  Controller will drive 80% of the way to each set point at the desired 
rate, and will then slowly step up (or down) to the set point to avoid any field 
overshoot. At each set point the field will stabilize, and remain stable, until the 
commands within the loop are completed. This is intended for use with highly field-
hysteretic samples. 

○ Oscillate:  Controller will intentionally overshoot each set point by 70% of the total 
field change, at the desired rate, and will then oscillate into the set point field in 
smaller and smaller overshooting steps. At each set point the field will stabilize, and 
remain stable, until the commands within the loop are completed. This is intended to 
eliminate flux motion in the superconducting magnet windings, yielding a very 
stable magnetic field and more stable SQUID operation. True zero field is best 
achieved using oscillate mode. 

○ Sweep:  Controller will drive directly from the initial field to the final field without 
stopping. Each time a field increment defined by the command is reached, the 
commands inside the scan field loop will be executed, but the field will continue to 
change while they execute. 
Note that measuring while sweeping the field will result in decreased sensitivity and 
less accurate data and is only suggested for qualitative analysis. Moreover, due to 
coupling from the magnet to the superconducting gradiometer, the field sweep rate 
cannot be set too high or no data can be acquired as the SQUID will be over-
ranging too often.  

• Scan Temperature – Creates a program loop for executing repeated commands at user-
defined temperature increments. All commands between the “Scan Temperature…” line 
in the sequence and the “End Scan” line in the sequence will be repeated at each 
temperature specified by the scan temperature command. Set the initial and final 
temperatures and the scale on which the spacing of the temperature steps should appear 
uniform (linear, 1/T, log(T).)  Also set the total number of temperature steps. (For 
uniform linear spacing, you may alternatively set the temperature increment.)  Finally, 
specify the rate and approach mode used by the temperature controller to achieve each 
set point: 
○ Fast:  Controller will drive directly to each temperature and attempt to maintain the 

specified sweep rate as closely as possible until each set point is reached. At each set 
point the temperature will stabilize, and remain stable, until the commands within 
the loop are completed. A small temperature overshoot can occur in this mode. 

○ No Overshoot:  Controller will drive to each set point at the desired rate until it is 
less than 30 seconds from achieving the set point, and will then slow the rate 
significantly to avoid temperature overshoot. At each set point the temperature will 
stabilize, and remain stable, until the commands within the loop are completed. This 
is intended for use with highly temperature-hysteretic samples. 

○ Sweep:  Controller will drive directly from the initial temperature to the final 
temperature without stopping. Each time a temperature increment defined by the 
command is reached, the commands inside the scan temperature loop will be 
executed, but the temperature will continue to change while they execute. 

• Scan Time – Creates a program loop for executing repeated commands at user-defined 
time increments (or immediate repetitions with no time increment.)  All commands 
between the “Scan Time…” line in the sequence and the “End Scan” line in the sequence 
will be repeated at each time specified by the scan time command. Set the total time in 
seconds and specify whether the spacing of events should be uniform in time or 
logarithmic in time. And specify the number of steps. This is the number of times the 
loop will be repeated. (For uniform spacing in time, you may alternatively specify the 
time increment.)  If the total time is set to zero seconds, then the number of steps defines 
how many times the loop will be repeated in rapid succession. 



Chapter 2 Section 2.3 
Software Sequences 

Quantum Design  MPMS 3 User’s Manual, 1500-100, Rev. F1 2-21 
June 2016 

• Sequence Message – Displays a message on the computer screen and pauses sequence 
execution until the message is acknowledged or until a timer expires. If the computer is 
set up with internet access and access to a mail server, a message can also be emailed 
with attachments such as data files. 

• Set Field – Sets the instrument’s magnetic field. Specify the field, the charging rate, and 
the approach: 
○ Linear:  Controller will drive directly to the field and attempt to maintain the 

specified charging rate as closely as possible. A small amount of field overshoot can 
occur in this mode. 

○ No Overshoot:  Controller will drive 80% of the way to the set point at the desired 
rate, and will then slowly step up (or down) to the set point to avoid any field 
overshoot. This is intended for use with highly field-hysteretic samples. 

○ Oscillate:  Controller will intentionally overshoot the set point by 70% of the field 
change, at the desired rate, and will then oscillate into the set point field in smaller 
and smaller overshooting steps. This is intended to eliminate flux motion in the 
superconducting magnet windings, yielding a very stable magnetic field and more 
stable SQUID operation. True zero field is best achieved using oscillate mode. 

Notice that sequence execution continues with the next command in the sequence as soon 
as the field is set, not when the field set point is achieved. To wait for a stable magnetic 
field before executing the next command, use the Wait command. 

• Set Temperature – Sets the sample temperature. Specify the temperature, the rate, and 
the mode: 
○ Fast Settle:  Controller will drive directly to the temperature and attempt to maintain 

the specified rate as closely as possible until the set point is reached. A small amount 
of temperature overshoot can occur in this mode. 

○ No Overshoot:  Controller will drive to each set point at the desired rate until it is 
less than 30 seconds from achieving the set point, and will then slow the rate 
significantly to avoid temperature overshoot. This is intended for use with highly 
temperature-hysteretic samples. 

Notice that sequence execution continues with the next command in the sequence as soon 
as the temperature is set, not when the temperature set point is achieved. To wait for a 
stable temperature before executing the next command, use the Wait command. 

• Shutdown – Places the instrument in shutdown mode to conserve resources. The motor 
is powered down, the field is set to zero and the magnet controller is turned off, the 
cooling flow is reduced while the current temperature is maintained. 

• Wait – Waits for specified conditions to be achieved, then delays a specified amount of 
time before continuing with sequence execution. Conditions that can be specified to wait 
for are temperature stability, field stability, stepper motor position (not currently in use), 
and chamber state. This command is usually used immediately after another command in 
order to make sure the desired outcome of the first command is achieved before 
proceeding. For example: 

Set Temperature 77K at 10 K/min. Fast Settle 

Wait For Temperature. Delay 10 secs, No Action 

Measure Moment vs. Field… 

This sequence will wait 10 seconds after the instrument has achieved temperature 
stability at 77K before beginning a series of moment measurements at various magnetic 
fields. Specify, also, what the instrument should do if an error occurs while waiting for 
the specified conditions (no action, abort sequence, or shutdown instrument.) 
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2.3.5.3 ADVANCED COMMANDS: 

• Beep – Causes the computer to make the Windows default beep sound. 
• Helium Low Pause – Pauses sequence execution if the liquid helium level drops below 

a specified reading on any normal helium level update. This command is useful in very 
long sequences, when execution might take place over a period when nobody is present 
to monitor the helium level. For safety reasons, any running sequence will be 
automatically stopped and the system shutdown when the helium level gets below 10% 
(~7 liters – this emergency level is 0% in an EverCool system) (see section 1.6). 

• Log Data – Records specified diagnostic data to a data file at a specified rate. No size 
limit is imposed on the data file generated, so the data file can get extremely large and 
difficult (or slow) to process. See appendix B for more information on logging diagnostic 
data. 

• Magnet Reset – Drives the magnet to zero field and applies heat to the superconducting 
magnet windings to remove trapped magnetic flux. (See Chapter 4 for application 
considerations.) 

• Sigma Log Data – Records specified diagnostic data to a data file at a specified rate. 
This command is similar to the Log Data command, except that it allows you to record 
statistics such as a running average and standard deviation for each data item, in each 
data record. It may generate large data files with large header sections. See appendix B 
for more information on logging diagnostic data. 

• SQUID – Allows direct control of the instrument’s SQUID. It is not usually necessary to 
utilize these controls because the instrument automation already optimizes SQUID 
operation. 
○ Quench – Applies heat to the SQUID or to the SQUID input (superconducting 

detection coil circuit) to eliminate standing currents. 
○ Reset – Holds the SQUID in reset for a specified amount of time, applying heat 

directly to the SQUID to return the SQUID output to nearly zero volts. 
○ Set Range – Sets the SQUID head gain manually. Overrides any auto-ranging that 

may be in effect.
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2.4 Graphing Data Files 
The graph view is the default for viewing data files. Any data file with one or more data records 
may be opened in a graph view. The appearance of graph views may be manipulated extensively 
to aid data analysis. 

• Open a data file to graph by clicking “Open Data File” ( ) or by selecting “File > 
Open > Datafile.”  Or on the control center click “View” to open the current data 
file. 

2.4.1 Data Selection and Plot Axes 
• Change the plot axes by selecting “Graph > Data Selection…” or right-click in 

an open graph window and select “Data Selection…” 
 

 
 

Figure 2-16. Graphing parameters interface. 
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• The axes may be assigned any label for which data exists in the data file. 
• Up to four vertical axes may be displayed on separate plots in the same graph window, 

but all plots in the graph window must share the same horizontal (x) axis. 
• To see more data in an additional window, right-click on the existing graph view window 

and select >>New Window. 
• When auto-scaling is selected for all axes, the plot axes will be rescaled each time new 

data is written to the data file so that all data is displayed. This helps optimize data 
viewing as data is being collected. 

• Quickly auto-scale the axes by right-clicking in the graph window and selecting “Auto 
Scale All Plots.” 

• Use the “>>” button to add custom axis labels and to change the axis scaling multiplier 
by factors of 10. 

• Use the “Filter…” button to plot only records with data that falls within a specified 
range. For example, specify a range for fit quality to hide data with a bad fit (i.e. noisy 
data.) 

• The “OK” button applies the changes to the graph window and closes the Data Selection 
dialog. The “Apply” button applies the changes to the graph window without closing the 
dialog. The “Cancel” button closes the Data Selection dialog without making any 
changes to the graph window. 

2.4.2 Plot Appearances 
• Change the appearance of each plot by selecting “Graph > Appearance > Plot 

1” (or “… Plot 2,” etc.) or right-click the plot you want to change and select 
“Appearance.” 

• Turn horizontal and vertical grid lines on 
and off with this dialog. 

• Choose between markers on each data 
record, lines between each data record, or 
both markers and lines. The lines shown 
can be limited to only those in the positive 
or negative x-quadrant direction using the 
“>>” button. 

• Check “Apply to All Plots” to 
apply the appearance settings to all plots in 
the graph window. 

Figure 2-17. Plot appearance interface. 
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2.4.3 Templates and Graph Files 
Groups of graph view settings may be saved in template files (.tpl) and applied to other data files 
so the graph view of each data file will look similar. The settings saved in template files include 
all settings in the Data Selection and Plot Appearance dialogs. This feature helps view many 
different data files in the same graphic format. 

A graph file (.gph) is a template file that MultiVu automatically applies to the data file (.dat) with 
the same name whenever the data file is opened in graph view.  You may save template files as 
graph files (.gph), but it is not necessary to do so. MultiVu automatically saves a graph file for 
each data file whenever all graph views are closed so that the graph view of the data file will look 
the same next time it is opened. 

• To save a template file, format the graph view as desired, then: 
○ Select “File > Save Template” 

OR 
○ Select “Graph > Save Template” 

OR 
○ Right-click the graph view window and select “Save Template” 

 

Then specify the path and file name for the template file. (Specify “Graph Files (.gph)” in the 
“Save as type:” box to save the template as a graph file. Be sure the file name you specify 
matches the data file you want the graph applied to in this case.) 

 
• To apply a template to a data file, select “Graph > Apply Template…” (or right-

click the graph view and select “Apply Template…”)  Then locate the template 
or graph file you want to use. 

• “Graph > Restore Graph” applies the settings from the graph file to the graph 
window. This will undo any settings changed since last time the graph file was saved. 

• “Graph > Default Graph” sets the axes to Moment and Time Stamp, with auto-
scaling on both axes. 

2.4.4 Exporting Data Files 
• Many spreadsheet programs can read the standard .dat files MPMS 3 MultiVu 

generates. They have a comma-delimited format. But the files contain additional header 
information and may contain diagnostic data that complicates your data analysis or 
communication with collaborators. To export data files, or subsets of the data in a data 
file, to an alternate file format use the “Export Data…” toolbar button ( ) or choose 
“File > Export…” from the menu. This feature generates data files from the data 
you specify in several formats that most graphing and spreadsheet programs understand. 
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Figure 2-18. Exporting data. 

• Make sure “Data File” specifies the file you want to export. 
• Designate the path and file name of the new file to write under “Export File.” 
• Under “Destination File Format,” choose which character will separate data items in the 

new file:  tab, comma, or space. 
• Choose whether you want column headers (column labels), full headers, or no headers. 

○ With full headers, the file format must be comma delimited. All the header 
information at the beginning of the data file will be written to the new file, including 
sample properties, software revision, and other information used by MultiVu. This 
header information will appear at the beginning of the exported data file and may 
not be easily imported by other programs. This option is used to keep the existing 
file format but export a subset of the data. 

• Click “Select Data” to specify which data items to export. 
○ Available data items are listed on multiple tabs. 
○ Check the box next to data items to write them to the export file. 
○ Specify the order of the data columns in the export file by entering numbers in the 

“Col Order” boxes. 
○ To exclude data that falls outside a certain range, check the “Select Range” box and 

specify the range of data to keep. 
• Click “Export” to write the selected data to the new file. You will see a confirmation 

dialog when the operation is complete. 
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C H A P T E R  3  

Hardware 

3.1 Overview 
In this chapter we describe the MPMS 3 hardware. The goal is to provide enough details to help 
understand how the system is working. In section 3.2 we give a general introduction on the system 
architecture and detail the power distribution, the module bay tower and the dewar setup. We 
provide insight into the heart of the instrument: the temperature control (section 3.3) allowing to 
vary the temperature between 1.8 and 400 Kelvin, the magnetic field control (section 3.4) 
generating fields from -7 to +7 Tesla, the motion control (section 3.5) scanning the sample in field, 
the SQUID detection system (section 3.6) sensing the induced signal collected by the pick-up coils 
and finally the facilities controlling the chamber atmosphere (section 3.7) and the cryogen level 
(section 3.8). Additional hardware such as the sample rod is described in section 3.9. 

3.2 System Setup 
The MPMS 3 hardware is primarily contained in a two-part metal enclosure.  The upper half of the 
enclosure contains a computer running the MultiVu software and a module bay housing the 
instrument’s modular electronics.  The lower half of the cabinet contains a dewar.  The sample 
transport is mounted on top of the cryogenic insert.  The lower end of the insert contains the 
shielded SQUID, a superconducting magnet, and associated hardware.  The cryostat is mounted on 
vibration isolation springs and magnetically shielded to confine magnetic fields greater than 5 
Gauss to the interior of the cabinet.  
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Figure 3-1. General system setup. 

The entire cabinet is mounted on casters to simplify relocation, and has leveling mounts in the front 
to stabilize the instrument in its final destination.  A number of cosmetic panels hide a large amount 
of the equipment, but may be removed to service the equipment or to fit the instrument through a 
standard 91 cm (35 in) doorway. 

3.2.1 System Power Distribution 
All system electronics are powered from a single power cord, and may be turned off with a single 
switch, except on EverCool-equipped instruments.  (In EverCool-equipped instruments, a helium 
compressor is required which is powered by a separate grounded 3-phase power cord.)  The 
MPMS3 requires single phase 200-230 VAC 50/60 Hz, and will draw 10A.  The power distribution 
unit on the cabinet has two grounded outlets for connecting auxiliary hardware (the computer 
monitor and the pump cabinet) and there are dedicated outlets inside the cabinet for distributing 
power to the equipment.  It is not recommended to use any of these outlets to power user 
equipment. The power distribution diagram can be found in Appendix C.3. 

 

 

W A R N I N G !  
CAUTION: The instrument must be plugged into a simple phase 
IEC 60309 outlet (16A/250V) fused at 16A. (See Appendix C.2.2 
for more details).  

Always power the system down before unplugging the power cord. 
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W A R N I N G !  
On the system side, the power cord is secured to the power 
distribution unit by a clamp. Do not tamper with this setup unless 
specifically instructed by qualified Quantum Design 
representatives. Risk for irreversible system damage and electrical 
shock hazard. 

 

 

The main power switch has a resettable breaker rated at 10A. 

 
Figure 3-2. Power distribution unit. 

In addition to the main MPMS 3 enclosure, a pump cabinet houses a vacuum pump required for 
instrument operation.  The power for this cabinet is provided by the main cabinet to prevent ground 
loops.  A metal hose and a USB cable also connect this cabinet to the cryogenic insert in the main 
cabinet. 

The instrument operation is most easily understood by recognizing several different subsystems that 
operate nearly autonomously to generate the desired instrument behavior.  Many of these 
subsystems have components housed in different locations, such as in the pump cabinet, in the 
modular electronics bays, and in the cryogenic insert.  All of the subsystems have hardware and 
software components, and their operation is coordinated by the MultiVu application software and 
low level application services on the computer.   

 

Ethernet 
Network 
(optional) 

Power Out To 
Pump Console 

Power Out 
To Monitor 

Main Power 
Switch 
(10A breaker) 

Main Power Entry 
Cable Connection 
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These subsystems are: 
• Temperature control system (section 3.3) 
• Magnetic field control system (section 3.4) 
• Motion control system (section 3.5) 
• SQUID detection system (section 3.6) 
• Chamber atmosphere control system (section 3.7) 
• Cryogen monitoring system (section 3.8) 

3.2.2 Modular Electronics 
The electronic components of the MPMS 3 are housed in modular enclosures that are easily added 
to the system or replaced in case of a system upgrade or repair.  (One exception is the gas handling 
controller that is tightly integrated on the top of the cryogenic insert.)  These modular electronics 
communicate with one another and with the system computer using a proprietary industrial-grade 
network based on the Controller Area Network (CAN) bus. 

 

The basic MPMS 3 electronics comprises: 
1. a gas handling controller (integrated on the cryogenic insert, model EM-QD) 
2. a magnet controller, model EM-QB (in the cabinet space above the computer) 
3. a SQUID control module, model CM-F 
4. a motor control module, model CM-A 
5. a temperature control module, model CM-G 

The SQUID control module, motor control module, and temperature control module are housed in 
module bays (Figure 3-3) that provide power and CAN bus interfaces in a standardized format.  
Additional controllers supplied with upgrade options may also be housed in these bays. 

 

 

W A R N I N G !  
Always power module bay tower down before 
installing/removing modules.  Failure to do so will damage the 
electronics. 

3.2.2.1 INSTALLING/REPLACING MODULES 

The module bays are divided into two categories based on the heat that each must 
dissipate.  The left-most bays are reserved for high-power modules, such as the motor 
control module and temperature control module.  These modules will not fit in the other 
bays—do not force them or equipment damage may result.  The center and right-most bays 
are for low-power modules, such as the SQUID control module.  Low power modules may 
be placed in any bay.  The excess cooling provided in high power bays will not harm them.  
You may distinguish low power modules from high power modules by the number of 
banana jacks on the rear panel (Figure 3-4):  low power modules have two jacks, high 
power modules have one jack. 
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  Figure 3-3. Module bay tower. 
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Figure 3-4. Module rear panels. 

The panel below the module bays provides access to the power supply tray (Model EM-QA).  In 
addition, this panel has a connector for communication with the computer, a breakout connector for 
the auxiliary magnet signals (allowing access to the magnet’s modulation coil by another device) 
and four connectors for connecting external CAN-based electronic controllers.  The latter 
connectors provide +/- 24VDC fused power to external modules.  The four unpaired fuses are 
behind the  panel of the power supply tray and should only be replaced with equivalent 5A, 20 mm, 
delay fuses under the direction of a qualified Quantum Design service representative (Figure 3-5).  
It is possible for the fuse on a +24V line to open without affecting the fuse on a –24V line.  In this 
case the electronics attached to these QD-CAN connectors may continue to operate with limited or 
unusual functionality.  However, both fuses should always be replaced at the same time. 

 
Figure 3-5. Location of the four unpaired fuses (5A, 20mm) for the CAN-based electronics 
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The model EM-QA module controller also utilizes two 6A, 20 
mm delay fuses at the power entry (Figure 3-6).  These should 
only be replaced with equivalent fuses on the direction of a 
Quantum Design service representative, and should always 
both be replaced at the same time. 

 
Figure 3-6. Location of the two, paired delay fuses (6A, 20mm) at the CAN tower power entry 

3.2.3 Cryogenic Equipment 
 

 

W A R N I N G !  
Cyrogens such as liquid helium and liquid nitrogen pose the 
following dangers: (1) They can cause serious burns due to 
extreme cold. (2) They may expand explosively in closed 
containers if warmed above their boiling point. (3) Their vapors 
may displace the breathable air in closed room. (4) Liquid or 
vapors may backstream out of fill ports when removing 
caps/plugs/transfer lines. 

 

 

W A R N I N G !  
To guard against these dangers, wear protective clothing such 
as gloves, goggles, and covered shoes when working with 
these cryogens. Also ensure that the room has good ventilation. 
Never disable relief valves, burst disks, or other safety devices 
on cryogen vessels and transfer equipment. 

Experienced personnel should perform or supervise 
cryogen transfers. 
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Liquid helium and liquid nitrogen are required to operate the MPMS 3.  Tanks, tubes, and hoses for 
these cryogens are often insulated with an evacuated space around them and fitted with pressure 
relief mechanisms (such as burst disks and re-sealing relief valves) to prevent the buildup of 
dangerous pressures.  For both performance and safety reasons, it is critical that no vacuum 
insulation nor pressure relief mechanism be tampered with, modified, or disabled.  All users should 
also be aware of the burn and asphyxiation hazards posed by liquid cryogens.  Please read section 
1.5 for an overview of these hazards. 

The purpose of the liquid helium is threefold.  Liquid helium cools the superconducting solenoid 
(magnet) that provides the magnetic field in the instrument, and associated components of the 
magnet system such as two superconducting electrical leads and the quick switch.  The use of a 
superconducting magnet system is the only practical way to generate magnetic field strengths found 
in the MPMS 3.  Liquid helium also cools the Superconducting Quantum Interference Device 
(SQUID) that is responsible for the instrument’s extreme sensitivity to magnetic moments, as well 
as the SQUID’s superconducting magnetic shield and the superconducting detection coils 
inductively coupled to the SQUID. By means of a vacuum pump, cold helium gas is drawn through 
the space surrounding the sample chamber to cool the sample down to 1.8K. 

The liquid nitrogen in the instrument serves to minimize helium boil-off in several ways.  (Liquid 
nitrogen is not used for MPMS 3 EverCool systems - refer to the EverCool option manual).  First, 
the outside of the liquid helium tank is shielded from radiated heat by the liquid nitrogen tank.  
Second, the upper section of the cryogenic insert, which hangs into the helium tank, is connected to 
the liquid nitrogen tank to intercept conducted heat. Third, this connection is linked to a radiation 
shield inside the cryogenic insert. The radiation shield intercepts heat from the sample chamber and 
heaters which would otherwise radiate to the liquid helium from within. 

 
Figure 3-7. MPMS 3 dewar.
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W A R N I N G !  
With the standard instrument cryostat, the hold time for the 
nitrogen tank when full, under typical operating conditions, is 
approximately 12 days.  The hold time for the helium tank, when 
full, is slightly longer if there is liquid nitrogen in the nitrogen 
tank.  When the liquid nitrogen tank is empty the instrument will 
no longer achieve the lowest base temperature specified.  In 
addition, the rate of helium consumption will increase.  When 
the liquid helium tank is empty, the SQUID detection system, 
magnet system, and temperature control system will all fail to 
work properly, and there is potential for damage to the 
hardware if operated with an empty helium tank.  It is 
recommended to fill both the nitrogen and helium tanks at least 
every 10-12 days, or once a week if convenient.  See chapter 
one for instructions to fill the nitrogen and helium tanks. 

 

Except in EverCool systems, the helium and nitrogen that escapes from the cryogen tanks through 
normal evaporation is routed to hose barbs on the back of the main cabinet through 0.2 psi (1.4 kPa) 
relief valves.  Rubber hoses route the exhausts to a visible location on the floor, to allow visual 
notification when the nitrogen tank is full during liquid nitrogen transfer. Liquid will be expelled 
from the hose when the nitrogen tank is full. The helium exhaust may be routed to a recovery 
system.  Make sure to terminate ground loops that may be caused when connecting a recovery 
system to the MPMS 3. 

The N2 exhaust rubber hose features an inline one-way valve at about 80 cm (30 in) from the 
exhaust hose barb. This valve ensures that no air gets cryopumped into the N2 tank. It is 
recommended to check regularly that the hose section between valve and system is not collapsing 
while performing a HELIUM transfer. If this is the case, please contact QUANTUM DESIGN. 
There might be risk for plugging the N2 exhaust with ice. 

3.3 Temperature Control System 
Temperature control for the MPMS 3 is achieved with several electronic and software components, 
allowing stable and continuous operation from 1.8 to 400 K with the standard system, including 
smooth temperature control through the 4.2 K liquid helium boiling point.  Temperature control is 
orchestrated by the Temperature Service on the computer.  The Temperature Service software 
receives the temperature set points and then sends commands to the temperature control electronics 
to achieve the desired result. 

 

Two electronic modules are involved in temperature control: 

• Temperature Control Module (model CM-G, located in the CAN module bay) 

• Gas Handling Controller (model EM-QD, integrated into the top of the probe). 

 

This section presents brief details of the components and operation of the temperature control 
system. 
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3.3.1 Temperature Control Electronics and Software 

3.3.1.1 TEMPERATURE CONTROL MODULE (TCM) 

The MPMS 3 sample chamber has a number of heaters and thermometers attached to the 
outside.  Three Negative Temperature Coefficient (NTC) thermometers are used for 
temperature sensing.  The primary sensor (sample thermometer) is located at the null point 
of the SQUID pickup coil.  Two other sensors, gas and neck thermometers, are located at 
the bottom of the sample tube and between the sample thermometer and the top of the 
sample tube.  Corresponding heaters are located near each thermometer.  Because of the 
importance of the sample temperature accuracy, the temperature of the sample 
thermometer is calibrated in-situ in the system.  Since strong magnetic fields can influence 
the accuracy of the thermometer at temperatures below 15 K, the sample thermometer is 
also calibrated under magnetic fields.  The temperatures of the gas and neck thermometers 
are pre-calibrated prior to installation on the sample tube.  The temperature control module 
reads out the gas thermometer, sample thermometer, and neck thermometer on the probe.  
The TCM also provides heater current to the gas heater, sample heater, and neck heater 
based on feedback temperature control using thermometer readings. 

 

Temperature is regulated by PID (Proportional-Integral-Differential) control.  The PID 
control is optimized depending on the temperature range of interest (Table 3-1).  Between 
320 K and 400 K, PIDs for the sample and gas thermometers are active.  Going down in 
temperature from 320 K to near 10 K, the PIDs for the sample and gas thermometers are 
active.  Going down from 10 K to 1.8 K and going up from 1.8 K to near 15 K, only the 
PIDs for the sample thermometer are active.  Going up from 15 K to near 320 K, the PIDs 
for the sample and gas thermometers are used, while the PIDs for the neck thermometer is 
active between 100 K and 320 K.   

 

Three thermometers are assigned to three of four bridges in the module, where the fourth 
one is a spare; SIMM interface 0: sample, SIMM interface 1: gas, SIMM interface 2: neck, 
and SIMM interface 3: spare (no simm card installed).  
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              Figure 3-8. MPMS 3 probe. 

The reported sample temperature comes from a thermometer reading that has been 
corrected for a number of factors, including magnetic field, thermometer location, thermal 
history, and thermal conduction from gas flow past the sensor.  These corrections can only 
provide an approximation of the exact sample temperature.  The most accurate sample 
temperature data is achieved at steady state.  Dynamic corrections, and the associated 
errors, are smallest when the rate of temperature change is small. 

3.3.1.2 GAS HANDLING CONTROLLER (GHM) 

Cooling is achieved by drawing helium from the liquid helium tank into the annular space 
around the sample chamber at a controlled rate with a vacuum pump.  The Gas Handling 
Controller (GHM) electronics control the mass flow controller for the main cooling flow 
and the impedance heater.  The GHM electronics also turn on and off the various solenoid 
valves as needed and – for systems equipped with the oven option – interfaces with the 
HiVac pump.  Additionally, it monitors the helium level within the cryostat and reads out 
the sample pressure from the pressure sensor located at the top of the probe.  The GHM  
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Utility (Figure 3-9) is the user interface for monitoring such things as CFE flow, heaters, 
and helium level, and executing chamber operations and valve states.  For illustrative 
purposes, heaters and thermometers have been drawn on the GHM Utility window to show 
their approximate locations.  The chamber heater and thermometer locations align with the 
position of a sample placed in the chamber, at 66±3mm. 

 

 
 Figure 3-9. Gas monitor interface. 

3.3.1.3 COOLING POWER 
Cooling power is provided by allowing a controlled amount of liquid helium from the 
dewar to enter the bottom of the cooling annulus.  The liquid helium enters through a 
variable impedance inlet (counterflow exchanger; CFE) and a fixed impedance 
(continuous low-temperature (CLT) inlet.  The liquid helium turns into a gas, which flows 
through the cooling annulus and is pumped from the top of the probe by the vacuum pump.  
The CFE is controlled by a mass flow controller.  During the cooling mode, the chamber 
heater is turned off.     
 
At or near the temperature set point, longitudinal copper wires along the length of the 
sample chamber maintain thermal uniformity and several torr pressure of helium gas in the 
sample chamber provides thermal contact with the sample.   
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3.3.1.4 HEATING POWER 

Temperature control within the sample space is achieved by heating and cooling the 
outside wall of the sample chamber.  Exchange gas in the sample space transfers the wall 
temperature to the sample.  The three heaters and temperature sensors (neck, sample, and 
gas) reduce temperature gradients within the sample space and allow for more accurate 
modeling of sample position versus temperature. 

3.3.1.5 GAS FLOW 

 
Cooling power is maintained by a continuous flow of helium from the bottom of the 
dewar, which is regulated by the external pump.  There are two impedance tubes which 
regulate cooling: the counterflow exchanger (CFE) and the continuous low-temperature 
(CLT) capillary.  The CFE flow operates in a range between 0.1 LPM and 5 LPM via a 
mass flow controller, enabling rapid cool-down to 10 K.  The maximum cooling rate is 30 
K/min, with typical cooldown from 300 K to 10 K (stable) in 15 minutes.  Below 10 K 
CFE is closed completely and the CLT flow controls the cooling rate.  The typical 
cooldown from 10 K to 1.8 K (stable) is within 5 minutes at cooling rate of 10 K/min.   
 
To hold temperatures below 10 K, a capillary tube with carefully tuned flow rate allows 
liquid helium into the annular cooling region from the helium tank.  The region is 
evacuated to low pressures while helium is continuously supplied.  The evacuation is 
performed by a rotary-vane pump (except in EverCool systems, where a scroll pump is 
used.) pumping through a solenoid valve that is used for isolating the region under special 
circumstances, such as power loss.   
 
Occasionally, the CLT impedance may become plugged with ice or other solid 
contaminants.  A plugged impedance will result in reduced helium flow through the probe 
insert and cause loss or degradation of temperature control below 10K. In this situation the 
flow reading of the ball gauges located on the side of the pump console, will generally be 
below 150 ccm. The only remedy is to warm the entire cryogenic insert to room 
temperature.  This may take over a week to do if no accelerated warming techniques are 
used.  It is recommended that only qualified Quantum Design representatives perform 
accelerated warming techniques on an instrument with this type of plug.  To help avoid 
this condition, follow the tips below to keep contaminants out of the liquid helium tank 
and cryogenic insert. 

• Use clean liquid helium, and do not pull liquid helium off of the very bottom of the 
storage dewar, where solid contaminants settle. 

• Replace the cap on the helium fill port right away whenever transferring liquid 
helium into the helium tank.  Never leave the tank open to atmosphere. 

• Check the O-ring inside the cap of the helium fill port for dirt and debris before 
replacing it.  Watch for poor sealing of the cap during normal operation and do not 
let a leaking condition persist. 

• Be mindful of changes in the rate of helium evaporation coming out of the helium 
exhaust port on the back of the cabinet, if connected to a meter or monitoring 
system.  An apparent reduction in helium evaporation rate might actually be caused 
by a leak between the tank and exhaust port which should be repaired. 

• Never stress, stretch, kink, disconnect, or loosen the hose between the main cabinet 
and the pump cabinet when the instrument is in operation. 
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3.3.1.6 TEMPERATURE CONTROL STATES 

 

In the MPMS3 Temperature Control System, the MultiVu display indicates whether the 
temperature is considered to be stable, near, or chasing (or tracking) to the set point.  Table 
3-1 shows how the temperature is controlled during the different modes of temperature 
state. 

 

Table 3-1. Temperature Control System States 

 

 Cooling Mode 

 
Thermometer PID 

 
Heater Used 

 
Helium Inlet 

 

Gas Flow 
(cc/min) 

 
Gas Sample Neck 

 
Gas  Sample Neck 

 
CFE CLT 

 
CFE CLT 

400 
to 
320 Active Active OFF 

 
Active Active OFF 

 
Open Open 

 

100 
to  
5,000 250 

320 
to 
10 Active Active Active 

 
Active Active Active 

 
Open Open 

 

100 
to  
5,000 250 

10 
to 
1.8 OFF Active OFF 

 
OFF Active OFF 

 
Close Open 

 
0 250 

 

 

 Heating Mode 

 
Thermometer PID 

 
Heater Used 

 
Helium Inlet 

 

Gas Flow 
(cc/min) 

 
Gas Sample Neck 

 
Gas  Sample Neck 

 
CFE CLT 

 
CFE CLT 

1.8 
to 
15 OFF Active OFF 

 
OFF Active OFF 

 
Close Open 

 
0 250 

15 
to 
320 Active Active Active 

 
Active Active Active 

 
Open Open 
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If the temperature control system appears to be malfunctioning, and fails to reach or maintain the 
requested temperatures, it is useful to monitor various parameters.  The software has capabilities to 
log diagnostic data to help identifying the cause of faults.  If problems with the system recur 
frequently, you are encouraged to contact your Quantum Design service representative for 
assistance. 

Note: When contacting your Quantum Design service representative for assistance, it is vital that 
you be as detailed as possible.  Most problems cannot be solved without specific information.  
Please be prepared to provide as much of the following information as possible:                          

• Description of failure, temperature and frequency of occurrence 

• Recent changes to the system, including helium fills, addition of new equipment such as 
helium recovery system, etc. 

• Provide relevant information such as a sequence, data file, diagnostic log file, and Event 
log file, etc. 

3.4 Magnetic Field Control System 
The magnetic field in the MPMS 3 is generated by a superconducting Niobium-Titanium (NbTi) 
solenoid mounted on the outside of the cryogenic insert.  The solenoid generates a vertical magnetic 
field.  Current is supplied by the magnet controller via a set of permanent current leads.  The leads 
are composed of different materials depending on what part of the system they are located in.  In 
the cabinet, the magnet leads are large gage copper cable.  In the very top section of the helium tank 
they are brass, to reduce the amount of heat that is conducted through them into the liquid nitrogen 
and helium.  Below the brass section, where the temperature is low enough, the leads are composed 
of high-temperature superconductor (HTS) tape, to eliminate Joule heating.  Below the HTS tape 
the leads are NbTi (type II superconductor) where they attach to the solenoid. 

In parallel with the magnet solenoid is a superconducting element called the QuickSwitch.  The 
QuickSwitch is immersed in liquid helium.  It is driven above its critical temperature with a heater.  
In this normal state the magnet controller may generate a voltage across the superconducting 
solenoid.  The solenoid current—and the magnetic field at its center—changes at a rate determined 
by the applied voltage and the solenoid inductance.  The QuickSwitch cools very rapidly and 
becomes superconducting when the heater is turned off.  In this state there is a short across the 
solenoid and no voltage may be developed.  Therefore, the magnetic field is extremely stable.  In 
addition, the QuickSwitch acts as a filter of external fluctuations from the power supply. 

The magnetic field reported by the instrument is computed from the current that is being driven 
through the magnet solenoid, multiplied by a geometric calibration factor.  It is possible for the 
magnetic field lines within the instrument to move—a condition called “field relaxation.”  It is also 
possible for a magnetic field to become trapped within the magnet even with no net current through 
the magnet solenoid.  This condition, commonly called “trapped flux,” depends greatly on the 
magnet charging history.  (See chapter 4 for more details.)  A heater integrated into the magnet 
solenoid may be used to drive the wire above its critical temperature and eliminate most trapped 
magnetic flux.  This procedure is called a magnet reset. 
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               Figure 3-10. Magnet control diagram. 

The magnet solenoid also contains a second, much smaller modulation solenoid for supplying small 
magnetic field offsets (to trim the magnetic field to true zero, low field option) and for generating 
AC magnetic fields (for AC magnetic susceptibility measurements, AC option).  

The Magnet Controller, model EM-QB, coordinates operation of the Quick Switch and the current 
in the magnet solenoid.  The novel design of this digital magnet controller utilizes analog feedback 
to achieve very smooth current ramps.  Except at zero magnetic field, this controller always 
supplies current to the magnet solenoid and must not be disconnected from the magnet.  Doing so 
could damage the magnet.  This is different than the operation of many other superconducting 
magnet systems, which often have detachable or retractable leads. 

 

 

The model EM-QB magnet controller utilizes two 8A, 20 mm 
delay fuses at the power entry.  These should only be replaced 
with equivalent fuses on the direction of a Quantum Design 
service representative, and should always both be replaced at 
the same time. Spare fuses can be found in the system’s utility 
kit. 

3.4.1 Magnet Safety  
No cables should ever be disconnected without first driving the magnet to zero field.  The 
MPMS 3 superconducting magnet can trap magnetic flux and therefore can lead to a hazardous 
situation if a charged magnet is left completely unconnected to the system, as doing so leaves 
no way to discharge the magnet directly.  Several different cables contain connections for 
magnet control.  Be sure to drive the magnet to zero field before disconnecting any cables if the 
probe ever needs to be disconnected from the controllers.
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W A R N I N G !  
Never disconnect a charged magnet from the controllers.   If the 
probe must be disconnected from the controllers, be sure to 
drive the magnet to zero field before disconnecting the 
controllers from the probe head. 

 

High magnetic fields can be dangerous.  Fields above 5 Gauss are potentially harmful to 
persons with medical implants (e.g. pacemakers, neurostimulators, etc.).  The MPMS 3 is 
configured with an integrated Environmental Magnetic Shield, and the 5 Gauss line of the 
longitudinal magnet is fully contained within the system’s enclosure.  Therefore, with the 
MPMS 3 system, there are no safety concerns regarding stray fields. 

3.5 Motion Control System 
The motion control system moves the sample within the detection coils.  The sample transport, or 
motor, is a long-throw linear motor mounted on springs within its casing for vibration isolation 
(Figure 3-9).  The sample transport receives current from the motor control module, model CM-A.  
A DC signal controls the sample position.  A precision optical encoder in the sample transport reads 
the position of the motor armature to within 0.01 mm.  This position is fed to the motor control 
module and used in a feedback loop to obtain precise sample positioning.  The armature position 
may be seen through a window on the front of the sample transport. 

   
Figure 3-11. Sample transport with and without end caps.
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In DC measurement mode, the sample is scanned up and down at constant speed, according to the 
measurement parameters set by the user.  Refer to Table 1-1 for a summary of the DC measurement 
parameters  
 

• The linear motor in the sample transport uses permanent magnets.  These magnets subject 
samples to approximately 200 Oe stray magnetic fields as they are inserted into the 
instrument.  Please contact Quantum Design if this is unacceptable for your samples. 

• For samples that cannot be exposed to the stray magnetic field of the sample transport a 
sample shield is available. 

3.6 SQUID Detection System 
 

 

W A R N I N G !  
CAUTION: SQUID detection is extremely sensitive to the 
magnetic signal generated by a user sample, but also to 
external electromagnetic disturbances, such as cell-phones, 
RF-furnaces or stray-fields of equipment in close proximity. 
Environmental noise could affect the performances of your 
system. We advise to isolate your instrument from any known 
electromagnetic noise sources. 

  

The SQUID detection system is composed of: 
1. A set of superconducting detection coils inductively coupled to a magnetically-shielded, DC 

SQUID. 
2. A SQUID head that biases the SQUID, provides feedback control and signal amplification. 
3. A CAN-based SQUID control module with a digital signal processor (DSP) which performs 

synchronous AC detection.    
 

 
Figure 3-12. SQUID detection diagram. 



Chapter 3 Section 3.7 
Hardware Chamber Atmosphere Control System 

Quantum Design MPMS 3 User’s Manual, 1500-100, Rev. F1 3-19 
June 2016 

Figure 3-12 illustrates the detection system in simplified fashion.  The detection coils are 
configured as a second order gradiometer to minimize signals from external disturbances.  Both the 
detection coil circuit and the SQUID input circuit have heaters that allow the elimination of 
standing currents in the superconducting loops by raising them above their critical temperature, and 
which are operated automatically by the SQUID control module. 

In the standard measurement, the instrument moves the sample through the detection coil set (over 
the specified scan length), and locates where the SQUID signal peaks.  (See Chapter 4 for more 
details on measurement theory). 

• With this type of measurement it is extremely important that the sample offset be properly 
determined. 

The SQUID ranges are labeled 1, 10, 100, and 1000.  This corresponds roughly to the multiplier 
required to convert the output voltage from the SQUID electronics to the number of flux quanta 
(Φo) measured by the SQUID. Range 1 corresponds to the highest gain setting and is the most 
sensitive range.  Range 1000 has the lowest gain and is the least sensitive range.   When the sample 
produces a signal that is too large, the SQUID must be reset many times during the course of a 
single measurement due to repeated over-ranging.  Little or no useful data is generated, or it takes 
much longer than the designated averaging time to generate a single data record.  Using the 
autoranging function (default) minimizes the occurrence of such over-ranging. 

• To decrease the sample signal with auto-ranging turned off and prevent such over-ranging, 
increase the SQUID range if it is not already set to 1000. 

Over-ranging is generally not encountered during DC scans, with the exception of high moment 
samples.  The DC scan is capable of measuring samples with moments as large as 5 emu.  
However, if the SQUID signal (in any range) exceeds 5 V, modifications to the measurement 
parameters or the sample itself may be necessary to mitigate over-ranging of the SQUID.  The 
following will help to overcome the dynamic range limitations: 

• Enable auto-ranging (if disabled) 
• Measure at smaller field (if the signal is field dependent) 
• Use a longer measurement time 
• Measure a smaller amount of the sample, if possible 

More detailed information regarding this issue can be found on the Quantum Design website, in 
Service Note 1500-229: DC Scan and High Moment Samples. 

3.7 Chamber Atmosphere Control System 
During measurements, the sample chamber and sample transport are normally held in a medium 
vacuum—approximately 10 Torr at room temperature.  (The pressure may drop to 1 Torr at the 
instrument’s base temperature.)   Retaining a low pressure of gas in the chamber allows the sample 
and sample chamber walls to reach a uniform temperature.  However, it is important that helium is 
the only gas in the chamber when cooling below room temperature.  Water vapor, nitrogen, oxygen, 
and most other contaminants will condense and then freeze as the temperature is lowered, creating 
additional friction when the sample is moving, or even blocking sample motion altogether in 
extreme circumstances.  Additionally, contaminants may impact some sensitive magnetic 
measurements, and may impact the instrument’s temperature control capabilities. 
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The standard procedure for inserting samples into the instrument involves purging the sample 
chamber and sample transport to ensure the clean environment described above.  This procedure 
should be performed with the sample chamber at room temperature.  The cap must be on the sample 
transport or the procedure will fail.  The chamber is first evacuated by the system vacuum pump to 
a few Torr, then it is filled with about one atmosphere of helium gas.  (The helium vapor in the 
liquid helium tank is used, except in EverCool systems.)  The chamber is evacuated and filled with 
clean helium gas in this manner twice more to flush out all contaminants, and then the chamber is 
evacuated to achieve the final pressure.  Finally, the chamber is sealed. 

When the sample transport is open for removing or inserting samples, clean helium gas is allowed 
to flow through the sample transport to prevent other contaminants from entering the head and 
chamber.  This is called the “flooding” state. 

• Avoid leaving the sample chamber open to atmosphere.  Even though the chamber is 
automatically vented as a precaution to minimize sample chamber contamination, it is best 
practice to keep the cap on the Sample transport whenever possible. 

Besides the continuous venting state and the purging then sealing operation, the sample chamber 
may also be immediately sealed, or pumped continuously.  All of these operations are performed 
with a series of solenoid valves on a manifold integrated onto the top of the cryogenic insert.  The 
valves are operated by the CAN-based gas handling controller (Model EM-QD), also integrated 
onto the top of the insert. 
 

 
Figure 3-13. Gas handling diagram. 



Chapter 3 Section 3.8 
Hardware Cryogen Monitoring System 

Quantum Design MPMS 3 User’s Manual, 1500-100, Rev. F1 3-21 
June 2016 

3.8 Cryogen Monitoring System 
The liquid helium level is monitored with a superconducting wire with sufficient electrical current 
flowing so that only the portion of wire submerged in liquid helium is superconducting.  The 
measured wire resistance is then proportional to the length of wire not immersed. 

The helium level meter positioning and approximate calibration are shown below.  The top of the 
meter is near the top of the magnet solenoid, and the bottom of the meter is near the SQUID and the 
inlet for the tube that draws helium into the cryogenic insert for sample cooling.   

• It is not necessary to submerge the magnet solenoid in liquid helium.  The magnet is 
cooled by helium vapor and by conduction through copper elements.  In fact, the presence 
of bubbles in the liquid helium around the detection coils may increase noise in some 
sensitive measurements.  Therefore, it is recommended to fill the tank to the bottom of the 
magnet solenoid, where the helium level reading is full (approximately 70 liters.)  This 
much liquid helium may last 12-14 days under normal operating conditions, and if the 
liquid nitrogen tank is not allowed to run dry. Dewar volumes and times are given for a 
standard MPMS 3, not an EverCool MPMS 3.  In case of an EverCool system, refer to the 
EverCool option Manual. 

• The magnet being vapor-cooled, it is required to ramp the magnetic field to zero before 
starting a helium transfer. Otherwise, the warm gas introduced into the dewar might cause 
the magnet to quench. 

• In case you wish to add additional liquid helium reserve, the software reports the 
approximate volume of liquid helium in the tank up to about 110 liters. 

There is currently no meter in the MPMS 3 for monitoring the liquid nitrogen level.  The rate of 
nitrogen evaporation will be fairly constant.  The liquid nitrogen tank should be filled every 10-12 
days.  It is recommended to fill the nitrogen and helium tanks at the same time. 

 

 
Figure 3-14. Helium level inside dewar. 

 

W A R N I N G !  
CAUTION: Carefully read Chapter 1, Section 1.5 for detailed 
instructions on filling nitrogen and helium. 
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3.9 Standby Mode 

The standby function in the MPMS3 is designed to put the machine in a safe state between 
measurements.  It has lower helium consumption than normal output, but still tries to ensure that 
there is adequate circulation to prevent the system from plugging.  The standby mode can be 
accessed through both a menu command and sequence command as shown in the figures.  Issuing 
the menu command will cause the system to immediately begin the process to enter standby.  Using 
the sequence command will cause the system to go into standby at that point in the sequence. The 
procedure to put the system into standby mode in both instances is the same. 

 The operations performed when a system is going into standby mode are the following: 

• Current measurements are stopped and the motor is returned to the bottom position 
• Magnetic fields (greater than 100 Oe) are ramped down by the power supply 
• If the AC or ULF options are present, fields in the modulation and trim coils in the magnet are 

turned off 
• Maintains the current temperature if the temperature is between 100K and 315K. 

o If the temperature is below 100K, set 180K 
o If the temperature is above 315K, set 305K 

• Reduce the flow through the primary impedance from 100ccm to 50ccm 

Setting a new temperature will cause the system to come out of standby mode and be ready for the 
next measurement.  

 

 

Figure 3-15. Initiating Standby Mode via the "Instrument" menu and by issuing a sequence command.
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3.10 Additional Hardware 

3.10.1 Sample Rods 
The sample rods to which the sample holders attach are composed of tapered carbon fiber tubes, 
with adapters on either end.  They are light, strong, and rigid—all important features for application 
in the MPMS 3.  A flexible plastic coupling at the top end helps accommodate slight misalignments 
between the magnetic latch mechanism and sample tube.  The magnetic latch mechanism at the top 
secures the rod to the armature of the Sample transport.  A bearing at the bottom end of the sample 
rod provides a smooth surface to minimize friction against the walls of the sample chamber.  The 
bearing also contains internal threads where sample holders attach. 

 
• Store the sample rods in the storage space provided on either 

side of the lower half of the instrument cabinet to keep them 
clean and prevent damage.  You must remove any attached 
sample holder first. 

• Be aware of the strong magnets in the top of the sample rod 
as you move the sample rod around your laboratory.  They 
may be attracted to other equipment or debris. 

• Inspect the magnets at the top of the sample rod from time to 
time and make sure they are clean.  Dirty magnets may 
prevent proper latching of the rod to the motor armature.  The 
magnets may be cleaned with a cotton swab and mild 
detergent (no acetone).  Magnetized debris may be removed 
with lint-free tissue paper or adhesive-backed tape.  If 
damaged, the magnetic latch may be replaced without 
replacing the entire sample rod.  (See appendix F for ordering 
replacement parts.) 

• Inspect the flexible coupling (flexture) which is just beneath 
the magnetic latch.  If damaged this will cause rattling and 
will produce noise in sample measurements.  A more detailed 
view can be found in Figure 1-2. 

• Inspect the bearing at the bottom of the sample rod 
periodically, to be sure it is clean and not noticeably 
scratched, abraded, or worn.  A dirty bearing should only be 
cleaned with a cloth and a small amount of isopropyl alcohol.  
Solvents such as acetone will damage this bearing. 

• Leave the blue bearing on the rod. Verify periodically that the 
bearing is screwed all the way against the sample rod. 

• When screwing the sample holder onto the sample rod, hold 
the blue bearing instead of the fragile carbon fiber rod to 
avoid damage. (see section 1.3.2) 

Figure 3-16. Sample rod. 
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3.10.2 User Kit 
a. The user kit supplied with the instrument contains several items: rigid brass and quartz sample 

holders for mounting samples onto. 

b. A sample mounting station to aid proper sample mounting as described in section 1.3.1. 

c. A palladium sample reference sample, mounted to a sample holder, which may be used to 
check the instrument’s magnetic moment calibrations with the formula below for the 
susceptibility of palladium at room temperature: 

µ=χmHm, 

where µ is the magnetic moment of the sample, χm is the mass susceptibility of palladium at 
298 K (5.25x10-6 emu/Oe-g), H is the magnetic field applied by the instrument, and m is the 
mass of the palladium sample (supplied with the sample.) 

d. A mounted Indium sample, which may be used to check the temperature accuracy of the 
system. The superconducting transition at zero field should be between 3.37K and 3.43K. 
Ensure that you have quenched all residual field out of the magnet when performing the M(T) 
measurement. 

e. A set of quartz sample braces.  A pair of the quartz braces can be used to help secure samples 
inside the brass sample holder.  These braces are intended to mount thin samples perpendicular 
to the magnetic field. 

f. A set of powder sample holders.   Two powder sample holders are used to safely encapsulate 
powder samples and snap them into brass holders.  Application note 1096-306 discusses use of 
the powder sample holders. 

g. Spare parts for the sample rods: one flexure which mounts to the top of the sample rod and one 
blue bearing, which mounts to the bottom of the rod. 
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C H A P T E R  4    

Measurement Theory and Applications 

4.1 Overview 
In this chapter we give detailed insight into the measurement theory and the most common applications. 

The MPMS 3 is a versatile and complex instrument which uses independent measurement techniques based 
on different data analysis methods to be seamlessly performed on a sample in the same environmental 
conditions with the same instrument. Optimizing the use of the instrument and obtaining the highest quality 
of data sometimes requires deeper knowledge that goes beyond the fundamentals of sample insertion and 
simple software operation. The sections below cover the theory of DC scan measurements (4.2) & squid 
drifts from various sources (section 4.3).  In order to have the system perform at its highest performance, 
section 4.4-4.7 will cover the importance of sample geometry, sample holder effects, sample insertion & 
sample location effects. Section 4.8 will explain how to write an effective sequence using M(H), M(T), 
M(t). Most common sources of errors will be found in section 4.9 and followed by further readings on 
Squid references in section 4.10 

4.2 Measurement Techniques 
The MPMS 3 uses a DC scan method to measure magnetic flux in a superconducting loop as a function of 
sample position and fit using an analytic function. In addition to the DC scan, the optional MPMS 3-VSM 
option vibrates the sample sinusoidally and utilizes a lock-in amplifier to measure the magnetic response. 
The combination of these optional techniques allows for the optimization of the measurement method most 
appropriate for the experiment. The sample is ideally located in the center of the pickup coils, inductively 
coupling to the magnetic field and generating a current as it moves through the coil. The coil geometry is 
chosen to maximize the response of a sample oscillating inside the coil set Figure 4-1 shows a schematic of 
the cryogenic insert and the relevant position of the detection circuit. 
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Figure 4-1. Cryogenic insert model. 

The superconducting pickup coils are inductively coupled through an input transformer to a Direct Current 
(DC) Superconducting Quantum Interference Device (SQUID). The SQUID is located in a complete 
superconducting shield to prevent magnetic flux from the magnet or environment from creating noise. The 
advantage of the DC SQUID over a radiofrequency (RF) SQUID is that it enables much greater dynamic 
range from the detection circuit and negates the need for RF signals. Changing magnetic fields induce 
trapped flux inside the pickup loop that can lead to increased noise in the SQUID. Heaters are installed on 
the SQUID and the input transformer to remove trapped flux that can distort the measurement. In practice, 
this can be achieved by just quenching the input transformer rather than the entire SQUID chip.  The input 
transformer, due to its construction, can be heated past its critical temperature in approximately 10ms and 
return to the superconducting state in a similar time frame.  This feature enables very sensitive SQUID data 
collection within milliseconds of stabilizing at a magnetic field, producing fast and accurate magnetic field 
loop measurements. The applied field produced by the superconducting magnet is controlled by a hybrid 
power supply, which combines both analog and digital feedback to achieve field changes of 0.3Oe over the 
full field range.  The accuracy of the applied field is limited by the trapped flux in the magnet and can be 
well characterized for each setup. 

Figure 4.2 is a simplified schematic of the MPMS 3 detection hardware.  The superconducting detection 
coils are configured as a second-order gradiometer, with counter-wound outer loops which make to first 
order the set of coils non-responsive to uniform magnetic fields and linear magnetic field gradients.  
Therefor a current is induced in the detection coils only in response to magnetic field disturbances. 
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 Figure 4-2. SQUID detection schematic. 

Assuming the sample dimensions are much smaller than the dimensions of the detection coils, the current 
induced in the detection coils is a function of the sample position.  The approximate shape of this function 
is shown above.  In practice, exact shape varies slightly with the size and shape of the sample.  The current 
in the detection coils is inductively coupled to the instrument’s SQUID, which serves as an extremely 
sensitive current-to-voltage converter.  Many details of the SQUID circuit are omitted for simplicity here, 
but it is relevant to note that SQUID feedback nulls the current in the detection coils so no current actually 
flows in them, and the feedback current yields the actual SQUID voltage for analysis.  See the “Further 
Reading” section at the end of the chapter for references that explain the details of SQUID operation. 
During a measurement the SQUID voltage is amplified and digitized by the instrument electronics.

4.2.1. DC Scan Measurement Theory 

The DC scan fits the measured SQUID response as function of position to an expected response 
function. The top of Figure 4-3 shows a typical DC response function for standard sample 
geometry like the supplied palladium reference sample.  For the DC scan, we collect two scans per 
waveform, both in the up and down motion. The motion path that we have chosen for the DC scan 
mode is based on a triangle wave.  In contrast to sinusoidal motion that has a maximum velocity 
around the center of the coils where most of the information is gathered about the sample, the 
triangle wave gives an even distribution of points in position about the center of the response 
function. To minimize accelerations felt by the sample, the peaks of the triangle have quadratic 
accelerations and decelerations and are usually outside of the region of data collection. As a result 
of the architecture of instrument, the data gathered by the motor and SQUID control electronics 
are independent and are synchronized with a sync signal. The data is independently transmitted to 
the control software running on a computer and is combined as a function of time. The software 
then fits the voltage as a function of position to the response function for a point source moving 
through a second order gradiometer (Figure 4-4).  The up and down scans are subtracted in 
position space, giving an approximation of the system drift over the time of the measurement.  
Linear drift is then subtracted from the SQUID signal as a function of time, and the raw data is 
fitted to the dipole response function in position space.  The fitting algorithm assumes that the 
sample magnetic moment approximates a dipole magnetic moment, with sign and value remaining 
constant during measurement.  Two fit calculations are made for each processed signal, one with 
the center position fixed and another with the center position as a free parameter.  Both are shown 
in the lower panel of Figure 4-4. 
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Figure 4-3. DC Scan response function. 

 

 

 

Figure 4-4.  Voltage versus position curves, before and after fitting to the dipole response function. 
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4.3 SQUID Drifts 
Since there will be intrinsic DC drifts in the SQUID signal that result from various sources like magnet 
drift, sample position movement, etc. we need to ensure that our analysis of the signal is unaffected.  
During the DC scan, the measured SQUID response as function of position is fitted to an expected response 
function. By carefully selecting the starting point of each scan and executing both up and down scans using 
a linear motion with constant speed to collect the SQUID voltage as a function of position and time, we can 
subtract these two scans from each other in position space.  The result will remove the sample signal from 
the scan and the remainder is the SQUID drift as a function of time and is equivalent to the intrinsic drift in 
the system. The drift is approximated as a linear function in time and removed from the data.  Returning to 
position space, the raw data is fitted to a response function without having to worry about a linear 
contribution to the signal. This method is superior to earlier techniques, which add a linear term to the 
response function and fit that to the raw data.  Unlike the older techniques that result in erroneous data fits 
if the data gathered for the response function is not perfectly centered or end effects introduce an 
asymmetric signal since a line and the response function are not orthogonal. 

4.4 Sample Geometry Effects 

4.4.1. Scanning for Sample Offset 

The MPMS3 allows for centering the sample using a DC scan along the entire length of 
the sample chamber smoothly. It fits the data to an expected waveform and calculates the 
center position. If the scan data shows clear deviations from the fit function, this may 
demonstrate the sample’s deviation from point-like dipole behavior due to its size, shape, 
or magnetic characteristics.  Alternatively, it may be an effect of a non-uniform magnetic 
field.  For example, a non-uniform residual magnetic field after the magnet is set to zero 
field is common.  In either case, the user should carefully consider whether the calculated 
sample offset is accurate or not. 

4.4.2. Detection Coil Geometry 

For reference, the dimensions of the MPMS 3 detection coils are 17 mm (diameter) and 8 
mm (height, center to either outer coil). Refer to Figure 4-2. The instrument is calibrated 
with a right circular cylinder of palladium that is supplied with the instrument, with 
diameter 2.8 millimeters and height 3.8 millimeters.  To the extent that your sample 
varies from this geometry, the instrument readings will be impacted in the following 
ways: 

4.4.2.1 LENGTH EFFECTS (LONG/SHORT SAMPLES) 

For samples significantly longer than the palladium reference, the material at either end 
of the sample generates more magnetic flux for the outer, counterwound detection coils to 
pick up.  This has the effect of flattening the spatial response curve of the detection 
coils—reducing the magnitude.  The result is that the reported magnetic moment appears 
smaller than the actual magnetic moment.  A very long, uniform sample would not 



Section 4.5 Chapter 4 
Sample Holder Considerations  Measurement Theory and Applications 

4-6 MPMS 3 User’s Manual, 1500-100, Rev. F1 Quantum Design 
June 2016 

register any signal at all as long as both ends are far away.  For most measurements 
therefore, the recommended sample length is < 5 mm.  This factor can be determined 
empirically with a reference sample, one may counter this effect by carefully measuring a 
reference of known magnetic moment and with geometry similar to that of the unknown 
sample, and then normalizing all magnetic moment measurements for the unknown 
sample to this well-known measurement. 

4.4.2.2 FILLING FACTOR AND RADIUS EFFECTS (NARROW SAMPLES) 

To a very good approximation, the lines of magnetic flux due to a sample will look like 
those from a magnetic dipole.  That is, they emanate from the sample and return to the 
sample.  Because the sample cannot completely fill the detection coils, some of these 
magnetic flux lines return inside the detection coils and are therefore not detected.  This 
is true for all samples and the magnitude of this effect depends on the radius of the 
sample relative to its length and relative to the radius of the detection coils. 

Samples narrower than the calibration reference will usually generate smaller signals than 
expected and samples wider than the calibration reference will usually generate larger 
signals than expected.  In other words, if you reduce the radius of a palladium reference 
sample by a factor of 2, its volume decreases by a factor of 4:  the instrument will report a 
reading more than a factor of 4 smaller even though the material has the exact same 
volume magnetization.  The magnitude of this error is described by the term filling factor. 

A common technique to determine the filling factor of a sample with a non-standard 
geometry is carefully measuring a reference sample of known magnetic moment and with 
geometry similar to that of the unknown sample, and then normalizing all magnetic 
moment measurements for the unknown sample to this well-known measurement. 

4.4.2.3 DEMAGNETIZATION FACTOR 

Samples with a large magnetic susceptibility and certain geometry effectively alter their 
own internal magnetic field.  Accounting for this magnetic field correction can be an 
important consideration for many magnetic measurements.  The demagnetization factor is 
a geometry-based value between zero and one that describes the extent of this field 
alteration.  This effect is due only to the sample geometry and susceptibility.  It is not an 
instrumental artifact.  The effect is especially relevant for wide, thin samples oriented 
perpendicular to the magnetic field—thin films in the extreme case—but should be 
considered for most samples.  For example, the demagnetization factor of  a spherical 
sample is 1/3, which can be significant if the sample has a large susceptibility.  It is 
beyond the scope of this manual to derive or tabulate demagnetization factors for 
different sample geometries, but can be located in the references at the end of the chapter. 

4.5 Sample Holder Considerations 
4.5.1 Characterizing Sample Holder Contributions 

Measure the magnetic signal from your sample holder without a sample mounted to it in order to 
characterize its contribution to your measurements. 
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4.5.2 Supplied Sample Holders 

The sample holders supplied with the instrument are approximately 130 mm long, allowing the 
sample to be mounted 66±3mm from the lower end. The sample transport will operate in the 
center of its position range.  The quartz sample holders are the best to obtain the highest 
instrument sensitivity and accuracy.  The quartz holders are brittle and fragile.  For applications 
where the highest sensitivity and accuracy are not required, the brass sample holders are more 
robust and easier to handle.  

4.5.3 Magnetic Impurities in the Sample Holder 

Impurities in a sample holder may generate signals in the instrument.  If a sample holder is not 
uniform in composition, but contains localized impurities, each point of impurity generates a local 
disturbance in the magnetic field which the detection coils will detect.  The background of each 
sample holder should be measured prior to mounting samples. 

 

4.5.4 Sample Mounting 

The sample must be mounted securely to the sample holder.  The sample holder must be 
connected securely to the sample rod.  If the sample does not move synchronously with the sample 
transport encoder array, then the reported moment by the instrument will be incorrect. Quantum 
Design does not supply material for securing the sample to the holder.  There are many glues and 
tapes available, depending on the specific application.  Most have some magnetic contamination, 
especially at very low temperatures, so be sure to measure the glue or tape you use to determine 
the extent of signal it produces. 

4.5.5 End Effects 

In an idealized measurement, the sample holder is made of a long, uniform material.  Where this is 
the case, the sample holder produces no net signal when it is inside the detection coils, because 
any magnetic field disturbance it produces is produced in the same magnitude at the two 
counterwound outer detection coils and the central coil.  If a sample holder does not pass 
completely through the detection coil set, then it creates more local magnetic field disturbance at 
the top coil than at the bottom coil, and there is a net signal due to the sample holder.  This is 
commonly referred to as a sample holder end effect.  To prevent this “end effect” from impacting 
measurements, the sample should be mounted at least 50 mm from both ends of the sample holder, 
and should be the same distance from both ends.  Also, any non-uniformities in the sample 
holder—such as bearings, fittings, and adapters—should be duplicated symmetrically about the 
center of the sample holder. 

4.6 Sample Insertion Considerations 

4.6.1 Inspection 

Each time you insert a sample into the instrument, inspect the following items to ensure optimal 
performance: 



Section 4.7 Chapter 4 
Sample Location Considerations  Measurement Theory and Applications 

4-8 MPMS 3 User’s Manual, 1500-100, Rev. F1 Quantum Design 
June 2016 

• The magnetic lock should be clean. 
• The flex joint just below the magnetic lock must not be cracked or damaged. 
• The coupling of the flex joint to the magnetic lock must be secure. 
• The coupling of the sample holder to the sample rod must be secure. 
• The sample holder must be mated straight for proper radial centering within the detection 

coils. 
• The sample holder and your sample should be clean and have no damage, like scratches , 

dents, etc. 

4.6.2 Sample Exposure to Magnet Fields 

As you insert the sample into the instrument, the sample is exposed to a magnetic field of 
approximately 200 Oe inside the sample transport.  A small remnant field is also normal inside the 
sample chamber.  Oscillate mode will yield the lowest remnant magnetic field. 

4.7 Sample Location Considerations 

4.7.1 Angular Dependence 

It is also important to mount the sample so that it moves smoothly on the axis of the 
sample rod.  If the sample moves off-axis, the user may find that the magnetic moment 
readings depend on the angular orientation of the sample holder and sample rod when 
inserted, to a degree that is extremely difficult to quantify.  This is because the 
instrument’s geometry diverges slightly from the ideal geometry:  detection coils have 
lead-in wires and bend with non-zero radius, the sample chamber may not be perfectly 
co-axial with the detection coils, etc.  Rotate the sample rod to find the minimum moment 
being reported. 

4.7.2 Magnetic Impurities 

Magnetic impurities in the sample holder, glue, or securing agent can generate erroneous 
signals and errors in sample offset scans.  Measure the empty sample holder to verify that 
it is free of magnetic impurities.  Routinely measure your glue or securing agent to verify 
that it is effectively free of magnetic contamination. 

4.8 Sequence Considerations 

4.8.1 Moment Versus Field (M(H)) 

The MPMS 3 is designed to perform efficient M(H) loops.  The most accurate data is measured 
when the instrument stabilizes the field for each measurement, which happens very quickly.  It is 
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also possible to collect data continuously while changing the magnetic field.  The instrument noise 
floor will increase to over 10-6 emu if you measure while ramping.  In addition, since the magnetic 
field and measured moment actually change over the course of such a measurement, the reported 
values will be averages, which tend to result in scatter or imprecise data. Moreover, due to 
coupling of the magnet to the gradiometer, the SQUID will super-impose a linearly changing 
signal to the sample signal. This linear signal might be several orders of magnitude larger than the 
signal from the sample and can cause artifacts which vary with ramping speed and direction. This 
large linear signal will also cause the SQUID to reset often which limits the maximum ramping 
rate that can be used while measuring. Due to these issues, it is generally more advantageous to 
measure at stable fields rather than while sweeping in the MPMS 3. 

Another consideration for some M(H) measurements is magnetic field error due to remnant 
magnetic field.  The remnant field depends on the recent history of the magnet and is neither 
known nor reported.  For more about remnant magnetic field, see the section below called 
“Common Sources of Error:  Magnetic Field Error.” 

4.8.2 Moment Versus Temperature (M(T)) 

The MPMS 3 is designed to perform large temperature changes quickly and to quickly stabilize 
the temperature.  It is also designed to maintain user-defined temperature sweep rates and to 
perform efficient M(T) measurements.  A high data density may be achieved by measuring while 
changing the temperature.  It may prove more efficient to sweep the temperature at a moderate or 
slow rate and collect data continuously, rather than stabilize the temperature for many 
measurements.  To verify the accuracy of the reported sample temperature while sweeping 
temperature, occasionally stabilize the temperature and continue measuring.  The reported 
temperature and magnetic moment readings will be averages, which can result in scatter or 
imprecise data, depending on the rate of temperature and moment change. 

4.8.3 Moment Versus Time (M(t)) 

The speed of the measurements makes it feasible to examine some time-dependent magnetic 
effects with the MPMS 3.  However, the time required to stabilize the magnetic field with the 
QuickSwitch is on the order of 1 second, and the minimum time required to collect one data point 
(minimum practical averaging time) is about 1  sec, depending on the computer workload.  Time-
dependent effects faster than this cannot be resolved with the standard MPMS 3 measurements. 

To view time-dependent effects, collect a continuous stream of data.  You will need to carefully 
select the measurement averaging time based on the time resolution and moment resolution 
required.  To examine a sample’s remnant magnetization as a function of time, set the instrument 
magnetic field to zero using the fastest charging rate.  If the instrument remnant magnetic field 
drifts after stabilizing at “zero” field, you may try to stabilize the magnet with the “Utilities > 
Reset Magnet” command.  See “Common Sources of Error:  Magnetic Field Error” below for 
more about remnant magnetic field. 

4.9 Common Sources of Error 
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4.9.1 Magnetic Field Errors 

The reported magnetic field is derived from the net current that is known to be passing through the 
magnet solenoid.  A correction is applied for the current that passes through the QuickSwitch 
while charging or discharging the magnet.  However, the actual magnetic field at the sample 
location may be different than the reported magnetic field due to magnetic flux that is trapped 
inside the solenoid.  This trapped flux occurs because electrical currents may indefinitely persist 
within the superconducting wire, which lacks electrical resistance, and generate a remnant 
magnetic field.  This magnetic field error depends on the recent history of the magnet and is 
usually the most problematic when the reported magnetic field is very low, or zero.  Use a known 
paramagnetic reference to determine the remnant field and post-process your data to correct for 
this error if necessary.  Automating the magnet charging with a sequence to create a reproducible 
magnet history helps make the remnant field reproducible for a given measurement series.  The 
remnant field will differ if you use different charging operations to set the same magnetic field.  
You may need to characterize the remnant magnetic field following all magnet charging 
operations in your sequence.  Our experience clearly demonstrates the accuracy this procedure will 
achieve. 

4.9.2 Sample Holder Effects 

As described in the section above, the sample holder and sample securing agent may contribute to 
the measured signal.  Measure each independently to determine the effects they have on 
measurements use centering scans to look for other print source dipole signals on the “blank” 
holder. 

4.9.3 Sample Location Errors 

Improperly-located samples will yield measurement errors.  It is important to determine the correct 
sample offset before beginning measurements.  If the sample temperature will be changed during 
or between measurements, it is important to adjust the sample location during the measurement 
process.  Thermal contraction of the sample rod and sample holder will result in the sample 
location changing.  Using the auto-tracking feature is the best way to automatically adjust the 
sample location.  When utilizing the periodic centering scan option, instead, the sample location 
might not be adjusted for each reading, and noticeable discontinuities may appear in the data each 
time the sample location is adjusted.  

4.9.4 Loosely Mounted Samples 

When samples are not mounted securely to the sample holder they will not undergo smooth 
motion within the detection coils.  The sample signal will be rejected, or unknown measurement 
behavior will result, and the sample may potentially fall off of the sample holder and become lost.  
It is very important to mount samples securely for accurate measurements. 

4.9.5 Temperature Errors 

The sweep rate of the temperature will dictate the accuracy of the reported temperature as 
compared to the actual sample temperature. The analytical function should provide very 
reasonable accuracy for sweep rates up to 10 K/minute. As noted in the thermometry section of the 
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manual, this instrument tries to always report the sample temperature, not just the thermometer 
reading. However, for very fast sweep rates, the user should validate the accuracy by comparison 
to a known response, like the Curie-Weiss behavior of ErYAG. 

If there is a reason to assume that the thermometer calibration of the system is no longer valid, the 
calibration can be checked by looking at the superconducting transition temperature of indium and 
compare the result with the measurement performed during the original system installation. 

The user kit contains an indium sample which should be measured using the “Temperature 
Accuracy, Oxygen Test” sequence located in the installation folder – the superconducting 
transition should occur at 3.40K +/-1%.  Please contact your Quantum Design representative if 
this temperature verification indicates that the temperature calibration of the system is no longer 
correct. 

4.9.6 Environmental Sources of Noise 

The SQUID system can be sensitive to environmental sources of noise. The most concern is for 
broadband RF radiation, like that associated with arc welding or RF-induction furnaces. Electrical 
transformers can be a source of noise. There are indications that cell phones can also disrupt the 
SQUID signal. 

Another concern is stray magnetic fields associated with charging of other magnets or the 
operation of items like an elevator. The full shield around the dewar will help mitigate these 
effects. 

A simple technique to determine if the system is experiencing interference with external noise 
sources is to monitor the SQUID voltage as a function of time. Look for discontinuous changes in 
the SQUID voltage. While it is best to isolate and remove the source of noise, the DC Scan 
measurement and other software features may be able to reject the interference. Please contact a 
Quantum Design service representative for more details on these procedures. 

4.10 Further Reading 
The following books and articles are a guide to general SQUID applications. Please see the references 
therein for more detailed issues. 

• Superconducting quantum interference device instruments and applications, R. L. Fagaly, Review 
of Scientific Instruments 77, 101101 (2006). 

• Demagnetizing Factors of the General Ellipsoid, J. A. Osborn, Phys. Rev. 67, 351 (1945) 
• The SQUID Handbook: Fundamentals and Technology of SQUIDs and SQUID Systems, Volume 

I,John Clarke, Alex I. Braginski, ISBN: 3-527-40229-2, August 2004 
• The SQUID Handbook: Applications of SQUIDS and SQUID Systems, Volume II, John Clarke 

(Editor), Alex I. Braginski (Editor), ISBN: 3-527-40408-2, October 2006 
• SQUID Sensors: Fundamentals, Fabrication and Applications, Series: NATO Science Series E, 

Vol. 329, Weinstock, H. (Ed.), ISBN-10: 0-7923-4350-6. 
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A P P E N D I X  A   

Maintenance and Servicing 

A.1 Overview 
In this appendix we provide maintenance tips and instructions for user-serviceable items on your 
MPMS3.  For help servicing the instrument, contact your Quantum Design service representative.  A 
list of service representatives can be found on the Quantum Design web site at 
http://www.qdusa.com, or by calling the Quantum Design world headquarters in the United States at 
1-800-289-6996. 

Also, please refer to the supplied manufacturer’s instructions for the vacuum pump and computer 
monitor. 

A.2 Periodic Maintenance Checklist 
To ensure proper instrument operation and long instrument lifetime, check the following items on the 
schedule shown. 

Every six months: 
 

 Inspect magnetic latches on sample rods and clean if necessary. 
 Inspect bearing surfaces on sample rods and clean if necessary (do not use solvents.) 
 Check pump oil level and add oil if necessary 
 Check pump exhaust filter located at rear of pump console and drain if necessary. 

Once a year: 
 

 Clean the sample chamber 
 Check serviceable o-rings for cracks and debris 

Once every two years: 
 

 Drain old pump oil and replace with fresh oil. 

http://www.qdusa.com/
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A.3 Service Procedures 
You may perform the following service procedures on the instrument at the installed site. Do not 
perform other service procedures not described here unless expressly instructed to do so by a Quantum 
Design representative. 

A.3.1 Removing a Loose Sample or Sample Holder from the Sample 
Chamber 
 
Items that you will need for cleaning rod assembly: 
- Double sided tape 
- Dental floss 

1) In order to start this procedure the sample chamber should be at room temperature (300K). 

2) The field in the magnet should be set to 0 Oe. 

3) Place a small piece of double sided tape on the end of the cleaning rod assembly. 

4) To ensure that the tape does not fall off, tie a small amount of dental floss around the tape to 
secure the tape to the rod. 

5) The sample transport should be removed for this operation.  Shut down MultiVu and remove the 
transport. Place the transport in the transport-shipping carrier.   

6) Insert the cleaning rod into the top of the sample chamber. 

7) Carefully push the rod down until it comes in contact with the item to be removed. 

8) Raise the rod up and slowly remove the rod from the chamber. 

9) Repeat as necessary to remove any debris from the chamber. 

10) If needed clean the chamber to insure no debris is left inside of the sample chamber. 

11) Replace the transport and restart MultiVu. 

If the sample cannot be retrieved using the method described above, do not use hooks, screws, brushes, 
or springs on the end of the cleaning rod to try and retrieve the sample as doing so can damage the 
chamber wall.  Contact a QD representative for assistance. 

A.3.2 Cleaning the Sample Chamber 
 
Items that you will need for cleaning the rod assembly: 
- Lint free wipes (Kimwipes®) 
- Isopropyl alcohol 

1) Before you start this procedure the sample space should be at room temperature (300K) for at least 
30 minutes.  

2) The field in the magnet should be set to 0 Oe. 

3) Remove any samples and sample rods. 
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4) Fold the Kimwipes®into a triangle (see figure A-1). 

5) Insert a corner of the wipe in to the cleaning tip of the cleaning rod assembly. 

6) Wrap the wipe around the tip of the cleaning rod. 

7) Soak the wipe with alcohol. 

8) Insert the tip of the cleaning rod into the top of the transport. The wipe should be able to go 
through the head without resistance - if it doesn't it should be re-wrapped a little tighter.  

9) Insert the cleaning rod all the way into the sample chamber keeping the rod straight up and down. 

10) Twist and move up and down to clean the sample chamber, turning in one direction as to not 
unravel the wipe from the cleaning tip. 

11) Remove the cleaning rod by pulling out straight up. 

12) Repeat several times until the wipe comes out clean. 

13) After the sample chamber is clean set temperature to 320K and perform a purge-and-seal function. 

      

 
Figure A-1. Cleaning the sample chamber. 
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A.3.3 Pump Oil, Changing and Filling 
Only use the procedure outlined here if your MPMS 3 is not outfitted with the EverCool recondensing 
dewar option.  Instruments with the EverCool option do not have oil-based pumps and require different 
pump servicing.  See the EverCool user’s manual for service procedures on EverCool equipped 
instruments.  The procedure below ensures that the chamber and annulus are not in a vacuum when 
opening the pump to atmosphere.  This prevents air from streaming in and contaminating these spaces 
while servicing the pump. 

 
1. Set the instrument temperature to 300 K and wait for it to stabilize at that temperature. 
 
2. Vent the sample chamber (“Instrument > Chamber… > Vent/Seal”) 
 
3. Shutdown the instrument (“Instrument > Shutdown… > OK”) 
 
4. Select "Utilities > Log Data…" and switch to the "Diagnostic Items" tab  
 
5. If not already checked, check the box next to "Annulus Pres (Torr)" and monitor its value  
 
6. Wait for the annulus pressure to reach 750-760 Torr. 
 
7. Move items off of the pump cabinet. Loosen the screws on the side of the console. The front 

cover and sheet-metal enclose are mounted together. To remove this assembly, lift the 
enclosure at the rear and carefully slide it towards the front before lifting it vertically. Place it 
into a safe spot to prevent damage. 

 
8. Shut down the pump with the power switch on the pump. 
 
9. Drain the oil from the exhaust filter into a cup or drain pan.  The exhaust filter may be drained 

by turning the nipple on the bottom of the filter clockwise with your fingers.  (Do not turn the 
entire clear filter cup unless it is necessary to replace the filter element.  The cup has a 
removable seal that is best left untouched if possible.)  

 
Note:  The exhaust filter may be drained at any time as necessary, but should be checked whenever 

servicing the pump.  It is not necessary to disconnect the pump to drain the exhaust filter. 
 

10. If you are changing the oil, drain the oil from the pump into a cup or drain pan.  The pump may 
be drained by turning the oil plug at the base of the pump counter-clockwise (just below the oil 
level view port.)  If you only need to refill the oil because the oil level is low, skip to step 12. 

 
11. Replace the drain plug and fill the pump with oil through the fill port on top of the pump.  Fill 

only to the marking on the top of the oil level view port.  Use only the oil supplied with the 
instrument.  See Appendix C for re-ordering information. 

 
12. Replace the plug in the fill port and turn the pump back on.  Replace the cover on the pump 

cabinet. 
 

13. Wait two minutes with the pump running before operating the instrument at all.  This allows 
the pump to pump air out of itself and the pumping line. 

 
14. Purge and seal the sample chamber (“Instrument > Chamber > Purge/Seal”). 
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A.3.4 Cosmetic Panels, Removing and Installing 
The cosmetic panels on the instrument may need to be removed in the following circumstances: 

• To move the instrument through a doorway 
• To access the magnet controller, gas handling controller, cryogen tanks (dewar), magnetic 

shielding, vibration isolation, cables, power distribution equipment, cryogenic insert, and 
other associated equipment for service 

The panel in front of the magnet controller may be removed by opening the left cabinet door and 
pulling the panel straight forward.  The panel snaps onto the cabinet in 3 locations.  A similar panel on 
the right side of the cabinet attaches the same way, but rarely needs to be removed. 

The other seven cosmetic panels are plastic and need to be removed and installed in sequence to gain 
access to the hardware in the lower half of the cabinet: 

 
Figure A-2. Main cabinet cosmetic panels. 

To remove all panels follow the sequence below: 

1. BOTTOM FRONT PANEL 

Pull bottom edge of panel away from cabinet (there are snaps on either side), swing bottom edge 
outward, then lift entire panel up, out of lip in top panels. 

To move the cabinet through a doorway, this is the only panel that needs to be removed.  To 
access the equipment above the dewar, continue removing the top panels: 
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2. TOP FRONT PANEL 

Open both doors and swing open (upward) the hinged arms above each door to remove the locking 
pins that secure this panel.  Then lift the panel upward, over the sample transport (motor) and 
away from the cabinet.  (Notice how the bottom of this panel sits in notches on the top left and 
right panels (#6)). 

3. TOP CENTER PANEL 

Lift directly upward (tabs on either side locate this panel in the top left and right panels (#6)). 

4. MAGNET CONTROLLER COVER 

Open left door and carefully pull the panel towards you (it snaps to the cabinet in three locations). 

This provides access to the magnet controller and the computer. 

5. MODULE BAY TOWER COVER 

Open right door and carefully pull the panel towards you (it snaps to the cabinet in three 
locations). 

6. TOP LEFT AND RIGHT PANELS 

Remove covers #5 and #6 first, open doors, move cabling out of the way, and lift panels straight 
up (they snap to the sheet metal cabinet in three locations). 

 This provides access to most of the serviceable equipment.  Should you require further access, the 
remaining panels are attached to the cryogenic insert (probe): 

7. PROBE COVER 

 Carefully spread the two front-facing edges of the cover and lift straight upward. 

8. BUTTON BEZEL 

 This panel rarely needs to be removed.  It has a sheet metal frame that is secured to the top of the 
cryogenic insert with four screws.  You may remove the screws and carefully slide the panel 
forward over the helium fill tube.  You will need to carefully disconnect the wiring to the buttons 
and the magnet current leads. 

 When reinstalling the panels, reverse the order of operations. 

A.3.5  Sample Transport Head: Removing and Reinstalling 
It is sometimes necessary or desirable to remove the sample transport (motor) from the system.  For 
example, to clean magnetized contamination out of the sample chamber, you may need to remove the 
sample transport to avoid contaminating it with the magnetized debris.  Follow the steps below to 
remove and re-install the sample transport. 

 
1. Remove any sample and sample rod from the chamber with “Sample > Install/Remove…”  

Select the “Open Chamber” button and wait for the system if necessary.  Then remove the 
sample rod. 

 
2. Select the “Shutdown” button. This disables the sample transport.  This operation will also 

ensure the sample chamber is set to room temperature before the sample rod is installed or 
removed.  If no sample rod needed to be removed, set the temperature to 300 K and vent the 
sample chamber before proceeding. 
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3. Remove the following plastic panels:  top front panel, top center panel, probe cover.  See steps 

2, 3, and 5 in the section “Cosmetic Panels, Removing and Installing.”  You may skip steps 1, 4, 
and 6 in that section. 

 
4. Disconnect the round cable connector on the back of the sample transport by pulling straight 

out. 
 
5. Make sure to have the sample transport stand open and close by.  This stand is part of the 

supplied instrument packaging, and is covered by a wooden box with metal clasps and metal 
handles on two sides. 

 
6. Turn the locking nut under the sample transport counter-clockwise while holding the sample 

transport.  The transport is heavy and you will need to stabilize it. 
 
7. Lift the sample transport straight up and place in the stand.  Never lay the sample transport on 

its side—this can damage delicate suspension springs in the head. 

To replace the Sample transport: 
 

1. Position the sample transport over the sample manifold block on top of the cryostat and 
carefully set it in the center.  Rotate until the armature position window faces the front of the 
instrument. 

 
2. While holding the sample transport, turn the lock nut clockwise until tight. 
 
3. Reconnect the cable by plugging it straight in. 
 
4. Select the “Back” button on the Install/Remove Sample Wizard. 
 
5. Select the “Open Chamber” button again.  This restarts the sample transport. 
 
6. Replace the plastic panels in the reverse order you removed them. 

A.3.6 Moving the Instrument 
The main instrument cabinet has four casters (pivoting wheels) located at the four corners of the 
cabinet, and may be easily rolled from one location to another.  However, the weight of the cabinet 
normally does not rest on the front casters, but instead on the rear casters and on leveling feet mounted 
just in front of the front casters.  This prevents accidental instrument movement. 

To move the instrument first remove bottom front panel, as described in the section above.  Then lift 
the front corners of the cabinet just enough to remove the weight from the leveling feet and screw the 
leveling feet up, off of the ground with your fingers.  Use a piece of scrap wood or metal pipe as a 
lever to perform this lifting operation.   

 

 

W A R N I N G !  
Do not lift from the center of the dewar! 

You will need to lift near the front corners, where the cabinet 
frame is located, rather than near the center, where the 
vibration isolation and cryogen tank (dewar) is located.   
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Figure A-3. Raising the leveling feet. 

Adjust the large nut (clockwise) to raise it.  Raise the steel feet using a 5/16 Allen Key.  Turn counter-
clockwise and raise them as high as the bottom of the feet with the large nut.  Once the leveling feet 
are screwed up and out of the way, allow the cabinet to rest on all four casters and roll it to its new 
destination.  With the bottom front panel removed it should fit through a standard doorway. 

Take care not to stretch or stress the hose and cables running between the main cabinet and the pump 
cabinet when moving the instrument.  You should have someone else help you by rolling the pump 
cabinet along-side the main cabinet. 

Make sure that the instrument is properly leveled again at its new destination. 



Appendix A   Section A.3 
Maintenance and Servicing Service Procedures 

Quantum Design  MPMS 3 User’s Manual, 1500-100, Rev. F1 A-9 
June 2016 

A.3.7 Air Filters, Cleaning or Changing 
The air filter on the front, at the bottom of the module tower filters the air cooling the module bay 
power supply.  It may be removed by removing the four screws holding the frame in place in front of 
the fan.  Clean the filter with mild soap and water to remove dust and debris, and air dry. 

Do not run the system for more than two days without the air filters in place. 

A.3.8 O-rings, Cleaning or Changing 
The various O-rings in the system may need to cleaned and re-greased occasionally.  Use only 
isopropyl alcohol applied to a lint-free cloth to clean O-rings.  After removing any O-ring, inspect it 
for cracks or other damage and clean the O-ring groove and mating surfaces with a lint-free cloth and 
isopropyl alcohol. Use a small amount of silicone or Apiezon M vacuum grease to lubricate and lightly 
coat the O-ring completely.  The O-ring should just look wet, but no grease itself should be visible or 
discerned as a lump or layer. Reinstall the O-ring only if it is not cracked or damaged.  The utility kit 
supplied with your system contains spares of the most commonly replaced O-rings. Service Note 1500-
220 lists the commonly replaced o-ring, with pictures illustrating their locations.  Contact your 
Quantum Design service representative to replace cracked or damaged O-rings. 

A.3.9 Replacing Fuses 
The system has several user accessible fuses. In case you encounter situations where a fuse blows or a 
breaker jumps, contact your Quantum Design service representative to assist in investigating the reason 
and provide advice. 

Laboratory power outlet: 

According to Quantum Design instructions and for safety reasons, the laboratory power outlet has to be 
equipped with 16A breaker. 

Power Distribution Unit: 

The main power entry located on the power distribution unit at the rear of the system has a 10A 
resettable breaker. 

 

 

The Module Bay Tower (model EM-QA) utilizes two 6A, 20 mm 
delay fuses at the power entry.  These should only be replaced 
with equivalent fuses and should always both be replaced at the 
same time. Spare fuses can be found in your utility kit. 

The Magnet Controller (model EM-QB) utilizes two 8A, 20 mm 
delay fuses at the power entry.  These should only be replaced 
with equivalent fuses and should always both be replaced at the 
same time. Spare fuses can be found in your utility kit. 

To access the magnet controller you will need top remove the 
magnet controller cover, as indicated in section A.3.4. 
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A.3.10 Unplugging Nitrogen Exhaust 

There are cases when the nitrogen exhaust mechanism of the MPMS 3 fails due to plugging, 
presumably by air leaking into the dewar.  If the rear, external exhaust fails to operate properly, this 
situation must be remedied before a transfer of more liquid nitrogen.  While the front fill and exhaust 
ports for the nitrogen are a safety release, they should not show venting during normal transfers.  If 
there are limited exhaust capabilities, an overpressure in the nitrogen tank can lead to a catastrophic 
failure of the dewar and damage to the probe. 

The primary advice is to verify there are no leaks into the nitrogen dewar.  Check that both front 
exhausts have the proper o-rings in place and are secure.  Kink the rubber tubing coming from the rear 
exhaust and allow a slight pressure to build up such that releasing the kink results in a burst of nitrogen 
gas.  This test would verify the rear pressure relief valve is operational and the exhaust is at least 
somewhat clear.  If during the start of the transfer the rear exhaust does not open within the first 30 
seconds, then stop transferring.   

It is recommended to transfer the nitrogen and helium on the same day.  If both cryogenic liquids are 
filled in the same day it is recommended to perform both transfers simultaneously (starting with LN2) 
or waiting for 2-3 hours after LHe is filled before transferring LN2. Since there is no nitrogen level 
meter and the presence of nitrogen is critical for low temperature operation and minimizing 
consumption of helium, the nitrogen should be added once a week.  Do not use a high pressure (~200 
psi, ~14 bar) liquid nitrogen storage dewar, but instead stay with the lower pressure (22 psi, 1.5 bar) 
rated nitrogen containers.  The helium should be added as needed.  Refer to Chapter 1, section 1.5 for 
more details regarding filling the helium and nitrogen tanks.   

It is well known that for nitrogen jacketed dewars, the transfer of helium will cause cooling of the 
nitrogen tank such that a vacuum is pulled.  Even though there is plenty of nitrogen in the tank, this 
vacuum can lead to accumulation of ice inside the exhaust ports if there is a leak or if the nitrogen 
ports are opened shortly after a helium transfer.  Normally, this situation will return to equilibrium 
within a few hours after the transfer of helium and the nitrogen gas boil-off will exhaust as expected.  
However, situations could develop where the exhaust ports are frozen open or leak in such a way as to 
generate a large enough ice plug that completely prevents the exhaust port from working.   The 
solution is to clear the ice plug, find the source of leak and fix it. 

Do not confuse the accumulation of ice on the outside of the exhaust lines with a plugging of the 
exhaust.  With high boil-off rates, ice is expected to appear, especially near the top of the dewar, under 
the foam insulation. 

Contact customer service for additional guidance and the procedure for establishing proper flow out 
the rear exhaust. 

A.4 Initial Cooldown Procedure 
The initial cooldown procedure is required after the system ran out of cryogens and warmed up for an 
extended period of time. Typically at that stage the probe (including magnet) and dewar are at room 
temperature. For cooling down an MPMS 3 EverCool system, refer to the corresponding option 
manual. 

NOTE  If the MPMS 3 has run out of helium, but is cooler than room temperature, the standard helium fill 
utility should be used rather than the cooldown wizard. 

Before starting the cooldown procedure you will need 100 liters of liquid helium, 100 liters of liquid 
nitrogen, a helium gas bottle with regulator, and the hose barb adapter for the helium fill port. Allow 
about 3-4 hours for cooling the system down from room temperature. 

If you have any questions contact your Quantum Design representative for assistance. 
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A.4.1 Preparing the System 
1. All cables are connected to the probe with one exception: Disconnect the SQUID control cable 

(3501-500) from the SQUID module (model CM-F) plug JF-1. 

2. The pump hose is connected to the pump. 

3. Start MultiVu (the initial starting of MultiVu will be longer due to the software trying to tune the 
SQUID which is temporarily disconnected). 

4. Start a log file (e.g., Date_Cooldown.dat). Select all items in each tab. 

5. Start the pump and let it warm up for 5 minutes. 

The cooldown wizard will prompt the user to verify that these steps have been completed prior to the 
start of the cooldown procedures. 

A.4.2 Starting the Cool Down Wizard 
Start the cool down wizard to initiate the system cool down.  Click the Helium Fill button on the 
instrument’s front or select “Utilities > Helium Fill…” from the menu in MultiVu.  Select “Yes” when 
asked whether this is an initial cool down to start the wizard. 

NOTE:  The cooldown wizard will only appear if the system has completely run out of helium and has 
warmed up.  Otherwise, only the standard helium fill window will appear. 

Closely follow the steps as outlined in the wizard to flush the system and probe and then cool down the 
system. 

The wizard will first prompt you to connect the hose barb to the helium fill port on the port and attach 
the helium gas line.  Next the wizard will prepare the dewar for the cooldown, by purging the dewar 
and then backfilling with helium (Figure A-4).  Before each dewar pumpout or backfill procedure, the 
wizard will prompt you to close or open the helium gas supply valve, respectively (Figure A-5). Once 
the dewar preparation is complete, you have the option to perform the procedure again, simply by 
clicking “Start”. 

 

 
Figure A-4. Cooldown Wizard - Dewar Preparation Procedure 
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Figure A-5. Warning issued to close the helium supply valve prior to dewar pump-out 

 

Annulus preparation is the next step in the cool-down wizard (Figure A-6).  This portion of the wizard 
will check the CFE flow and verify that the proportional valve is operational. 

 
Figure A-6. Cool-down Wizard - Annulus Preparation Window 

Once the flow has stabilized at 50 cc/min and the annulus preparation is complete, you will then be 
prompted to close the helium gas supply valve and remove the hose bard from the helium fill port.  A 
dialog will also appear, instructing you to begin filling both liquid nitrogen and liquid helium.  The 
filling of both cryogens should be done simultaneously. 

Fill LHe to about 60-80%. If the storage dewar runs dry stop immediately.  The level meter is not 
operational for entire duration of the helium fill portion of the cool-down wizard, but instead is only on 
for brief intermittent periods.  This is to avoid the extra heat load from the level meter.  The progress of 
the cool-down will be shown by the green indicator on the last page of the cool-down wizard. 

Fill LN2 until the tank is full (liquid nitrogen will spit out of the rubber exhaust hose.   

 

W A R N I N G !  

Liquid nitrogen could crack your lab floor.  Ensure proper 
protection. 
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A.4.3 Verifying Probe is Working:  
1. Close the cool down wizard when it has completed. 

2. Reconnect the SQUID control cable (3501-500) to the SQUID module (model CM-F) plug JF-1. 

3. In MultiVu tune the SQUID: In Utilities/SQUID open squid control and select Auto Tune. 

4. In MultiVu set the temperature to 298K. 

5. Install the Pd sample and set the field to 1 Tesla. 

6. Locate the sample and verify moment calibration (see section 3.9.2). 

7. Run a sequence down to base temperature. Note: Running for 1.8K right after an initial cooldown 
might take more time than usual. Allow some time for the system to settle. 

8. Install all cosmetic panels.  
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A P P E N D I X  B  

Advanced Software Operations 

B.1 Overview 
In this appendix we describe advanced operations performed with MultiVu. Section B.2 outlines 
the SQUID range settings. The following sections describe specific diagnostic tools. This is 
crucial in case troubleshooting is required. Section B.3 focuses on diagnostic data logging, 
section B.4 on the background event log and section B.5 on specific SQUID diagnostics. Finally 
in section B.6 we describe how to reset the magnet. 

B.2 SQUID Ranges and Autoranging 
The SQUID ranges are labeled 1, 10, 100, and 1000.  This corresponds roughly to the multiplier 
required to convert the output voltage from the SQUID electronics to the number of flux quanta 
(Φ0) measured by the SQUID. As the output voltage from the SQUID electronics is in the range 
±5V this means that the maximum SQUID signal one can measure in each of the ranges is 
roughly ± 5Φ0, ± 50Φ0, ± 500Φ0, and ± 5,000Φ0. However, the maximum full-scale reading in 
emu (or A-m2) depends on numerous calibration factors.  You may simply remember that 1 is the 
most sensitive range, and that each successive range reduces the amplification by x10. 

The instrument is calibrated to minimize discontinuities between ranges; however, discontinuities 
cannot be eliminated completely.  It may be possible to notice the instrument range changes as 
small steps or discontinuities in your data.  The SQUID range is one data item that is collected 
with each data record, so it is possible to examine your data and know whether a range change 
correlates with a discontinuity in magnetic moment data. 

The SQUID range selection appears on the “Advanced” tab of the measurement and sequence 
command windows.  The default setting is sticky autorange. 
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B.2.1 Sticky Autorange 
Change the SQUID range only if the signal is < 9% or > 90% 
of the current full scale range.  This setting minimizes the 
amount of time spent changing ranges and minimizes the 
number of possible data discontinuities due to range changes. 

 

 

B.2.2 Always Autorange 
Figure B-1. SQUID ranging. 

 
Check the signal level during every single measurement and adjust the range for maximum 
signal every time.  Signal may not exceed 90% of full scale.  This setting maximizes the signal 
level, but also creates potential delay determining the best range setting for every data point and 
allows for data irregularities when the signal level is very close to the range boundaries. 

B.2.3 Fixed Range 
Keep the SQUID set to the selected range. Note that the system will not collect any data points 
with this setting if the signal exceeds the maximum of the selected range. 

B.3 Logging Diagnostic Data 
The menu command “Utilities > Log Data…” is used to log diagnostic data for the instrument.  
To use the logger, click “Browse” and specify a file name to write to.  You may specify a new 
file name or an existing file name.  Be careful:  If you check the “Overwrite Existing File” box, 
any existing data in the file will be deleted!  Also, specify how often to log data records to the 
file.  Some problems are best diagnosed by very rapid data logging for a short period of time, 
while others are best diagnosed with very long logs with infrequent data records.  A Quantum 
Design representative can usually help you determine the most appropriate logging interval to use 
when troubleshooting. 

When you click “View Data,” the specified data file will be opened in a graph view.  But no data 
will be present in the file until you select data items to log from the other three tabs—“Standard 
Items,”  “Diagnostic Items,” and “Advanced Items”—and until you click “Start” (begins the 
logging) or “Acquire Once” (records all of the checked data items one time only.)  Once logging, 
data will continue to be recorded to the file at the specified rate until you click “Stop.”  You may 
change the data items being logged while the logger is running.  A time stamp always 
accompanies each data record. 
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Figure B-2. Data logging interface. 

B.3.1 Standard Items 
Standard Items include basic information generally available in the MultiVu status bar.  The state 
of the sample chamber, temperature control, field control, and motor are recorded in the data file 
as integers.  The log data window displays the meaning of each of these status codes in real time, 
but this text is not included in the log data files 

 

      
Figure B-3. Selection of standard data to log. 
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To learn the meaning of status codes that have been logged to a data file, open the status 
calculator  dialog by selecting “Utilities > Diagnostic > Status Calculator” from the menu bar.  
The status codes for temperature control, field control, and sample chamber can be calculated, as 
well as the time stamp. 

 

 
Figure B-4. Status Calculator 

 
B.3.2 Diagnostic Items 

Diagnostic Items include more detailed information about the data from each individual sensor or 
transducer in the system. 

B.3.3 Advanced Items 
Advanced Items are all configurable data items.  A large amount of raw instrument data is 
available for logging when required.  Configuration of these data items is accomplished with a 
Qmap file which is usually supplied by a Quantum Design representative. 

The menu command “Utilities > Sigma Log Data…” contains very similar capabilities as the log 
data command, except that you may log the statistics (stats) average and standard deviation of 
each data item as well.  This generates data files that are significantly larger and more tedious to 
navigate than the standard log data command.  The average values recorded with this command 
may be a simple average of all new data, or a running average of the last several data items, in 
which case each average may be calculated with some of the same data as the previous data 
record. 

The log data and sigma log data commands have counterpart sequence measurement commands 
which may be executed within a sequence to start and stop data logging, change the log file or 
logging rate, or change the data being logged. 
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B.4 Using the Event Log 
The event log is a text file containing diagnostic messages generated by the instrument, with time 
stamps.  The event log is limited to 10 MB in size, and will begin over-writing itself when this 
limit is reached.  It is arranged chronologically. 

You may specify the different level of diagnostic messages that are displayed in the MultiVu 
event log viewer.  Message levels range from informational to fatal errors.  Access the event log 
with the menu command “Utilities > Event Log.”  If you experience a problem with your 
MPMS3, you may be instructed to read the contents of the log to help determine the source of the 
problem. 

Anytime an event occurs (with a level which is enabled in the Event Log viewer), a little dialog 
box with the three most recent events will be displayed. This ensures that you don’t miss 
potentially significant error messages. 

B.5 SQUID Diagnostics 
MPMS 3 MultiVu contains a diagnostic SQUID interface which allows you to change the SQUID 
bias, range, and offset.  In addition, it allows you to quench the SQUID and the SQUID input 
circuit, eliminating standing currents by heating them above their critical temperature.  You may 
also zero the output, tune the SQUID, and determine the transfer fraction (V/Φ0).  The “Output” 
selection allows you to control what signal is present at the BNC connector (JF-5 and JF-7) on 
the front of the SQUID control module, model CM-F. 

These procedures are rarely necessary under normal instrument operation.  They exist for use by 
service personnel and engineers.  The SQUID diagnostics are accessed with the menu command 
“Utilities > SQUID.” 

B.6 Resetting the Magnet 
Because it poses no resistance to the motion of electrons, the superconducting solenoid in the 
MPMS 3 tends to “trap” magnet flux.  It can be very difficult to drive the magnet to truly zero 
magnetic field.  Even though there is no net electrical current through the solenoid and no voltage 
across it according to the magnet controller, small currents may still circulate within the 
superconducting material. 

Resetting the magnet is one way to help minimize the magnetic field or field gradients in the 
sample chamber.  The operation is completely automated, but should only be initiated by a user 
who understands the operation.  The software first drives the magnet to zero field and then 
applies heat to the magnet with an integrated heater to drive the superconducting solenoid 
windings above their critical temperature.  After resetting the magnet, some time is required for 
the magnet to cool back down to operating temperature. So you should wait a couple of minutes 
before charging the magnet again. 

Reset the magnet with the menu command “Utilities > Reset Magnet.”  A confirmation window 
will follow. 
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Note that resetting the magnet can use a significant amount of helium boil-off. For most purposes 
simply oscillating the field to zero from a field of a few tesla will provide a similar end result 
while requiring significantly less liquid helium. 
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A P P E N D I X  C  

System Specifications and Interconnects 

C.1 Overview 
In this appendix we provide information on system specifications, such as power requirements 
and operating conditions (section C.2). We further provide interconnect diagrams for a more 
detailed understanding of the system architecture (section C.3). 

C.2 System Requirements and Operating Conditions 
Quantum Design service representatives will perform the initial installation of the system. These 
are however various requirements which need to be fulfilled prior to the installation. 

C.2.1 Power Ratings 
 

 

W A R N I N G !  
Voltage: 200-230 VAC, 50/60 Hz, single phase 
Current: typical operation 6-8 A 

 
 

 

W A R N I N G !  

Mains Fusing: 10 A breaker at main power switch. 
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C.2.2 Laboratory Power Outlet Setup 
Laboratory power outlet is required to be fused to 16A MAX. 

The power cord supplied with the system is 2.5m (10 ft) long. The power outlet should be 
within that distance from the planned system location or an extension cord will be 
required (not supplied by Quantum Design). 

 

Laboratory outlet specifications:  

International industrial type connector 
IEC 60309 6H Female 
16A/250V 
2P+E 
I44 (splash proof) 
Color Code: blue 
Safety approvals: UL/CSA, VDE, IEC 

Figure C-1. Laboratory power outlet. 

C.2.3 Laboratory Ambient Conditions 
Operating ambient temperature: 10-40 °C (50-104 °F) 
Operating ambient relative humidity: 10-90% (non-condensing) 

C.2.4 Cryogenic Requirements 
For the initial cooldown the system requires the following quantities of cryogens: 

Liquid Nitrogen: 100 liters 
Liquid Helium: 100 liters (another 100 liters should be available as a back-up) 
Pressurized Helium gas cylinder with regulator (regulator pressure range: 100-300 mbar) 

Under normal operating conditions the cryogen hold-times are typically 12 days for 
helium (100% = 70 liters) and nitrogen (100% = 55 liters). See section 1.5 for more 
details on transferring cryogens.  For EverCool system configuration, please refer to the 
corresponding power and cryogenic requirements. 

In case the system warms up, follow the cooldown procedure described in Appendix A.4. 

C.3 System Interconnects 
The various system interconnects are shown below to help understanding of the general 
architecture of the system. Most of these interconnects do not need to be serviced by the user at 
all.
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Figure C-2. MPMS 3 System Architecture
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       Figure C-3. MPMS 3 System Interconnects.
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C.3.1 Master List of Connections 
A master list of connections is provided below for the standard MPMS 3 modules and controllers 
as well as option modules. 

 

Table C-1. Connections List – SQUID Control Module 

MODULE/PART 
#/CHANNEL CABLE ASSEMBLY MODULE/PART 

#/CHANNEL 

PIN # FUNCTION PIN # 
SQUID CONTROL:  

4101-500, JF1/2 (CH1/2) SQUID CONTROL: 3501-500 SQUID HEAD:  
4500-500, JQE-1 

1 DETECTOR A 1 
9 DETECTOR B 9 
2 SIGNAL A 2 

10 SIGNAL B 10 
3 +15 VOLTS 3 

11 -15 VOLTS 11 
4 MOD/BIAS A 4 

12 MOD/BIAS B 12 
5 TEST INPUT 5 

13 REF GND 13 
6 RANGE/HEATER/RESET 6 

14 RANGE/HEATER/RESET 14 
7 EXT INPUT A 7 

15 EXT INPUT B 15 

8 SHIELD 8 

SQUID CONTROL:  
4101-500, JF-4 (AUX) 

SVSM AC-SQUID MODULE:  
3101-404 

SQUID AC:  
4101-400, JK-1  
(SQUID AUX) 

3 SIGNAL A 15 
8 SIGNAL B 8 
1 FEEDBACK + 1 
6 FEEDBACK - 9 

5 RESET 5 
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Table C-2. Connections List – SQUID Head Module 

MODULE/PART 
#/CHANNEL 

CABLE ASSEMBLY MODULE/PART 
#/CHANNEL 

PIN # FUNCTION PIN # 

SQUID HEAD:  
4500-500, PIGTAIL 

MPMS3 FLEXIBLE DC SQUID: 
3502-050 

SQUID CAPSULE ASSY.:  
4502-001 

E11 FEEDBACK A 1 
E12 FEEDBACK B 2 
E7 MODULATION A 3 
E8 MODULATION B 4 
E3 SIGNAL A 5 
E4 SIGNAL B 6 

E13 SQUID HEATER A 7 
E14 SQUID HEATER B 8 
E5 BIAS A 9 
E6 BIAS B 10 
E9 INPUT TRSF HEATER A 11 

E10 INPUT TRSF HEATER B 12 

E2 SHIELD/GRD 13 
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Table C-3. Connections List – Temperature Control Module 

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

TEMPERATURE CONTROL 
MODULE: 4101-260, JG-1 

TEMPERATURE CONTROL:  
3501-010 

SAMPLE TUBE:  
4501-500, JQD-11 

1 GAS HEATER THERMOMETER I+ 1 

16 GAS HEATER THERMOMETER I- 16 

2 
GAS HEATER THERMOMETER 

V+ 2 
17 GAS HEATER THERMOMETER V- 17 
3 SAMPLE THERMOMETER I+ 3 

18 SAMPLE THERMOMETER I- 18 
4 SAMPLE THERMOMETER V+ 4 

19 SAMPLE THERMOMETER V- 19 
5 NECK THERMOMETER I+ 5 

20 NECK THERMOMETER I- 20 
6 NECK THERMOMETER V+ 6 

21 NECK THERMOMETER V- 21 

7 
SPARE THERMOMETER I+ (NOT 

USED) 7 

22 
SPARE THERMOMETER I- (NOT 

USED) 22 

8 
SPARE THERMOMETER V+ (NOT 

USED) 8 

23 
SPARE THERMOMETER V- (NOT 

USED) 23 
12 SROM GRD 12 
44 SROM SI 44 
13 SROM SO 13 
14 SROM CS 14 
15 SROM VCC 15 
30 SROM SCK 30 
31 GAS HEATER I+ 31 
32 GAS HEATER I- 32 
33 SAMPLE HETER I+ 33 
34 SAMPLE HETER I- 34 
35 NECK HEATER I+ 35 
36 NECK HEATER I- 36 
37 SPARE HEATER I+ (NOT USED) 37 

38 SPARE HEATER I- (NOT USED) 38 
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Table C-4. Connections List – Ultra Low Field Module 

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

MPMS 3 ULF: 4101-550,  
JJ-2 (MOD TRIM) 

SVSM AC MOD/TRIM COIL:  
3101-402 

POWER DRAWER ASSEMBLY:  
4506-050, JQA-3 (MOD COIL) 

8 MOD + 13 
4 MOD - 5 
9 TRIM + 12 

5 TRIM - 4 
MPMS 3 ULF: 4101-550,  

JJ-1 (FLUXGATE) SVSM FLUXGATE: 3084-723 FLUXGATE FISCHER 
CONNECTOR 

1 INTEGRATOR RESET A 1 
6 INTEGRATOR RESET B 2 
2 SENSOR DETECT A 3 

7 SENSOR DETECT B 4 

Table C-5. Connections List – SQUID AC Module 

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

SQUID AC: 4101-400,  
JK-1 (SQUID AUX) 

SVSM AC-SQUID MODULE:  
3101-404 

SQUID CONTROL:  
4101-500, JF-4 (AUX) 

15 SIGNAL A 3 
8 SIGNAL B 8 
1 FEEDBACK + 1 
9 FEEDBACK - 6 

5 RESET 5 

SQUID AC: 
4101-400, JK-2 (CAL) 

SVSM AC CAL/DETECT COIL: 
3101-403 

WAP FISCHER CONNECTOR --
> CAL COIL 

2 CAL COIL + 4 --> 1 

7 CAL COIL - 6 --> 2 

SQUID AC: 4101-400,  
JK-3 (MOD TRIM) 

SVSM AC MOD/TRIM COIL:  
3101-402 

POWER DRAWER ASSEMBLY:  
4506-050, JQA-3  

(MOD COIL) 

8 MOD + 13 
4 MOD - 5 
9 TRIM + 12 

5 TRIM - 4 
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Table C-6. Connections List – Motor Module 

MODULE/PART 
#/CHANNEL CABLE ASSEMBLY MODULE/PART 

#/CHANNEL 

PIN # FUNCTION PIN # 
MOTOR MODULE:  

4101-100, JA-1 (SERVO) 
VSM, DRIVE (SVSM):  

3096-200-02 
VSM TRANSPORT: 4096-

400-02 

 MOTOR - 14 
 MOTOR + 12 

1 MOTOR - 15 
10 MOTOR + 13 
2 + 5 V 16 
11 GND 4 
19 SDO  MOS 1 7 
24 SPARE 1 10 
3 + A 17 
12 - A 18 
20 SDI  MISO 8 
23 AUXCS 2 
4 + B 5 
13 - B 6 
21 SCK 1 
22 ROMCS 9 
25 SPARE 2 3 
26 SPARE 3 11 
5 + Z N/C 
14 - Z N/C 
8 + LIM N/C 
17 + LIMRTN N/C 
9 - LIM N/C 

18 - LIMRTN N/C 

With Rev D0 or higher, Motor Modules have rotator connection (see table C-7). 
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Table C-7.Connections list – Motor Module Stepper   

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

MOTOR MODULE:  
4101-100, JA-Z (STEPPER) 

Rotator Cable: 
3505-300 

Feedthrough 
4505-305 Rotator Rod 

Fischer 
Connector 

Omnetics 
Connector 

1 MOTOR A+ 5 1 
9 MOTOR A- 4 2 
2 MOTOR B+ 12 3 
10 MOTOR B- 6 4 
3 VCC 11 7 
11 GND 9 12 
7 Limit + 7 8 
15 Limit - 10 10 
8 Limit RTN 8 11 

 
 

Table C-8. Connections List - Gas Handling Module 

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

POWER DRAWER ASSEMBLY:  
4506-050,QD CAN, JQA-7 

GAS HANDING, QD CAN:  
3506-020 

MPMS3 GHC:  
4501-040GAS CONTROL, JQD-9 

7 CAN H 7 
2 CAN L 2 
8 SYNC H/RS 8 
4 SYNC L 4 
5 LINE SYNC 5 
6 SYS GND 6 
1 -24 VDC 1 
3 24V RTN 3 

9 +24 VDC 9 
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Table C 9. Connections List - Oven Module 

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

OVEN MODULE: 
 4101-200, JC-1 OVEN CONTROL: 3097-010 WAP FISCHER CONNECTOR --

> HEATER STICK 

9 TC-NEG 6 

1 TC-POS 4 

2 THM-A 3 

10 THM-B 5 

7 HTR A 1 

15 HTR  B 2 

Table C-10. Connections List - Magnet Control 

MODULE/PART #/CHANNEL CABLE ASSEMBLY MODULE/PART #/CHANNEL 

PIN # FUNCTION PIN # 

POWER DRAWER 
ASSEMBLY: 4506-050,  

JQA-2 (MAG AUX OUT) 

MPMS3, MAGNET CONTROL: 
3503-010 

PROBE HEAD,  
4502-100, JQD-12 

8 MAG VOLTAGE A 8 
21 MAG VOLTAGE B 9 
9 MOD COIL A 10 

22 MOD COIL B 11 
10 SWITCH HEATER A 12 
23 SWITCH HEATER B 13 
11 QUENCH HEATER A 14 
24 QUENCH HEATER B 15 
25 TRIM COIL A 16 

13 TRIM COIL B 17 

POWER DRAWER 
ASSEMBLY: 4506-050, 
JQA-1 (MAG AUX IN) 

MPMS3 MAGNET CONTROL 
INTERFACE: 3503-012 

HYBRID MAGNET 
CONTROLLER:  

4503-010-01, JQB-1 (MAGNET 
CTRL) 

8 MAG VOLTAGE A 8 
21 MAG VOLTAGE B 21 
10 SWITCH HEATER A 10 
23 SWITCH HEATER B 23 
11 QUENCH HEATER A 11 

24 QUENCH HEATER B 24 
HYBRID MAGNET 

CONTROLLER:  
4503-010-01, JQB-5 

MAGNET CURRENT: 3503-015 PROBE HEAD,  
4502-100, JQD-15 
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1 CURRENT POS 1 

2 CURRENT NEG 2 
 

Table C-11. Connections List - Evercool Option 

MODULE/PART 
#/CHANNEL CABLE ASSEMBLY MODULE/PART 

#/CHANNEL 

PIN # FUNCTION PIN # 

MANIFOLD: 4099-605, SV1 SOLENOID VALVE, EC: 3101-363; 
RECIRC VALVE 

BOX; EVERCOOL 2 
CONTROLLER:  
4099-641, JQL-1 

1 +24 V 1 

2 GND 2 

MANIFOLD: 4099-605, SV2 SOLENOID VALVE, EC: 3101-363; 
EXHAUST VALVE 

BOX; EVERCOOL 2 
CONTROLLER:  
4099-641, JQL-2 

1 +24 V 1 

2 GND 2 

MANIFOLD: 4099-605, SV4 SOLENOID VALVE, EC: 3101-363; 
SUPPLY VALVE 

BOX; EVERCOOL 2 
CONTROLLER:  
4099-641, JQL-4 

1 +24 V 1 

2 GND 2 

MANIFOLD: 4099-605, LP1 PRESSURE SENSOR: 3099-617; 
DEWAR PRESSURE 

BOX; EVERCOOL 2 
CONTROLLER:  
4099-641, JQL-9 

1 +12 V 1 

2 GND 2 

4 SIGNAL 3 

MANIFOLD: 4099-605, LP2 PRESSURE SENSOR: 3099-617; 
DEWAR PRESSURE 

BOX; EVERCOOL 2 
CONTROLLER:  

4099-641, JQL-10 

1 +12 V 1 

2 GND 2 

4 SIGNAL 3 

MANIFOLD: 4099-605, LP3 PRESSURE SENSOR: 3099-617; 
SUPPLY PRESSURE 

BOX; EVERCOOL 2 
CONTROLLER: 4099-641, 

JQL-11 

1 +12 V 1 

2 GND 2 

4 SIGNAL 3 

FAN, JQL-14 FAN 24 V: 3099-617 
BOX; EVERCOOL 2 

CONTROLLER:  
4099-641, JQL-14 

1 +24 V 1 
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MODULE/PART 
#/CHANNEL CABLE ASSEMBLY MODULE/PART 

#/CHANNEL 

PIN # FUNCTION PIN # 

3 GND 2 

4 STAGE DC DIAPHRAM 
PUMP:  4095-306, P19 ADAPTER DC PUMP: 3095-243 

BOX; EVERCOOL 2 
CONTROLLER:  
4099-641, JQL-18 

1 SWITCH COMMON (K1-COM) 1 

2 CNTROL (K1-N.O.) 2 

3 PUMP SPEED V 3 

4 GND 4 

5 +24 V 5 

6 GND 6 

EVERCOOL-2 
CONTROLLER:  
4099-600, JQL-8 

INTERLOCK CABLE:  
3099-625-01, -02 

CRYOMECH 
COMPRESSOR:  
4099-610 OR -611, -612, 
SYSTEM I/O 

1 +24 V 10 

2 GND 13 

N/C   9 

N/C   11 

EVERCOOL-2 
CONTROLLER:  

4099-600, JQL-17 SEARIAL CABLE: 3099-624-01, 02 

CRYOMECH 
COMPRESSOR:  
4099-610 OR -611, -612, 
RS232/485 

1 DSR N/C 

2 CD N/C 

3 DTR N/C 

4 GND 5 

5 RX 2 

6 TX  3 

7 CTS N/C 

8 RTS N/C 
EVERCOOL-2 

CONTROLLER:  
4099-600, JQL-13 COLD HEAD: 3099-627 

PULSE TUBE COLD 
HEAD: 4099-608 

5 CABLE SHIELD N/C 

2 THERMOMETER I+ 7 

1 THERMOMETER I- 8 

3 THERMOMETER V+ 9 

4 THERMOMETER V- 10 

6 HEATER + 1 
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MODULE/PART 
#/CHANNEL CABLE ASSEMBLY MODULE/PART 

#/CHANNEL 

PIN # FUNCTION PIN # 

7 HEATER - 2 
 
 

 
Figure C-4. MPMS 3 Power Distribution Diagram 
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Figure C-5. MPMS 3 Cryogen Plumbing Diagram 
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C.3.2 Attaching a Printer to the System 
The recommended solution is to print through a network printer.  If this is not available or 
possible, a printer can be attached to the system.  Due to noise issues and possible ground loops it 
is required when hooking a printer up to the system, the power be plugged into the pump cabinet 
and the USB cable be plugged into the marked USB outlet on the computer or the provided USB 
hub.   

 

 

W A R N I N G !  

The power provided on the power strip for the pump cabinet is 
220V. 

 

Please contact a Quantum Design representative if you have any questions or concerns about 
attaching a printer to the system. 
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A P P E N D I X  D   

Understanding the Data Files Format 

D.1 Overview 
In this appendix the meaning of each data column in a measurement data file generated by the 
MPMS3 system is explained in some details. 

D.2 Data File Columns Descriptions 
 

Table D-1. Standard Measurement File Data Columns 

COLUMN DESCRIPTION 

General Items 

Comment 

Any comments entered into the data file. 

Comments can be entered either directly using the 
Measure → Datafile Comment… menu entry or 
inside a sequence using the Measurement 
Commands → VSM → Datafile Comment sequence 
command. 

Time Stamp (sec) 

The absolute time stamp for the current row of data. 

Timestamps can be converted into date & time values 
using the Utilities → Status Calculator menu 
item in MultiVu (enter the timestamp from the data file 
into the Time text field and click State? to convert the 
value). 

Temperature (K) 

The sample temperature for the current data row. 

This is the sample temperature, taking into account 
thermal history and current measurement options (e.g., it 
might be the temperature of the oven sample holder 
when performing measurements with the oven option 
active). 
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COLUMN DESCRIPTION 

Magnetic Field (Oe) 

The magnetic field for the current data row. 

This value takes into account current measurement 
options (e.g., field reported by the Ultra-Low Field 
Option). 

DC Scan Related Items 

DC Moment Fixed CtrError! Bookmark not defined. 
DC Moment Err Fixed CtrError! Bookmark not 
defined. 

Amplitude of the moment and associated standard error 
for DC scan measurements (fixed center) 

The “Fixed Center” values denote the analysis result 
where the sample position is determined by the 
AutoTracking algorithm, the moment thus being the only 
free parameter for the fit to the raw data. 

DC Moment Free CtrError! Bookmark not defined. 
DC Moment Err Free CtrError! Bookmark not 
defined. 

Amplitude of the moment and associated standard error 
for DC scan measurements (free center) 

The “Free Center” values denote the analysis result 
where both, the sample location and the sample 
moment, are free parameters for the fit to the raw data. 

DC Fixed Fit 
DC Free Fit 

Quality of fit of the raw data to the dipole response 
function for the “Fixed Center” and “Free Center” fits, 
respectively 

Values range from 0 to 1 with 1 being a perfect fit and 0 
being random data with no correlation to the expected 
response function 

DC Calculated Center (mm) 
DC Calculated Center Err 

Calculated sample position and associated estimated 
error for the “Free Center” fit to the DC scan raw data 

This value uses the same coordinate system as the 
“Center Position (mm)” value – for perfectly centered 
samples and clean signals those two values should 
match within the resolution of the transport encoder. 

DC Scan Length (mm) Scan length of the current data point (as selected by the 
user in the “Measure” menu) 

DC Scan Time (s) Scan time of the current data point (as selected by user 
in the “Measure” menu) 

DC Number of Points Number of points in the raw DC scan waveform 

DC SQUID Drift SQUID drift calculated from the subtraction of the up and 
down measurement scans 

DC Min V (V) 
DC Max V (V) 

Maximum and minimum voltage reported by the SQUID 
module during the DC scan. 

These values represent the uncorrected values without 
taking into account drifts. Values are reported as raw 
voltage multiplied by the SQUID range as reported in the 
next column (i.e., maximum reported value can be as 
high as ±5000 in range 1000). 

Range Range setting of the SQUID module for the current data 
point. 

Possible values are 1, 10, 100, and 1000 (with 1 being 
the most sensitive setting). 

Diagnostic Items 
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COLUMN DESCRIPTION 

Min. Temperature (K) 
Max. Temperature (K) 

Minimum and maximum sample temperature readings 
over the time required to measure the current data point. 

These values are especially useful when measuring 
while sweeping temperature as they give an indication 
about the temperature accuracy for the data point. 

Min. Field (Oe) 
Max. Field (Oe) 

Minimum and maximum sample field readings over the 
time required to measure the current data point. 

Mass (grams) Total mass of moving parts obtained from the DC 
component of the motor force. 

This includes the armature inside the linear motor, the 
sample rod, sample holder, and the sample itself. 

Motor Lag (deg) Phase lag between motor drive current and actual motor 
position. 

Pressure (Torr) Pressure inside the sample chamber for the current data 
point. 

Measure Count Total number of waveforms used to calculate the current 
data point. 

This number indicates the quality of the data point – in 
perfect conditions, it should be (Frequency x Averaging 
Time) but can be reduced due to waveform rejection 
inside the SQUID module (e.g., SQUID resets occurring 
during the measurement). 

If the Measure Count drops below 50% of the expected 
value, the data point will be rejected and not logged in 
the data file. 

Measurement Number Measurement repetition number for MvsH and MvsT 
measurements. 

SQUID Status (code) Internal status codes as reported by the SQUID module. 

Motor Status (code) Internal status codes as reported by the motor module. 

Measure Status (code) 0 OK 
1 SQUID voltage railed 

Motor Current (amps) AC component of the motor current. 

Value is proportional to the force required to achieve the 
requested vibration amplitude. 

Motor Temp. (C) Temperature of the heat sink inside the motor module. 

This temperature is used internally from the motor 
module to prevent damage to the module and the motor. 
If the temperature exceeds a maximum value, the motor 
will stop moving and an error will be logged into the 
event log. 

Temp. Status (code) Temperature status code as reported by the temperature 
control subsystem. 

Status codes can be translated into corresponding status 
text using the Utilities → Status Calculator… 
menu entry in MultiVu (enter the status code from the 
data file into the Temp. text field and click State? to 
convert the value). 
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COLUMN DESCRIPTION 

Field Status (code) Field status code as reported by the magnet power 
supply. 

Status codes can be translated into corresponding status 
text using the “Utilities → Status Calculator…” 
menu entry in MultiVu (enter the status code from the 
data file into the Magnet text field and click State? to 
convert the value). 

Chamber Status (code) Chamber status code as reported by the Gas handling 
controller. 

Status codes can be translated into corresponding status 
text using the “Utilities → Status Calculator…” 
menu entry in MultiVu (enter the status code from the 
data file into the Chamber text field and click State? to 
convert the value). 

Chamber Temp (K) Chamber temperature for the current data point. 

This value is the instantaneous temperature reported by 
the chamber thermometer on the sample tube and will be 
different from the sample temperature reported earlier as 
this does not take thermal history into account. 

When the oven option is active, the chamber 
temperature should be stable at about 280 K and can be 
used to diagnose oven performance issues.  

Redirection State 0 No redirection 
1 Oven option active and controlling 
temperature 

Map 01 … Map 16 Mappable data columns (varying content). 

Additional data columns available for logging advanced 
diagnostic data (see section B.3.3 in the SVSM User 
Manual). Actual column titles in the data file will reflect 
the data being recorded when the data file was first 
created. 

 



Quantum Design  MPMS 3 User’s Manual, 1500-100, Rev. F1 E-1 
June 2016 

A P P E N D I X   E    

Using the MPMS 3 Superconducting Magnet 
at Low Fields 

E.1 Overview 
 
The superconducting magnet used in MPMS 3 is capable of generating fields up to 7 tesla 
(7x104 gauss) with the value determined to a very high degree of accuracy over most of this 
range. The magnetic field value reported to the user is based only on the current flowing from 
the magnet power supply. At low fields (less than 1 tesla), the magnetic field experienced by 
the user’s sample can deviate significantly from the reported magnetic field. The magnitude 
of this field error can be as much as 40 gauss in MPMS 3 magnets. The origin of this effect is 
described and methods for its mitigation are outlined. 

E.2 Introduction 
 

When using a superconducting solenoid to control the magnetic field in an experiment, the user must 
be aware of pinned magnetic flux lines and flux movement within the magnet in order to better know 
the magnetic field at the location of the user’s experiment. This appendix will discuss how these 
effects manifest in the magnet used for the Quantum Design MPMS 3. As the title implies, the effects 
are of greatest relative significance at low fields and are very important to keep in mind when 
conducting research on soft magnetic materials whose magnetic state is strongly affected by small 
changes in magnetic fields near zero.  

Quantum Design does not incorporate a field sensor such as a Hall sensor in its instruments. The 
magnetic field reported by the MPMS 3 is based on the current that is being generated in the magnet 
power supply (if the magnet is charging), or the last current that was sourced from the power supply 
when it was connected to the magnet (if the QuickSwitch on the magnet has been closed). The magnet 
power supply current is translated into a magnetic field using a constant field-to-current conversion 
factor (or “B/I ratio”) for that given magnet. This yields a magnetic field value that is very accurate at 
higher fields (above about 1 tesla). 

There are two phenomena that cause the MPMS3 reported magnetic field to differ from the actual 
magnetic field at the location of the user’s sample. Below is a brief summary of these effects. The 
remainder of this appendix will describe each of these phenomena in greater detail. 

1) Magnet remanence: alloys such as those used in the windings of superconducting magnets will permit 
the magnetic field to enter the superconducting material as threads of quantized magnetic flux when 
placed in sufficiently large magnetic fields. These flux lines are “pinned” and immobilized at defects in 
the material. Movement of flux lines causes energy dissipation and can destroy the superconducting 
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state. When the magnetic field is removed (for our case, when the magnet current is set back to zero 
from a high field), some of these pinned flux lines remain behind and create a small magnetic field 
seen at the sample location.  

2) Flux creep and escape: over time, some of these pinned magnetic flux lines will redistribute and may 
even leave the wire material altogether. The term “flux creep” describes the diffusion of flux lines 
inside a superconductor. At a stable magnetic field, escape of flux from the interior of the wire can lead 
to induced currents in the magnet due to the topology of the superconducting magnet. 

Section E.3 will discuss the first two effects of remanence and flux motion. Section E.3.1 presents 
methods for mitigating the magnetic field artifacts that have been described.  

Before reading this application note, it is important to understand the basics of magnetic field control 
in the MPMS 3, especially the principle of the superconducting QuickSwitch, as described in section 
3.4 of the MPMS3 User Manual. Familiarity with superconducting phenomena, especially the mixed 
state of type II superconductors, is also highly recommended as this note will not provide that 
background (see ref. i) 

E.3 Magnet remanence and flux motion 
 

The effect of magnet remanence at low fields is an offset error in the reported magnetic field. This 
offset is dependent on the magnet history and is opposite in sign when coming from positive versus 
negative fields. Figure E-1 below illustrates how this offset manifests in DC magnetometer data for a 
sample that is magnetically reversible. If one plots the magnetic moment vs. the reported MPMS 3 
magnetic field, the red curve results. Note that the hysteresis curve is “inverted” so that there is an 
apparently negative coercivity for the sample! On the other hand, if one were to plot the moment vs. 
the actual magnetic field at the sample location, the reversible blue M(H) curve results. While it is 
unphysical for the entire M(H) hysteresis loop to be inverted (it implies continuous heat absorption by 
the material as one cycles the field) it is possible to have a locally inverted region of the loop. The 
existence of locally inverted hysteresis loops is of interest to the research community, so it is important 
to discern real sample physics from instrument artifacts, as pointed out in ref. ii.  

If we define the field error as: 

field error = (real magnetic field at the sample) – (reported field) 

and plot this quantity as a function of the field in a typical MPMS 3 magnet (see Figure E-2), we see 
that the absolute error decreases at higher fields, the sign of the field error depends on the direction of 
magnet charging, and that switching the field charging direction results in the field error traversing to 
the appropriate leg in a short field duration (see traversing lines at -3 and +5 tesla). 

 



Appendix E Section E.3 
Using the MPMS3 Superconducting Magnet at Low Fields Magnet remanence and flux motion 

Quantum Design  MPMS 3 User’s Manual, 1500-100, Rev. F1 E-3 
June 2016 

 

Figure E-1. A magnetically reversible material (blue curve) can appear hysteretic (red cureve) due to 
superconducting magnet remanence.  Note the inverted (clockwise) nature of the loop. 

 

Figure E-2. Field error (defined in text) vs. the charge field in a typical MPMS 3 superconducting 
magnet.  Note the negative sign of the field error when decreasing from positive fields.  Note also that 

the error is generally not symmetric between up and down leg 

Another important feature to notice in Figure E-2 is that the field error is negative when discharging 
from positive fields. That is, if setting zero field in linear charging mode from +1 tesla or above, the 
resulting field at the sample will be about -20 gauss in this example. So, if one wants to reach true zero 
field it means stopping the field discharge short at +20 Oe instead of overshooting zero field as one 
might intuitively think (see footnote iii for a discussion of magnetism units). Finally, note the 
asymmetry between the values of field error for up and down ramping directions. It has been observed 
that the field error magnitude near zero field can differ by up to 15 gauss (this is a property of a 
particular magnet) for the different charging directions. 
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Figure E-3 shows the typical magnitude of the field error in a 7 tesla MPMS 3 magnet. Note the log-
normal plot style necessitated by the large variation in the field error as a function of applied field.  

As with the other figures, this should not be used to generate a correction for data taken on a different 
system as the magnitude of the remanence varies from magnet to magnet. Rather, these figures should 
be used for their qualitative information. 

 

 

Figure E-3.Typical magnitude of average field error (averaged between up and down ramp directions) 
as a function of the magnet filed for a MPMS 3 magnet.  Note that the field error can be as much as 15 

gauss different between up and down ramp directions. 

 
Figure E-4. The magnetic field at the sample location, as measured using a paramagnetic Dy2O3  

sample, slowly drifts by about 1 gauss upon setting zero field in LINEAR mode from +7 tesla.  After 1 
hour, the field was once again set to zero which heats the QuickSwitch and removed persistent 

currents.  See the diagram on the next page for an explanation of this phenomenon. 
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The effect of magnetic flux motion on the magnetic field at the sample location is illustrated in Fig. 4. 
The field was set from +7 tesla to zero in linear mode and stabilized. The effects shown here are seen 
to be independent of the initial field providing it was larger than +1 tesla. 

These unusual observations can be explained by the fact that a small amount of pinned remnant 
magnetic flux in the magnet escapes from the magnet windings into the bore of the magnet. In order to 
understand this, note that when the QuickSwitch is in the superconducting state it will sustain small 
DC currents without dissipation. This means that the current in the magnet can differ slightly from the 
current at the power supply when the QuickSwitch is in the superconducting state, a fact which should 
be kept in mind for the discussion below. As illustrated in the table and the accompanying figure 
below, a magnet is originally in its virgin state (1) in which no flux is pinned inside it. Upon heating 
(opening) the QuickSwitch and passing current in the magnet windings (2), a positive field is generated 
in the sample space at the center. After removing the current in the magnet and cooling (closing) the 
QuickSwitch (3), some flux remains pinned in the magnet and has the same sign as the original field 
because it resulted from field lines penetrating the magnet at positive fields.iv However, the stray fields 
from these “dipoles” are of course of the opposite sign, hence the negative initial remanent field at the 
sample location after discharging from positive fields. After an hour in this state, a small fraction of the 
pinned flux lines have escaped from the magnet windings and are in the bore of the magnet (4). Since 
this flux is now in free space, it must be represented by currents flowing in the magnet and these are in 
the direction of the original magnetic field. Since the magnet is superconducting (the QuickSwitch acts 
as a persistent switch at small currents like this), these currents will not dissipate. The small amount of 
flux escape has a large effect on the field at the sample location due to a field amplification effect: the 
field (seen at the sample location) when the flux has moved into the bore of the magnet is much larger 
than the stray field when that same amount of flux was pinned in the magnet.v Upon heating the 
QuickSwitch and setting zero field (5), the power supply removes the positive current in the magnet 
and the field that remains at the sample location is due to the stray fields from the remaining pinned 
vortices in the magnet. The magnetic field at the sample is nearly the same as in state (3) because the 
vast majority of the flux has remained pinned in the magnet. 
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Figure E-5. Top view of magnet. 

Table E-1. QuickSwitch and Remnant Field States 

Step 
magnet 

state 
switch 
state Imagnet Bsample 

1 virgin closed 0 0 

2 charged open I2 > 0 B2 > 0 

3 remanent closed I3 = 0 B3 < 0 

4 remanent 

+ 1 hour 
closed I4 > 0 B4 > B3 

5 remanent, 

reconnected 
open I5 = 0 B5 ≅ B3 
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E.3.1 Mitigating magnetic field artifacts in measurements 
 
The magnitude of the remanence in the magnet can typically be reduced down to 1-2 gauss by setting 
the field to zero (from an initial field above 1 tesla) in oscillate mode. This will also attentuate the flux 
creep effects. Remanence can be further reduced down to <0.05 gauss by using the Ultra Low Field 
option for the MPMS 3 which employs a fluxgate magnetometer and the modulation coil in the magnet 
to compensate trapped flux from the magnet.  

Once a low-remanence state has been achieved in the magnet, you can make measurements at low 
fields (-100 Oe < H < +100 Oe) without inducing a significant amount of remanence. However, a field 
of 1 kOe will already introduce a lot of pinned flux in the magnet.  

Some measurement situations (most commonly M(H) loops from high fields through zero field) do not 
permit the use of low field techniques discussed above. In this case there are some guidelines we 
recommend in order to achieve best results: 

• Determine the magnet remanence and flux creep properties of your magnet  
(see Figs. G-2 thru G-5) by using a pure paramagnetic sample such as the Er:YAG standard sample 
(4500-636) or a Dy2O3 pellet (4041-008) that is free of any measureable amount of ferromagnetic 
impurities (very important –  a ferromagnetic signature will lead to an underestimate of the real magnet 
remanence value); this option is good since in principle the M(H) slope for these materials is very 
nearly constant at 300 K so one can determine the absolute field error at each field – contact 
apps@qdusa.com for more information. 

• The remanence properties of the magnet are very reproducible as long as the same field charging 
recipe is followed each time; thus, once the field error table is determined by using a standard sample, 
you can run the same field charging sequence on your sample and apply this field correction; 
alternately, you can modify the field set points of the measurement protocol so that the actual field is 
the desired one (in the example from Fig. 2, setting +20 Oe from positive high fields will produce a 
field at the sample of ~0 Oe). 

In conclusion, one must be cautious when using a magnet used for generating ~104 gauss to also 
accurately generate fields on the order of 10 gauss. By understanding the basic operating principles of 
a superconducting magnet and by following the guidelines laid out above, it is possible to greatly 
reduce artifacts in the reported magnetic field. 

While we have focused here on the instance of the Quantum Design MPMS 3, the effects of 
remanence, flux creep and persistent switch leakage currents discussed in this application note are 
relevant to any superconducting magnet with a superconducting switch.  

 

mailto:apps@qdusa.com
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i M. Tinkham, Introduction to Superconductivity (McGraw-Hill, 1996).  
ii “Soft-magnetic materials characterized using a superconducting solenoid as magnetic source” Giovanni 
Mastrogiacomo, Jorg F. Löffler, and Neil R. Dilley, Appl. Phys. Lett. 92, 082501 (2008), DOI:10.1063/1.2838733 
iii Note on the magnetic units convention: we refer here to the magnetic field B in units of gauss (where 104 gauss = 
1 tesla) and it represents the real magnetic field at the sample. In contrast, the magnetic induction H is expressed in 
oersted (Oe) and, being defined as the field due to free currents, this is the one that the user controls when setting a 
current at the magnet power supply. In SI units, B = m0(H + M) where M is the magnetization density and is defined 
as arising from bound currents. For more information, see the Magnetic Units Conversion Table under Technical 
Resources at the Quantum Design website www.qdusa.com . 
iv For viewing clarity in the figure, the magnetic field lines in the superconductor do not show the supercurrent 
vortices that generate the magnetic field. 
v Consider the persistent magnet as a superconducting ring of inner dimension of R and the pinned flux line in the 
superconductor with a radius r, where R >> r. Referring to the states in Table 1, we must compare the magnetic 
field at the sample location (taken as the origin) between the initial remanent state (3) and when the vortex moves 
out of the ring into the middle (4). 

We know that flux is conserved: ( ) ( ) 2
4

2
3 0 RBrRB ⋅=⋅=Φ  

That is, the flux enclosed on vortex at position R (at the inner bore of the magnet) is compared with field in the bore 
of the magnet after the vortex moves out.  

The equation above approximates the magnetic field B as constant over the area of the loops in both cases. While 
this is not strictly true, the error is small compared with the amplification effect we are observing and hence is 
neglected. 
magnetic moment of vortex: Irm ⋅= 2π  
where I is the current flowing around perimeter. 

magnetic field at center of the vortex (a current ring):  ( )
r

I
RB

2
0

3
⋅

=
µ

 

put this value of I into above expression for moment: ( ) 3
3

0

2 rRBm
µ
π

=   

magnetic field at sample location due to pinned flux “dipole”: ( ) 3
0

3 4
0

r
mB ⋅−=

π
µ

 

insert expression for m from above: ( ) ( ) 3
3

3 2
0 






⋅−=

R
rRB

B  

Use flux conservation equation to compute ratio of field seen at sample in state 4 vs. state 3: 
( )
( ) r

R
B
B 2

0
0

3

4 −=  

Since R~2.5cm and r ~10-3 cm, this amplification is over x1000.   
This is why a tiny amount of flux creep out of magnet will have a large effect on the field seen at the sample 
location. 
 

http://www.qdusa.com/
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A P P E N D I X  F   

Ordering Replacement Parts 

F.1 Overview 
In this appendix we list the Quantum Design part number for loose or consumable parts you may 
wish to order throughout the lifetime of the MPMS 3. Contact your local Quantum Design 
representative to order parts. 

Table F-1. Replacement Parts 

Picture Name Part 
Number 

 

quartz 
sample 
holder 

4500-604 

 
brass sample 
holder 4500-608 

 

palladium 
reference 
(mounted) 

4500-612 

 

 
sample rod 4500-600 

 

magnetic 
latch for 
sample rod 

4096-358 

 

sample rod 
flexure 4500-607 
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Sample rod 
bearing 4500-603 

 

sample 
mounting 
station 

4500-626 

 

ultratorr 
fitting (tube 
fitting) for 
helium 
transfers 

YSS-6-
UT-A-
8BT 

 

nitrogen fill 
port plug 4504-032 

pump oil HH-110-25-012 

activated alumina for oil mist filter on rotary vane pump H026-00-050 

CONSULT A QUALIFIED QUANTUM DESIGN SERVICE REPRESENTATIVE BEFORE 
REPLACING ANY O-RINGS OR SEALS. 

teflon gas cap seal used on helium inlet plug 4504-002 

o-ring for cap seal used on helium inlet plug VON2-014 

o-ring for nitrogen fill ports VON2-012 

o-ring for transfer line bayonet VON2-014 

o-ring for top of sample space manifold VON2-019 
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o-ring for motor cap VON2-022 

CONSULT A QUALIFIED QUANTUM DESIGN SERVICE REPRESENTATIVE BEFORE 
REPLACING ANY FUSES 

fuses for module tower power entry: 6.3A, 20mm, delay (external) FD6.3-20MM 

fuses for magnet controller power entry: 8A, 20mm, delay (external) FD8-20MM 

fuses for module bay QD-CAN outlets: 5A, 20mm, delay (external) F5-20MMSB 

fuses for 5V power output in computer: 3.15A, 20mm, delay (internal)  FD3.15-20MM 
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